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1 Copyright and Declaration 

Copyright  

SIGLENT TECHNOLOGIES CO., LTD. All Rights Reserved. 

 

Trademark Information 

SIGLENT is the registered trademark of SIGLENT TECHNOLOGIES CO., LTD. 

 

Declaration 

⚫ SIGLENT products are protected by patent law in and outside of P.R.C. 

⚫ SIGLENT reserves the right to modify or change parts of or all the specifications or pricing 

policies at company’s sole decision. 

⚫ Information in this publication replaces all previously corresponding material. 

⚫ Any way of copying, extracting or translating the contents of this manual is not allowed without 

the permission of SIGLENT. 

 

Product Certification 

SIGLENT guarantees this product conforms to the national and industrial stands in China and other 

international stands conformance certification is in progress. 
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2 General Safety Summary 

Carefully read the following safety precautions to avoid any personal injury or damage the instrument 

and avoid any products connected to it. To avoid potential hazards, please use the instrument as 

specified. 

Protection is impaired if used in a manner not specified by the manufacturer. 

 

2.1 Precautions for Operation 

Before operating this product, special training is required to ensure that the user is physically, mentally 

and emotionally healthy and able to use the network analyzer, otherwise it may cause personal injury 

or material damage. Employers、operators are responsible for selecting suitable personnel to operate 

this product. 

Before moving or transporting this product. Please read and observe the "Safety Transportation 

Matters" chapter. 

As with all industrial products, the use of substances that cause allergic reactions such as nickel 

cannot generally be ruled out. If you experience an allergic reaction while using this product, please 

consult a doctor in time to determine the cause. 

Before you perform mechanical or heat treatment or disassemble the network analyzer, please be 

sure to read and pay special attention to the "Waste Disposal/Environmental Protection" chapter. 

In the event of a fire, this product may release harmful substances (gas, liquids, etc.), causing health 

problems. Therefore, appropriate measures must be taken, for example, protective masks and 

protective clothing must be worn. 
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2.2 Safety Terms and Symbols 

The meaning of symbols 

symbol meaning symbol meaning 

 
Warning 

 
Power Switch 

 
Hazardous Voltage 

 
Equipment meeting double 
insulation or reinforced insulation 

 
EarthGround 

 
Indoor use only 

 Lithium battery failure 

 

EU label for separately recycled 
electrical and electronic equipment 

 

Cue and its meaning 

DANGER : Indicates direct injury or hazards that may happen. 

WARNING : Indicates potential injury or hazards that may happen. 

CAUTION : Indicates potential damage to the instrument or other property that may happen. 

It must be consulted in all cases where  is marked, in order to find out the nature of the potential 

HAZARDS and any actions which have to be taken to avoid them. 

 

2.3 Safety Operation Matters 

The product can only be operated under the safe conditions and positions specified by the 

manufacturer. Do not obstruct the ventilation of the network analyzer during use. Failure to comply 

with the manufacturer's specifications may result in electric shock, fire, serious personal injury, or 

even death. Applicable local safety regulations and accident prevention rules must be observed in all 

applications. 

 

When powered by a power adapter, it can only be used indoors. 

Do not place the product on surface, vehicle, cabinet or tables that for reasons of weight or stability 

are unsuitable for this purpose. When installing the product and fastening it to the article or structures, 

always follow the manufacturer's installation instructions. If the installation is not carried out in 

accordance with the requirements of the document, it may cause personal injury or even death. 

Do not use this product in or near a heat source, and the ambient temperature cannot exceed the 
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maximum temperature in the document or datasheet 

 

2.4 Safety of Electricity 

If you ignore the electrical safety methods, electric shock, fire and/or serious personal injury or death 

may occur. 

 

Only use the power adapter and battery specified by the manufacturer to power the network analyzer, 

and the power adapter can only work within its rated input voltage range. 

Only the probe specified by the manufacturer can be used for testing. The use of non-manufacturer 

probes for testing may result in electric shock accidents. 

The user is not allowed to damage the insulation protection layer of the network analyzer and 

accessories. Doing so may cause electric shock. If an extension cord or terminal block is used for 

power supply, it must be checked regularly to ensure safe use. 

Before use, please check whether the power cord and probe are damaged. If the power cord and 

probe are damaged, please do not continue to use the product. 

Do not insert the AC plug of the power adapter into a dusty or dirty socket. Please make sure that the 

plug is firmly inserted into the socket, otherwise it may cause fire and/or injury due to sparks. 

Do not overload any sockets, extension cords or connectors. Doing so may cause fire or electric 

shock. 

When the measured voltage Vrms exceeds 30V, you should take appropriate measurement methods 

to avoid any danger. 

Unless expressly permitted, do not remove the cover or any part of the shell while the product is in 

operation. Doing so will expose circuits and components, reduce the overvoltage level of the 

measurement, and may cause personal injury, fire, or damage to the network analyzer. 

Anything that is not designed to be placed on the external interface of this product should not be 

placed on the external interface, otherwise it will cause an internal short circuit and/or electric shock, 

fire or injury to the network analyzer. 

Do not place this product in an environment exceeding IP51, otherwise the network analyzer will be 

damaged. 

This product must be used in a dry environment, otherwise it may cause electric shock. 

It is forbidden to use this product when condensation has formed or may form inside or on the surface 

of this product. For example, when the network analyzer moves from a cold environment to a warm 
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environment, the penetration of water increases the risk of electric shock. 

 

2.5 Safety Transportation Matters 

SIGLENT Technology provides handbags for the network analyzer. For short-distance transportation 

under supervision, please make sure that the network analyzer is turned off before putting it in the 

handbag. For long-distance transportation under unsupervised, please take out the battery and put it 

in your handbag. 

In order to facilitate the user to hold, SIGLENT Technology has installed a fabric handle on the network 

analyzer. This handle cannot be used as a focus point to be fixed on transportation equipment, such 

as cranes, forklifts, trucks, etc. It is the user's responsibility to fasten the product firmly to the 

transportation or lifting tool. 

If you use this product in a vehicle, the driver is responsible for driving the vehicle safely and correctly. 

The manufacturer is not responsible for any accidents or collisions. Do not use this product in a 

moving vehicle to avoid distracting the driver. Use this product appropriately in the vehicle to prevent 

injury or other damage in the event of an accident. 

 

2.6 Battery Usage 

This product contains a rechargeable lithium battery pack. If misused, there is a risk of explosion, fire 

and / or serious personal injury, and even death in some cases. 

The battery cannot be disassembled or crushed. 

The battery or battery pack cannot be exposed to high temperature or fire, and it must be stored in 

direct sunlight. Keep the battery clean and dry. Use a dry, clean cloth to clean contaminated 

connectors. 

The battery or battery pack cannot be short-circuited. Batteries or battery packs should not be stored 

in an environment that can easily cause a short circuit, such as boxes and drawers containing metal 

debris. The battery pack cannot be taken out of its original packaging before use. 

Batteries and battery packs should not be exposed to any mechanical shock that exceeds the 

allowable level. 

If the battery leaks, do not let the liquid contact the skin or eyes. If contact occurs, wash the contact 

area with plenty of water and seek medical assistance. 

The power adapter specified by SIGLENT Technology must be used for charging, otherwise it may 
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cause a fire or cause personal injury or death. 

It must be charged in a well-ventilated room. During the charging process, the network analyzer 

should not be covered by objects (such as blankets, towels, clothes), which will affect the heat 

dissipation effect and cause a serious fire. 

Improper battery replacement may cause an explosion. For the reliability and safety of the network 

analyzer, the battery model specified by SIGLENT Technology must be replaced.  

Used batteries and battery packs must be recycled and separated from residual waste. Batteries 

contain hazardous waste, and local regulations on waste disposal and recycling must be followed. 

 

2.7 Waste Disposal 

The used batteries in the product must not be disposed of together with unsorted municipal waste, 

they must be collected separately and placed in designated recycling points. 

If the product and its components are mechanically and/or thermally processed in a way beyond the 

intended use, hazardous substances may be released. Therefore, this product can only be 

disassembled by professional personnel. Improper disassembly may endanger your health. The local 

waste disposal regulations must be followed. 

 

2.8 Safety Compliance 

This section lists the safety standards with which the product complies. 

 

U.S. nationally recognized testing laboratory listing 

◼ UL 61010-1:2012/R:2018-11. Safety Requirements for Electrical Equipment for Measurement, 

Control, and Laboratory Use – Part 1: General Requirements. 

◼ UL 61010-2-030:2018. Safety Requirements for Electrical Equipment for Measurement, 

Control, and Laboratory Use – Part2-030: Particular requirements for testing and measuring 

circuits. 

 

Canadian certification 

◼ CAN/CSA-C22.2 No. 61010-1:2012/A1:2018-11. Safety Requirements for Electrical Equipment 

for Measurement, Control, and Laboratory Use – Part 1: General Requirements. 

◼ CAN/CSA-C22.2 No. 61010-2-030:2018. Safety Requirements for Electrical Equipment for 
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Measurement, Control, and Laboratory Use – Part 2-030: Particular requirements for testing 

and measuring circuits. 

 

2.9 General Care and Cleaning 

Care  

Do not store or leave the instrument in direct sunshine for extended periods of time. 

To avoid damages to the instrument or probes, please do not expose them to fog, liquid, or solvents. 

 

Cleaning 

Please perform the following steps to clean the instrument and probes regularly in accordance with 

its operating conditions. 

Disconnect the instrument from all power sources and then clean with a soft wet cloth. 

Clean the loose dust on the outside of the instrument and probe with a soft cloth. When cleaning the 

LCD, take care to avoid scratching it. 

To avoid damage to the surface of the instrument and probe, please do not use any corrosive liquid 

or chemical cleansers. 

Make sure that the instrument is completely dry before restarting it to avoid potential short circuits or 

personal injury. 

 

2.10 Measurement Category 

 

WARNING  

Make sure that no measurement overvoltage reach the product, or else the 
operator might expose to danger of electric shock. 

 

IEC61010-2-030 defines the measurement category to rate the ability of measuring instruments to 

withstand short-term transient overvoltage outside of the working voltage. This product and its 

accessories can only be used in the environment of the nominal measurement category. 

⚫ CAT Ⅰ: 

0- An instrument with no rated measurement category is used to measure circuits that are not 

directly connected to the mains, such as a circuit board powered by a battery or a secondary 
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circuit with special protection. 

⚫ CAT II: 

For measurements installed in buildings, such as junction boxes, circuit breakers, distribution 

boards and equipment permanently connected to fixed installations. 

⚫ CAT III: 

Used for measurements installed in buildings, such as junction boxes, circuit breakers, 

distribution boards and equipment that are permanently connected to fixed installations. 

⚫ CAT IV: 

It is used for measuring at the source of low-voltage devices, such as electricity meters and 

primary overcurrent protection devices. 
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3 Working Environment 

3.1 General requirement 

Environment 

This product is intended for indoor use and should be operated in a clean, dry environment. 

It can be stored in an environment with a waterproof/dustproof rating better than IP51. 

 

Temperature 

Operating: 0℃ to +40℃ 

Non-operation:-20℃ to +60℃ 

 

Note: Direct sunlight, radiators, and other heat sources should be taken into account when assessing 

the ambient temperature. 

 

Humidity 

Operating: 85% RH, 40 ℃, 24 hours 

Non-operating: 85% RH, 65 ℃, 24 hours 

 

Altitude 

Operating: less than 2 km 

Non-operation: less than 3 km 

 

Installation (overvoltage) Category 

This product is powered by mains conforming to installation (overvoltage) category II. 

 

 

WARNING  

Make sure that no overvoltage (such as that caused by thunderbolt) can 
reach the product, or else the operator might expose to danger of electric 
shock. 
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Installation (overvoltage) Category Definitions  

Installation (overvoltage) category I refers to signal level which is applicable to equipment 

measurement terminals connected to the source circuit. In these terminals, precautions are done to 

limit the transient voltage to the corresponding low level.  

Installation (overvoltage) category II refers to the local power distribution level which is applicable 

to equipment connected to the AC line (AC power). 

 

Degree of Pollution 

network analyzers may be operated in environments of Pollution Degree II. 

 

Degree of Pollution Definitions 

⚫ Degree of Pollution I: 

No pollution, or only dry non-conductive pollution occurs. This pollution level has no impact. For 

example, clean rooms or air-conditioned office environments. 

⚫ Degree of Pollution II: 

Generally, only dry non-conductive pollution occurs. Sometimes temporary conductivity may 

occur due to condensation. For example: general indoor environment. 

⚫ Degree of Pollution III: 

Conductive contamination occurs, or dry non-conductive contamination becomes conductive 

due to condensation. For example, an outdoor environment with a canopy. 

⚫ Degree of Pollution IV: 

Produce permanent conductive pollution through conductive dust, rainwater, or snow. For 

example: outdoor places. 

 

IP Rating  

IP51 (as defined in IEC 60529).Ventilation Requirement  

Please make sure that the air intake and exhaust areas are free from obstructions and have free air. 

When using the network analyzer in a bench-top or rack setting, provide at least 10 cm clearance 

beside, above and behind the instrument for adequate ventilation.  
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WARNING  

Inadequate ventilation may cause temperature increase which would 
damage the instrument. So please keep the instrument well ventilated during 
operation. 

 

3.2 AC Power Requirement 

The power adapter operates with a single-phase, 100 to 240 Vrms (+/-10%) AC power at 50/60 Hz 

(+/-5%). 

No manual voltage selection is required because the instrument automatically adapts to line voltage. 

Depending on the type and number of options and accessories (probes, PC port plug-in, charging 

etc.), When powered by adapter, the analyzer can consume up to 20 W of power. 

 

Note: The power adapter automatically adapts to the AC line input within the following ranges: 

 

Voltage Range: 90 - 264 Vrms 

Frequency Range: 47 - 63 Hz 

 

Please use the power cord and adapter provided by the manufacturer. Use of other non-designated 

products may cause personal injury. 

 

 

WARNING  

Electrical Shock Hazard! 

Use of an adapter or power supply not specified by the manufacturer may 
cause personal injury. 

 

To make the network analyzer completely power off, unplug the instrument power cord from the AC 

socket and remove the battery from the analyzer. 

The battery should be removed from the analyzer when it is not to be used for an extended period of 

time. 
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4 Quick Start 

This chapter guides users to quickly get familiar with the appearance, panel and the user interface, 

as well as announcements during the first use of the analyzer. 

 

4.1 General Inspection 

When you get a new analyzer, it is recommended that you proceed through the following steps. 

 

Check to see if there is any damage caused by shipping problems 

If the packing case or foam protective pad is seriously damaged, keep it until the whole machine and 

accessories pass the electrical and mechanical tests. 

 

Inspection machine 

If you notice external damage, contact your SIGLENT dealer or local office, and SIGLENT will arrange 

for a repair or replacement. 

 

Check the accessories 

Please check the accessories according to the packing list in the box. If the accessories are 

incomplete or damaged, please contact your SIGLENT sales representative. 
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4.2 Preparing for Use 

4.2.1 Appearance and Dimension 

 

 

Figure 4-1 Front and lateral View 

 

4.2.2 Fixed Bracket 

The included tilting stand is available for desktop operation. The tilting bracket provides a backward 

tilt for improved stability. To deploy the tilt bracket, pull the bottom of the tilt bracket away from the 

back of the instrument. To retract the tilting bracket, push the bottom of the bracket toward the back 

of the instrument. 

 

 

Figure 4-2 Side View 

Unit:mm 
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4.2.3 Power Supply Information 

The battery that comes with the analyzer may need to be recharged before use. The device can use 

the supplied AC-DC adapter (refer to the product technical data sheet for ordering information). The 

specifications of the input AC power supply are: 100-240V, 50/60Hz; Or charge through the on-board 

DC adapter in the accessory. 

Specifically, the analyzer can be connected to the adapter according to the power socket shown in 

the figure below. 

 

 

Figure 4-3 Rear View and Power 

 

◆ Adapter factory configuration is the 12V 4A 

◆ Battery factory installed, the user can change itself 

 

 

WARNING 

This instrument can only use Siglent approved batteries, adapters and 
chargers. When using an onboard DC adapter, always ensure that the power 
supply is rated at least 75 W @ 15 VDC and that there is no dust or debris 
on the socket. If the adapter plug becomes hot during operation, discontinue 
use immediately. Siglent recommends taking out the batteries when devices 
aren't used for too long. 

 

  

Power socket 
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4.3 Front Panel 

 

Figure 4-4 the Front Panel 

 

NO. Name Description 

1 LCD Screen 8.4 inch multi-touch screen, resolution 800*600 

2 Power Switch 

Stand by status: Orange; Fully charged status: green 

Power on status: White 

Short press(1 second): Software startup/Shutdown prompt 
pops up,to Stand by status with current state saved 

Long press(3 second): Hardware shutdown,to Stand by 
status without current state saved 

3 Function Keys 

Complete the function control and parameter input of the 
analyzer, and most operations can be completed by the 
touch screen. 

Press  Lock  to turn off/on the keyboard and touch 

functions. 

4 
Three-dimensional 
knob 

Complete the quick adjustment and selection of 
parameters. 

5 Fan vent 
Built-in fan external exhaust port. Please ensure that this 
vent is unblocked. 

6 Battery case cover 
Internal battery protection cover. Remove during battery 
replacement. 

7 Detachable  
hand strap 

Convenient hand force, can be installed on both sides. 
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Name Description 

 
The shortcut item selection button will pop up a measurement item selection 
menu on the screen, where you can select a test item. 

 
Shortcut format selection button to select the data format displayed for the 
test project. 

 
Quick calibration selection button, call up the calibration item menu, and you 
can proceed with subsequent calibration items. 

 

Key and touch screen lock control. 

When the button light is on, all key pad buttons and touch screen buttons 

except the  Lock  button are locked to prevent misoperation. 

 

 

 

The function key part of the front panel is the reuse key of menu selection mode and value input mode, 

which can be switched by  Enter  and  Esc  : 

 

◆ Under default reset, the operation interface is in menu selection mode, and function keys will 

be identified as the blue silk screen function identifier on the upper side of the key. Use  

Enter  to switch from menu selection mode to value input mode. 
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◆ When the operation interface is in value input mode, the multiplex key will be identified as 

the white silk screen digital identifier inside the key. You can use  Esc  to switch from value 

input mode to menu selection mode. 

 

Name Description 

 

In menu selection mode, control frequency parameters; Control the length 
(distance) parameter during time domain analysis. 

 
In menu selection mode, control the scanning power. 

 

In menu selection mode, control amplitude parameters, such as scale and unit, 
reference power, etc. 

 

In menu selection mode, control the cursor Marker parameters, such as cursor 
type, cursor positioning, noise cursor, N dB bandwidth, etc. 

 

In menu selection mode, control mathematical functions, such as mathematical 
calculations, formula editing, data temporary storage, etc. 

 

In menu selection mode, control screen display parameters, such as trace 
settings, channel settings, sub window settings, etc. 

 

In the menu selection mode, control peak parameters, such as peak search, 
peak rule setting, etc. 

 

In the menu selection mode, control the average function and bandwidth 
parameters, such as RBW, VBW, IFBW, etc. 

 

In menu selection mode, control the scanning parameters, such as scanning 
time and type, scanning points, etc. 

 

In menu selection mode, control trigger parameters, such as trigger mode, 
single scan, HOLD, etc. 

 

In menu selection mode, storage and call control of data and configuration, 
images, etc., such as trace data storage and call, calibration status storage and 
call, screenshot storage, etc. 

 

In menu selection mode, control reset parameters, such as reset status 
definition, power on status definition, user status definition, etc. 

 
In the menu selection mode, view help information, version information, etc. 

 

In menu selection mode, perform system general information viewing, version 
and calibration operations, as well as input and output port settings, screen 
display settings, etc.ell as input and output port Settings, screen display 
Settings, etc. 
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4.4 Rear Panel 

  

 

NO. Name Description 

1 Port 1 

The RF signal input and output port is a 50 Ω SMA 3.5mm male 
connector, which can also be configured as a DC output to provide 
bias voltage. 

Maximum input ±50 VDC, + 30 dBm. 

2 Trig In 

Trigger input is a BNC female connector. When the analyzer uses an 
external trigger mode, the connector receives a rising or falling edge 
of an external trigger signal that is used to establish event 
synchronization. 

3 Ref In 

Reference clock input, BNC female connector. The analyzer can use 
an internal reference clock or an external reference clock. If the 
instrument detects a signal from an external 10 MHz reference clock, 
it automatically uses the signal as the analyzer's reference clock 
source. At this time the screen status bar frequency reference 
display external; 

When the external 10 MHz reference signal is lost, exceeded, or not 
connected, the analyzer's reference clock is automatically switched 
to the internal 10 MHz reference clock, and the screen frequency 
reference bar will display the internal.  

[Ref In] is used to establish clock synchronization between multiple 
instruments. 

4 Port 2 

The RF signal input and output port is a 50 Ω SMA 3.5mm male 
connector, which can also be configured as a DC output to provide 
bias voltage. 

Maximum input ±50 VDC, + 30 dBm. 

5 K-groove Slots are provided to accept Kensignton® cable locks. 

6 GPS Ant 

The GPS antenna port is a SMA female connector used to install the 
GPS antenna and receive GPS satellite signals. 

Can provide 3.3V DC feed for active GPS antenna. 

7 Bias Out 

The offset voltage output port is a 50Ω female SMB connector. 

Used to provide bias voltage for external signal amplifiers, such as 
tower amplifiers. 

8 
USB 
Device 

The main USB port is TypeC. The analyzer can be used as a slave 
device and connected to a PC via USB cable. The PC uses the USB-
TMC protocol to remotely control the analyzer. 

9 USB USB slave port, TypeB. The analyzer can be used as the main 
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Host device and is connected to external USB devices through this port. 
For example, 

Connect external extended memory to read files in memory, or store 
the current instrument state, data, or current screen display content 
into memory; 

Connect a USB keyboard, USB mouse, or other USB receiver; 
Connect USB-GPIB adapter to realize GPIB remote control of 
analyzer; 

Connect electronic calibration parts to realize automatic calibration of 
analyzer. 

10 LAN 
RJ45 ports. The analyzer is connected to the LAN through network 
cable, and can be viewed and controlled remotely through VXI, 
Socket protocol, or a web browser. 

11 
External 
power 
supply 

2.5mm x 5.5mm barrel connector, connected to 12V 4A power 
adapter charging port, center positive. Used to power devices and 
charge batteries. 

 

 

WARNING 

The analyzer does not support DC input. To avoid damage to the instrument, 
the DC voltage component of the signal reaching the RF input must not 
exceed 50 V. 

If possible, add an isolated DC component to the RF input of the analyzer 
before signal measurement. 

 

 

WARNING 

In order to avoid damage to the instrument, the DC voltage component of the 
signal input to the RF input should not exceed 50 V; 

When the frequency is greater than 10 MHz, the maximum continuous power 
of the RF signal shall not exceed +33 dBm. 

When the frequency is less than 10 MHz, the maximum continuous power of 
the RF signal should not exceed +20 dBm. 

 

 

WARNING 

Before connecting any signal, short connect the inner core of the test cable 
to the housing floor to release the static electricity accumulated on the inner 
core of the test cable. 
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4.5 User Interface 

 

 

No Name Description 

1 Mode/Measure 
Indicate the current working mode and measurement function 
of the analyzer, and click to switch, such as spectrum analysis 
mode, real-time spectrum mode, etc. 

2 
Trace 
information 

Indicates the items tested by the trace, parameter 
configurations, etc. 

3 
Quick Action 
Bar 

Shortcut buttons for some commonly used operations. 

4 
Result display 
area 

The measurement results are displayed in various forms such 
as spectral lines, cursors, traces, and Smith circles. 

5 
Information 
and 
Notifications 

Display the basic configuration and information of the currently 
selected trace, as well as hardware status and notifications. 

6 Menu area Used to configure measurement Settings. 

7 
Battery and 
Remote status 

Display battery level and remote control status. 

 

4.5.1 Active entry 

 

Functions Functions Description 

 Recall the previous step. 
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 Recovering the withdrawn operation. 

 Add a measurement trace. 

 Add a measurement trace in a new window 

 Add a measurement channel in a new window. 

 Add a marker. 

 
Delete active window or trace. 

Note: Keep at least one trace on the interface. 

 Save status, calibration data, and snp files, etc 

 Load status, calibration data, and snp files, etc 

 Screenshot 

 

4.5.2 Value of marker 

Display the frequency and reading of the marker. 

 

4.5.3 Trace State 

⚫ A trace is a series of measured data points. Up to 256 traces can be created. In addition, one 

historical memory trace for each active trace can be stored and displayed. Mathematical 

operations can be performed on the current trace data and the historical memory trace. 

⚫ Press the Display button in the front panel, and the Trace Setup menu pops up on the right side 

of the screen to manage the operation Trace, such as adding a trace, deleting a trace, maximizing 

the trace window, moving traces between Windows, keeping the trace to the maximum or 

minimum value without displaying the current value, etc. 

⚫ Select a trace line and press the Scale button to change the reference electric equalization 

operation. 
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4.5.4 Hardkeys 

Using Display Setup in the Display submenu, you can set Hardkeys and open the virtual keypad on 

the right side of the screen to operate the vector network analyzer without operating the function keys 

on the front panel. 

 

4.5.5 Channel State 

⚫ Channels contain traces. Up to 256 channels can be created. The channel setting determines 

how trace data is measured, and all traces assigned to a channel share the same channel setting. 

⚫ Press the Display button in the front panel, and the Channel Setup menu pops up on the right 

side of the screen. This can be used to manage operation channels, such as adding channels, 

copying channels, and deleting channels. 

 

4.5.6 Function Keys 

Functions Functions Description 

Log Mag Parameters are displayed in logarithmic amplitude mode. 

Lin Mag The parameters are displayed in amplitude linear fashion. 

Phase Displays the phase of the parameter. 

Delay Displays the delay of the parameter. 

Smith The parameters are shown in the form of a Smith chart. 

Polar The parameters are displayed in polar coordinates. 

SWR The parameters are shown in SWR. 

 

4.5.7 Label Page 

Displays all parameter display formats supported by the vector network analyzer. 

 

4.5.8 Window State 

⚫ Windows can be used to view trace data and up to 100 windows can be created. 
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⚫ Press the button of Display in the front panel and the Window Setup menu pops up on the right 

side of the screen. It can be used to manage operation windows, such as selecting a window, 

adding a window, deleting a window, maximizing a window, layout, and so on. 

 

4.5.9 Stimulus Range 

Displays the excitation signal set in the current window, including starting frequency, ending frequency, 

internal source output power, etc. 

 

4.5.10 Status Bar 

Functions Functions Description 

IntTrig Displays the current trigger mode. 

Continuous Continuous trigger, single trigger, and other trigger mode displays. 

BW=10k Display of the current IF bandwidth. 

C1·Port S parameter calibration data state loading display. 

SrcCal 

Display whether the internal source power calibration data state is loaded 

or not. A Gray dark shaded label represents an unavailable selection/ 

option. 

RF On Internal source output power ON and off, RF ON stands for ON. 

IntRet A display that currently uses an internal or external reference signal. 

Update On UI waveform update or not. 

 

4.5.11 Message Bar 

Displays the current date information and error information during testing. 

 

4.5.12 Graffiti Function 

This product provides a basic graffiti function, which is used to draw graphics and mark information 

on the main interface. This feature is great for annotating screenshots and adding important details 

before saving.  
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⚫ Graffiti function menu bar 

 

Figure 4-5 graffiti function menu bar 

 

As shown in Figure 4-5, the graffiti menu contains functions of enable, edit, clear, save and call. 

 

⚫ Graffiti Editing Interface 
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Figure 4-6 graffiti editing interface 

 

As shown in Figure 4-6, the toolbar at the bottom of the interface displays a series of tools for graphic 

editing: 

1. Selection tool: A series of editing can be carried out after the drawing is selected 

2. Text tool: Add text notes in the interface 

3. Line tool: Add a line in the interface 

4. Rectangle tool: Add a rectangle to the interface 

5. Ellipse tool: Add an ellipse to the interface 

6. Curve tool: Draw a series of lines arbitrarily in the interface (double click the mouse/ double 

click the finger on the screen to finish drawing) 

7. Delete tool: Delete the currently selected drawing 

8. Text color tool: Set text color (support graphics: text) 

9. Text size tool: Set text size (support graphics: text) 

10. Background filling tool: Fill graphics background color (support graphics: text, rectangle, ellipse) 

11. Border color tool: Set the border color of graphics (support graphics: text, line, rectangle, 

ellipse, curve) 

12. Border line tool: Adjust the border line thickness of graphics (support graphics: text, line 

segment, rectangle, ellipse, curve) 
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13. Exit editing tool: Exit the current editing state 

 

 

Figure4–7 Color selection interface 

 

As shown in Figure 4–7, after calling out this interface, you can adjust the corresponding colors of the 

graphics: 

1. Color shade selection tool: Mouse/ finger click to select the appropriate brightness of the color 

2. Color selection tool: Select a specific color 

3. Color transparency tool: Adjust color transparency (the more right, the lower color 

transparency) 
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Figure 4-8 Line thickness adjustment interface 

 

As shown in Figure 4-8, you can adjust the line thickness at the edge of the graph by calling out this 

interface. The larger the value is, the thicker the line will be. 

⚫ Save/Recall 

Click the save menu button to save the current graffiti content as a file with *.GFT as the file extension. 

 

4.5.13 Theme Management 

In the "Theme Management" panel, Siglent provides display configuration options for the 

measurement panel, allowing you to flexibly configure parameters such as trace color thickness, XY 

axis font style, and view grid style. 

 

Figure 4-9 The Measurement Panel 
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A. Trace Title Bar 

B. Response Axis/ LeftAxis 

C. Plot Grid 

D. Marker 

E. Marker Info Bar 

F. Trace Line 

G. Stimulus Axis/ BottomAxis 

 

Press the “Display” button on the front panel → “Display Setup” →“Theme Manager…” to enter the 

"Theme Management" panel. Siglent supports importing and saving themes. Select a specific theme 

from the theme drop-down menu to configure the measurement panel display parameters in one step. 

After completing the new theme configuration, click "Copy..." and then set a new name to add the 

current theme to the theme drop-down menu. Click "Delete" to delete the current topic from the theme 

drop-down menu. 

 

Figure 4-10 Theme Management Panel 

 

A. theme drop-down menu 

B. "Copy...", save current theme 

C. "Delete", delete current theme 

D. Style Settings 

E. Color Settings 

 

4.5.13.1 Style Settings 

Click on "Style Settings" to enter the style setting interface, with the following options: 
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4.5.13.1.1 Plot Grid 

"Window" → "Plot Grid" to enter the plot grid style setting menu, where you can set the grid line style 

and width. The grid line style menu bar has five styles to choose from: solid, dash, dot, dash dot, and 

dash dot dot. 

 

Figure 4-11Choosing The Line Style With “dash” In The Plot Grid Menu 

 

4.5.13.1.2 Marker 

"Window" → "Marker" to enter the marker style setting menu, where you can set the font size, font 

style and font weight of the marker. The font style can be selected as normal or italic, and the font 

weight can be selected as normal or bold. The settings for font styles are the same below. 

 

4.5.13.1.3 Marker Info Bar 

"Window" → "Marker Info Bar" to enter the marker information bar style setting menu, where you can 

set the font size, font style, and font weight of the marker information bar. 

 

4.5.13.1.4 Response Axis 

"Window" → "Response Axis" to enter the response axis style setting menu, where you can set the 

font size, font style, and font weight of the response axis. 
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4.5.13.1.5 Stimulus Axis 

"Window" → " Stimulus Axis" to enter the stimulus axis style setting menu, where you can set the font 

size, font style, and font weight of the stimulus axis. 

 

4.5.13.1.6 Trace Line 

"Window" → "Trace Line" to enter the trace line style setting menu, where you can set the trace line 

width. 

 

4.5.13.1.7 Trace Title Bar 

"Window" → "Trace Title Bar" to enter the trace title bar style setting menu, where you can set the 

maximum limit columns, minimum limit columns, maximum limit rows, font size, font style, and font 

weight. 

 

4.5.13.2 Color Setting 

Click on "Color Setting" to enter the color setting interface. In the interface, you can set the colors of 

current traces, historical memory traces, measurement window backgrounds, grid lines, axis text, and 

other objects. For the current trace and historical memory trace, you can choose eight colors each, 

corresponding to Trace1-8 and MemTrace1-8. If the number of traces is greater than 8, the color of 

the trace is Trace x% 8, where x is the serial number of the trace. 

 

Click on the color box on the right, and the "Color Picker" interface will pop up. You can set the desired 

color by moving the color panel circle and color axis ruler. 

 

Siglent supports importing and exporting color configuration files. Click on "Import" on the bottom right 

side and select the corresponding file to complete the color configuration in one step; Click on "Export", 

select the save path and set the file name to save your current color configuration. 
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A. Objects with modifiable colors 

B. Color Box, click to pop up the "Color Picker" interface  

C. "Color Picker" interface 

D. Import Color Settings 

E. Export Color Settings 

 

4.6 Touch screen and mouse operation 

The analyzer provides a 8.4 inch multi-touch screen and supports various gesture operations 

including: 

◆ Slide the waveform left and right or up and down in the measurement result area to change the 

X-axis center coordinate or Y-axis reference coordinatePerform two-points scaling in the 

waveform area to change the X-axis span 

◆ The waveform is scaled horizontally at two points in the measurement result area to change the 

X-axis display range 

◆ Click the shortcut menu area, working status area, scanning parameter area and menu area for 

function selection 

◆ Click editable parameters, virtual numeric keyboard or QWERT keyboard will pop up, parameter 
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or text editing 

◆ Open and drag the cursor 

◆ When the mouse is connected, clicking the left mouse button has the same effect as a single 

touch 

 

You can turn the touch screen function on and off via  Lock  . 

 

No Name Description 

1 Click Most controls just need to be tapped, touched and released. 

2 Double click 

Some controls require double clicking. 

If the second press is not detected within a specific time 
period, the operation is cancelled or treated as a single 
press. 

3 Press and drag 

Some objects can be dragged. 

This is done by gently holding down the action object and 
dragging it to a new position while releasing it. For example, 
you can drag items such as tags, limit line nodes, and center 
frequencies by dragging tracks left or right. 

4 Pinch or release 

Some projects can be scaled down or expanded. 

This is done by pressing down with two fingers at the same 
time and gently holding the item as you pull the fingers closer 
or further, then releasing. You can pull items in and out, such 
as frequency spans, by touching and holding the trace in two 
locations, then pulling your finger closer to narrow the span 
or pulling your finger further to widen it. 

 

4.7 Help Information 

The Help system of the vector network analyzer can provide the Help information of the function keys 

and menu options on the front panel. Press the Help button on the front panel to enter the Utility 

menu, click Help to open the Help document, click into the corresponding directory to view the 

information. 

 

4.8 Communication and Remote Control 

The analyzer supports communication with computers via USB, LAN, and GPIB-USB interfaces. By 

using these interfaces, in combination with programming languages and/or NI-VISA software, users 

can remotely control the analyzer based on a SCPI (Standard Commands for Programmable 

Instruments) compliant command set, LabView and IVI (Interchangeable Virtual Instrument), to 
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interoperate with other programmable instruments. 

You can also go to  System  > System > I/O Settings > Network and set the corresponding 

communication port to view and control the analyzer directly on a PC or mobile terminal using a web 

browser. For more details, refer to the ‘User Guide’. 

 

4.9 Troubleshooting 

This section lists the possible faults and troubleshooting methods that may occur during the use of 

the analyzer. When you encounter these faults, please follow the corresponding steps to handle them. 

If unable to process, please contact SIGLENT and provide the equipment information of your 

instrument (serial number labeled on the back of the instrument or  System  > Help > About… ). 

 

Troubleshoot the analyzer according to the following steps: 

1. Switch on the power and the instrument will enter the charging state. The backlight of the power 

switch on the front panel will light up orange (charging)/green (full). 

If the power switch on the front panel is not on: 

◆ Check that the power switch is turned on and that the power connector is properly connected 

 

2. Press the power switch on the front panel, and the instrument will turn on. The color of the power 

switch on the front panel will turn white. At the same time, the fan on the back will turn and the 

screen will light up. 

If the instrument does not enter the power on state normally: 

◆ Check whether the fan and screen are loose or damaged 

◆ If the fan and screen are normally powered on, but the screen stops in the startup screen, 

or the button does not respond 

If the above problems exist, do not disassemble the instrument and contact SIGLENT in time. 

 

3. The analyzer enters the working state normally, and the buttons and touch screen should respond 

to the measurement operation normally. 

If the instrument does not work properly: 

◆ Check that the analyzer is working in the remote control lock state 

◆ Check whether the analyzer can be controlled using the mouse and keyboard 

◆ Check whether the analyzer can be controlled using VNC or remote commands 
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◆ Press  System  >  Self Test  > Screen Test/Key Test /LED Test/Touch Test to check 

whether there is any response or interference between the key and screen 

◆ Check whether strong electromagnetic fields exist around the analyzer. Strong 

electromagnetic fields will affect the response of the capacitor touch screen 

If the above problems exist, do not disassemble the instrument and contact SIGLENT in time. 

 

4. The analyzer should be in scanning or measuring state when working normally, and the screen 

waveform and parameters are in updating state. 

If the instrument screen waveform or parameters are not updated for a long time: 

◆ Check whether the current trace is in View state or multiple averaging state 

◆ Check whether the trigger conditions are not met and wait. Check the trigger Settings and 

whether there is a trigger signal 

◆ Check whether it is currently in a single scan state, or whether it is in a measurement 

calculation state 

◆ Check whether the current scan time is set too long or whether the measured dwell time is 

set too long 

 

5. Incorrect or inaccurate measurement: 

Users can obtain detailed instructions on technical indicators from the back of this manual to 

calculate systematic errors, check measurement results and accuracy problems. To achieve the 

performance indicators listed in this manual, you need:  

◆ The instrument is in the calibration cycle, stored in the working temperature of 20℃~30℃ 

for at least two hours, and preheated for more than 40 minutes 

◆ Have a certain understanding of the measured signal, and set the appropriate parameters 

for the instrument 

◆ Check that external devices are properly connected and working, and that line losses are 

correctly compensated 

◆ Check whether signal tracing, frequency offset, amplitude offset, or correction functions are 

applied 

◆ Check whether an external reference clock source is applied 

◆ The instrument is measured and calibrated regularly to compensate for measuring errors 

caused by aging and other factors. For calibration, contact SIGLENT, Inc., or an authorized 

measurement provider for paid service. 

6. Pop-up message: 

The instrument will give prompt message, error message or status message according to the 

state it is in. These messages can help the user to use the device correctly, not the device failure. 
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5 Set Up a Measurement 

This chapter introduces in detail each function button on the front panel of SHN900A series vector 

network analyzers and the following menu functions. 

5.1 Measurement parameters 

5.1.1 S parameters 

S parameters are used to describe the degree of a transmitted or reflected signal through an 

impedance discontinuity. S parameters are relative measurements, defined as the ratio of two 

complex voltages. They contain the amplitude and phase information of the relevant signals. For the 

2-port vector network analyzer, there are 4 S parameters (S11, S21, S12, S22).  

The specific meaning of each S parameter can be described by the following items: 

Sxy  x,y∈(1,2): 

x: The response port is also known as the receiving port of the vector network analyzer. The 

transmitted signal enters the port after passing through the DUT. 

y: The excitation port is also known as the transmitting port of the vector network analyzer. 

The output signal of this port is provided to the DUT. 

 

Here is a list of common Measurements with S-Parameters: 

Reflection Measurements Transmission Measurements 

● Return loss 

● SWR 

● Reflection coefficient 

● Input impedance 

● S11, S22 

● Insertion loss 

● Transmission coefficient 

● Gain/ loss insertion 

● group delay 

● Linear phase shift 

● electrical delay 

● S21, S12 

 

5.1.2 Receiver Measurement 

Each port of the vector network analyzer contains 1 reference receiver and 1 measurement reference 

receiver. For the 2-port vector network analyzer, there are a total of 2 reference receivers and 2 

measurement reference receivers. The power measured by these receivers can be compared to 
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obtain all the S parameter indices. 

R1, R2 are the reference receivers used to measure the signal emitted from the vector network 

analyzer, it is equal to the transmitted power at the port after power calibration. 

● R1: Measures the output power of port 1  

● R2: Measures the output power of port 2  

 

A, B are test receivers used to measure the reflected or transmitted signal power after passing through 

the device under test. 

● A: Measures the signal power entering port 1  

● B: Measures the signal power entering port 2 

 

5.1.3 Balanced Measurement 

5.1.3.1  Balanced Devices 

Standard Single-ended devices generally have one input port and one output port. Signals on the 

input and output ports are referenced to ground. As Fig2.1 Balanced devices have two pins on either 

the input, the output, or both. The signal of interest is the difference and average of the two input or 

output lines, not referenced to ground, as Fig2.2. 

 

DUTV V  

Fig 2-1 Single-ended devices 

DUTV V  

Fig 2-2 Balanced devices 

 

Differential and Common Modes Model 

On balanced devices, the signal of interest is the difference and average of the two input or output 

lines. In balanced device terminology, these signals are known as the Differential and Common modes. 

● Signal A is fixed at 1V peak 

● Signal B is selectable 

● Differential is calculated as A minus B 
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● Common is calculated as the average of A and B 

 

Input Signal A and B, A =1V, B=2V Differential=(A-B), Common=(A+B)/2 

  

 

Input Signal A and B, A =1V, B= reverse phase 2V Differential=(A-B), Common=(A+B)/2 

  

 

5.1.3.2  Measuring Mixed Mode (Balanced) S-Parameters 

The mixed mode S parameter is an extension of the conventional S parameter for balance 

measurement. If the measuring device is a balanced device, its mixed mode parameters can be 

measured by the VNA. Some balanced devices are designed to amplify the differential component 

and reject the common component. This allows noise that is common to both inputs to be virtually 

eliminated from the output. For example, a balanced device may amplify the differential signal by a 

factor of 5, and attenuate the common signal by a factor of 5. Using traditional S-parameter notation, 

an S21 is a ratio measurement of the device Output/device Input. Mixing this with balanced 

terminology, we could view the amplifier's Differential Output signal/ Differential Input signal. To see 

this parameter on the analyzer, we would select an Sdd21 measurement using the following balanced 

notation: 
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The general notation for the mixed S parameter is Sabxy, where: 

1) a - Represents the output mode of the device 

2) b - Represents the input mode of the device 

choose from the following for both a and b 

● s – single ended (unbalanced port) 

● d – differential (balanced port) 

● c – common (balanced port) 

3) x – device output “logical” port number 

4) y - device input “logical” port number 

 

5.1.3.3 DUT Topology Port Mapping 

In the balanced measurement, the signal of interest is the difference or average of two BALANCED 

input or BALANCED output lines. It is also possible to have single-ended ports AND balanced ports 

on the same device. 

Press the “Meas” button on the front panel → Balanced → Topology... , Create or edit DUT Topology 
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and Logical Port Mapping.  

 

“Logical Port” is used to describe a physical analyzer test port that has been remapped to a new port 

number. 

1. Map any two physical ports of the vector network analyzer to a balanced logical port. 

2. Map any physical port of the vector network Analyzer to a single-ended logical port. 

These selections apply to ALL measurements in the channel. If the device topology is changed, any 

existing measurements in the channel that are incompatible with the new topology will be 

automatically changed to one that is compatible. 

A multi-port vector network analyzer can be used to measure the following topological relationships 

for differential devices. When the vector network analyzer has only 2 test ports, then only the first 

balanced device under test can be tested. 

Balanced 

1 Logical port (Balance Port 1) - 2 physical ports (Port1, Port2) 

 

 

5.1.4 Wave 

Receivers can be also selected using logical receiver notation 

Press the “Meas” button on the front panel → Wave → Other... to enter the Wave TAB interface. 
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Logical receivers are generally represented by aN, M and bN, M forms. 

aN, M represent the power received by the reference receiver of the logical port N when the physical 

port M outputs power. 

bN, M represent the power received by the measurement receiver of logical port N when the physical 

port M outputs power. 

● aN - Represents Reference receiver for logical port N 

● bN - Represents the test port receiver for logical port N 

● M – Represents the Physical port number of the output power 

 

For example: 

1) a1,1 Represents Physical port 1 outputs power when the reference receiver of logical port 1 is 

measured. When logical port 1 is mapped to physical port 1, it is equivalent to R1,1; 

2) a2,1 Represents Physical port 1 outputs power when the reference receiver of logical port 2 is 

measured. When logical port 2 is mapped to physical port 2, it is equivalent to R1,2; 

3) b1,1 Represents Physical port 1 outputs power when the test port receiver of logical port 1 is 

measured. When logical port 1 is mapped to physical port 1, it is equivalent to A,1; 

4) b2,1 Represents Physical port 1 outputs power when the test port receiver of logical port 2 is 

measured. When logical port 2 is mapped to physical port 2, it is equivalent to B,1; 
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5.1.5 Ratio 

Ratio measurement allow you to choose your own ratio of any two receivers that are available in 

your analyzer. S-parameters are actually predefined ratio measurement. For example S11 is A/R1. 

Ratio - Check Activate to create or change a measurement. Select a receiver for the Numerator, 

select another receiver for the Denominator, then select a source port for the measurement. 

The Source port is always interpreted as a logical port number. 

For ratio measurement: "b2/a1,1" means that the logical source port number is 1, and the logical port 

2 measurement receiver/logical port 1 reference receiver. 

 

 

5.2 Frequency range 

Frequency range is the span of frequencies you specify for making a device measurement. 
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5.2.1 Set the frequency range 

Set the range of RF frequencies. 

Operating steps: 

Press Freq on the front panel to open the frequency setting interface, parameter change mode: 

1. Use the numeric keypad to input the value of the frequency and press the unit button to select 

the desired unit. The optional units are GHz, MHz, kHz, and Hz. Press ENTER to select the 

current unit by default. 

2. Press ENTER or the multifunction knob to enter the state of parameter editing. Move the cursor 

to the specified position by the left and right arrow keys. Modify the value by pressing the up and 

down key, rotating the knob, or pressing the numeric keypad. Press ENTER, the knob, or ESC 

to exit the editing mode. 

Note: 

● Start: Specify the starting frequency of the swept measurement range 

● Stop: Specify the end frequency of the swept measurement range 

● Center: Specify a center frequency of the swept measurement range 

● Span: Specify the swept measurement frequency range 

● Step: Specifies the frequency step size between data points 

● Number of Points: Specify the number of measurement points per sweep 

 

5.2.2 CW time sweep or power sweep 

Measurements using a CW time sweep or power sweep will be performed on a single frequency 

rather than the entire frequency range 

Operating steps: 

Press Sweep, use the knob or arrow keys to focus on the Sweep → Sweep type. Parameter change 

mode: 

1. Press ENTER or the knob to enter the parameter editing state and then move the cursor to the 

specified position by up and down arrow keys or the knob to set the Sweep type to CW Time or 

Power Sweep. Press ENTER or the knob to select the current option. 

2. Press Freq use the knob or arrow keys to focus on the Freq → CW parameter entry. Select the 

edit box to enter the edit mode and change the value by pressing the up and down key, rotating 

the knob, or pressing the numeric keypad. Press ENTER, the knob, or ESC to exit editing mode. 
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5.2.3 Frequency resolution 

Set the frequency resolution to 1Hz. 

 

5.3 Power level 

Power level refers to the output power at the port of the vector network analyzer. 

Here are the keys to operation: 

1. Press Power , use the knob or arrow keys to focus on the Power → Power Level parameter 

item. Input the required power level. Press ENTER to exit editing mode. The default unit is dBm. 

2. Press Power , use the knob or arrow keys to focus on the Power → RF Power parameter item. 

Turn on or off RF power. 

3. Press Power , use the knob or arrow keys to focus on the Port Power parameter item, Configure 

start and stop power. Start and stop power are only available in power sweep mode. 

 

5.4 Sweep 

Sweeping refers to the measurement of a series of consecutive data points against a series of 

specified excitation values. 

 

5.4.1 Points 

Data points are the number of data samples representing the measured values at a single excitation 

value. You can specify the number of data points that the vector network analyzer measures in a 

sweep. The sweeping time of the vector network analyzer varies proportionally with the number of 

points. 

Operating steps: 

Press Sweep, use the knob or arrow keys to focus on the Sweep → Number of Points parameter 

item, Enter the number of points required, Press ENTER to exit editing mode. 

The number of data points collected by the vector network analyzer during the measurement sweep 

can be set to any number between 2 and 20001. 
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Note: Maximum point limits may differ for some measurement classes. 

● For maximum trace resolution, use the maximum data points. 

● For faster throughput, use a minimum number of data points to provide an acceptable resolution. 

● To get the best number of points, look for values that do not differ significantly in the measurement 

as you add points. 

● To ensure accurate measurement calibration, ensure that the user uses the same number of 

points for calibration and measurement. 

 

Points are the number of data items collected in one sweep. This number can be set separately for 

each channel. 

● To obtain high trace resolution for excitation values, select a larger point value. 

● For high throughput, keep the smaller point value within the allowable trace resolution range. 

● For high measurement accuracy after calibration, use the same number of points as the actual 

measurement. 

 

5.4.2 Sweep type 

Key operation: 

Press Sweep, use the knob or arrow keys to focus on the Sweep → Sweep Type parameter item. 

Press ENTER or Knob to enter the editing state, then move the cursor to the specified position by up 

and down direction keys or Knob, set the sweep type to the required measurement type, press ENTER 

or Knob to select the current option. 

 

Sweep type: 

● Linear Frequency 

● Log Frequency 

● Power Sweep 

● CW Time 

● Segment Sweep 

 

Linear Frequency: Set the measured abscissa frequency scale as a linear scale, and keep the full 
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frequency scale at equal intervals. 

Log Frequency: Set the measured abscissa frequency scale to log scale. To observe a wider 

frequency range, the calibration interval in the full frequency band is not uniform and presents periodic 

changes. 

Power Sweep: The power sweep will increase or decrease the power of the source according to the 

walk length. Power sweeping is used to characterize power-sensitive circuits through measurements 

such as gain compression. In the Sweep Type dialog box, you can specify “Start Power”, “Stop Power”, 

“CW Frequency”, “Points”. 

CW Time: Set the analyzer to a single frequency, and the data is displayed versus time. 

Segment Sweep: “Segment Sweep” activates a sweep consisting of frequency sub sweep (called 

segmentation). For each segment, you can define a separate power level, IF bandwidth, IF bandwidth 

for each port, sweep time, delay, sweep mode. After the measurement calibration has been performed 

on the entire sweep or all segments, the measurement values of one or more segments can be 

calibrated. 

 

In the Segment Sweep type, the vector network analyzer performs the following operations. 

● Sort all defined segments in order of increasing frequency. 

● Measurements were made at each point. 

● Display a trace containing all retrieved data. 

 

Limitations on segmented sweeping: 

● The frequency range of one segment may not overlap with the frequency range of any other 

segment. 

● The number of segments is limited only by the combined data points of all segments in the sweep. 

 

Operating steps: 

Press Sweep, Use the knob or arrow keys to focus on the Sweep → Sweep Type parameter item. 

Parameter change mode: 

1. Press ENTER or Knob to enter the state of parameter editing, then move the cursor to the 

specified position by up and down arrow keys or Knob, set the sweep type as Segment Sweep, 

and press ENTER or Knob to select the current option. 

2. Press Sweep, use the knob or arrow keys to focus on the Segment Table parameter item. Move 
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the cursor to the specified position by up and down arrow keys or knobs, set Add Segment, Insert 

Segment, Delete Segment and Delete All Segments to perform segment operation. Select the 

segment table for segment setting and tick the corresponding menu to display the corresponding 

contents in the following segment. 

 

Figure 5-1 Segment table 

 

X-Axis Point Spacing: In segment sweep mode, this feature will affect how the segment trace is 

drawn on the screen. This function is in the sub-sweep table menu. 

● When X-axis point spacing is not used, multi-segment sweeping traces may sometimes result in 

many measurement points being squeezed into a narrower portion of the X-axis 

● When X-axis point spacing is used, the X-axis position of each point needs to be selected so that 

all measurement points are evenly distributed along the X-axis. 

 

For example, suppose you have the following two sections: 

 

 

Figure 5-2 X-point spacing is not used 
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Figure 5-3 Use X-axis point spacing 

 

5.5 Trigger 

The trigger is the signal that causes the vector network analyzer to carry out the measurement sweep. 

The vector network analyzer is flexible in the configuration of the trigger function. 

 

5.5.1 Trigger Settings 

Operating steps: 

Press Trigger, use the knob or arrow keys to focus on the Trigger parameter item. 

 

5.5.2 Trigger source 

Operating steps: 

Press Trigger, Use the knob or arrow keys to focus on the Trigger Source parameter item. Press 

ENTER or the Knob to enter the parameter editing state, then move the cursor to the specified position 

by the up and down arrow keys or the knob, and press ENTER or the knob to select the current option. 

 

Trigger source: These Settings determine the source of the trigger signal for all existing channels. A 

valid trigger is generated only if the vector network analyzer is not sweeping. 

 

● Internal triggers: After the previous measurement is completed, the vector network analyzer will 

immediately send a continuous trigger signal. 
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● Bus trigger: The vector network analyzer waits for the SCPI trigger instructions issued by an 

external controller (PC). 

● External trigger: Trigger signals generated by external devices received through the BNC 

Connector on the rear panel. 

● Manual trigger: Manually send a trigger signal to the vector network analyzer. Available Only 

when you select “Manual” to trigger. 

 

5.5.3 Trigger Range 

Operating steps: 

Press Trigger, Use the knob or arrow keys to focus on the Trigger Scope parameter item. Press 

ENTER or the Knob to enter the parameter editing state, then move the cursor to the specified position 

by the up and down arrow keys or the knob, and press ENTER or the knob to select the current option. 

● All channels: Triggers are sent to all triggerable channels. A trigger will sweep all channels that 

can be triggered. (Default setting) 

● Current channel: Triggers are sent to the current channel but after the current channel completes, 

the channel increments to the next triggerable channel. 

 

5.5.4 Channel Settings 

Operating steps: 

Press Trigger, use the knob or arrow keys to focus on the Trigger parameter item. Press ENTER or 

the Knob to enter the parameter editing state, then move the cursor to the specified position by the 

up and down arrow keys or the knob, and press ENTER or the knob to select the current option. 

 

These settings determine the number of trigger signals that the channel will receive. 

● Hold trigger: The channel does not accept any trigger signals. 

● Single trigger: The channel receives a trigger signal and then enters the “hold” state. Another 

way to trigger a single measurement: Set the trigger source to “manual” and send a manual 

trigger. At this point, however, all channels are set to single trigger. 

● Continuous trigger: Channels accept an unlimited number of trigger signals. 

● Hold all channels: All channels enter the hold state and do not accept any trigger signals. 
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● Restart: Stops the currently sweeping Channel, and re-sweep when a new trigger signal is received. 

Examples: 

1. When the trigger source is internal trigger and the trigger mode is "Single" or "Continuous", 

click the "Restart" then the trace will re-sweep from the first frequency point. 

2. When the trigger source is Manual/External/Bus and the trigger mode is "Single" or 

"Continuous", click the "Restart" will stops the currently sweeping and re-sweep when a new 

trigger signal is received. 

3. When channel in Hold mode, click the "Restart" does not do anything. 

4. Multiple Channels in Continuous mode: The current sweep on the current channel is stopped, 

and the first channel that can sweep is started. 

 

5.5.5 Trigger mode 

Operating steps: 

Press Trigger, use the knob or arrow keys to focus on the Trigger → Trigger Setup parameter item. 

Press ENTER or the Knob to enter the parameter editing state. Then move the cursor to the specified 

position by the up and down arrow keys or the knob, and press ENTER or the knob to select the 

current option. 

These settings determine the number of trigger signals that the channel will receive. 

● Sweep trigger: Each “manual” or “external” trigger causes all traces of the shared source port to 

be swept in the order specified below. In the case of a “single” trigger, the count decrements by 

1 after sweeping all traces in all directions. 

● Point trigger: Each “manual” or “external” trigger results in a measurement of a data point. 

Subsequent triggers go to the same trace until it completes, the other traces in the same channel 

are then swept in the order specified below. If it is a "single" trigger, the count decreases by 1 

after measuring all data points on all trace lines in the channel. 

When multi-port calibration is on (requires multi-direction sweeping), the trace on the screen will not 

be updated until all relevant directions have been swept. For example, when all four 2-port S 

parameters are displayed: 

a) If full 2-port calibration is on, triggering 1 will cause no trace to be updated. 

b) When the calibration is off, triggering 1 will cause S11 and S21 updates. Trigger 2 will cause 

updates to S22 and S12. 

 
Trace sweep order: 
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For all trigger modes, the trigger signal remains in the same channel until all traces in this channel 

have been swept, and then continue to trigger the next channel that is not in the "hold" state. 

 

The traces within each channel are always swept in the following order: 

Scan the traces in order of source ports. For example, in a channel with all four 2-port S parameters, 

simultaneously scan the source port 1 trace (S11 and S21). Then, simultaneously scan the source 

port 2 traces (S22 and S12). 

 

5.5.6 External and auxiliary triggers 

Both external and auxiliary triggers are used to synchronize the triggers of the vector network analyzer 

with those of other devices. 

 

Ready signal and trigger signal: 

Ready signals are different from trigger signals. The ready signal is used to indicate that the 

transmitting instrument is ready for measurement. The instrument receiving the ready signal then 

sends a trigger signal indicating that the measurement will be made or that the measurement has 

been completed. Usually, the slower instrument sends the trigger signal. 

● Measurement trigger input: This signal is easy to use, but has limited configuration capabilities. 

● Auxiliary trigger outputs: Connectors and signals are highly configurable and can be used to 

synchronize with any number of devices. 

 

Measurement trigger input 

The trigger input connector is located on the back panel of the vector network analyzer. These signals 

can be used when the vector network analyzer communicates with slower instruments. 

● The vector network analyzer sends a “ready” signal when it is ready for measurement 

● The external device sends a trigger signal to the vector network analyzer when it is ready for 

measurement 

● Additional signals are provided on the vector network analyzer processor I/O to indicate that the 

vector network analyzer sweep has been completed and the processor can be set for the next 

measurement. 
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To make the vector network analyzer respond to measured trigger inputs or processor I/O signals, 

select External on the “Trigger Settings” tab on the “Source” Settings. Also, on the Trigger Settings 

tab, on the Range Settings, select whether an external trigger applies to all channels (global) or one 

channel (local). The appropriate settings to apply are as follows: 

 

Main trigger input: 

Global/ channel trigger delay - after receiving an external trigger, the start time of the sweep will be 

delayed by the specified amount of time plus any inherent delay. 

● When the trigger scope is “channel” , the delay value is applied to the specified channel. 

● When the Trigger Range is Global, the same delay value is applied to all channels. 

 

The VNA receives the trigger input signal through the following connectors: 

● Measure trigger input BNC connector: Trigger input on the rear panel. 

 

Polarity: 

High level: When the vector network analyzer is ready (trigger ready) and the TTL signal on the 

selected input is “high”, It triggers the vector network analyzer. 

Low level: When the vector network analyzer is ready (trigger ready) and the TTL signal on the 

selected input is “low”, it triggers the vector network analyzer. 

Positive edge: When the vector network analyzer is ready, it will trigger on the next positive edge. 

When set to accept a trigger before ready, if a positive edge has been received since the last data 

acquisition, the vector network analyzer will trigger immediately after ready 

Negative edge: When the vector network analyzer is ready, it will trigger on the next negative edge. 

When set to accept the trigger before ready, if a negative edge has been received since the last data 

acquisition, the vector network analyzer will trigger immediately after ready. 

After receiving the trigger selection before being ready, the vector network analyzer will move to the 

ready state (trigger ready), if any triggers have been received since the last data fetch, the vector 

network analyzer will trigger immediately and the vector network analyzer will remember only one 

trigger signal. All other signals will be ignored. 

● If this check box is cleared, any trigger signals received by the vector network analyzer before it 

is ready will be ignored. 

● This feature is only available when a positive or negative edge trigger is selected. 
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Trigger ready indicator (output): 

On the Vector Network Analyzer, when "External" is selected on the "Trigger Settings" tab, both 

"Measurement Trigger Input" and "Measurement Trigger Ready (Output)" will be enabled. 

Select the connector to send the ready output signal of the vector network analyzer: 

● Processor I/O pin 21. 

Select the "polarity" of the "ready output" signal. 

● Ready low: "TTL low" indicates that the vector network analyzer is triggered ready 

 

Auxiliary trigger 

The auxiliary trigger connector is located on the back panel of the vector network analyzer. When the 

external source is configured as an external device, the vector network analyzer will automatically 

control all trigger settings. Do not set other trigger settings. The vector network analyzer will start 

measuring when it receives a valid trigger signal from the specified trigger source: 

● Inside: Measurements begin immediately. 

● Manual: Press the vector network analyzer “Trigger” button to start the measurement. 

● External: The measurement starts when the measurement trigger input signal is received from 

the external device. This must be configured separately. 

The “Auxiliary Trigger Output” signal can be configured to be sent just before the measurement is 

performed or just after the measurement is completed. When communicating with an external source, 

the “Auxiliary Trigger Output” signal should be sent after the measurement is completed to indicate 

that the external source can be set for the next measurement. 

 

Enable: When checked, the signal can be output to external devices using auxiliary connectors. 

● Channel: This setting is controlled by the vector network analyzer “Preferences” setting. 

● Global: All secondary trigger settings apply to all channels. On the Trigger Settings tab, set the 

“Each Point” setting, which also applies to all channels. 

Channels: All secondary trigger settings will be applied to the specified channel and each channel 

can be configured individually. 

 
Auxiliary channel output (to device): 

The following settings control the properties of the signal emitted from the “Auxiliary Trigger Output ” 
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connector on the back panel: 

Polarity: 

Positive pulse: the output pulse is positive. 

Negative pulse: The output pulse is negative. 

 

Location: 

Before acquisition: Send pulses just before data collection begins. 

After the acquisition: Pulses are sent immediately after data collection is completed. 

Each point: When checked, trigger output can be sent for each data point, and when cleared, trigger 

output can be sent for each sweep. 

Select “Auxiliary Trigger” - “Global” vector network analyzer preferences, On the “Trigger Settings” 

tab, the “Dot” Settings are set. After that, this setting applies to all channels. When multiple channels 

exist, the channel settings set last are used.  

Pulse Duration: Specify the duration of a positive or negative output trigger pulse. 

 

5.6 Data format 

The data format is the method by which the vector network analyzer displays the measured data 

graphically. Select the data format that corresponds to the information you want to know about the 

test device. 

 

5.6.1 Display format 

Operating steps: 

Press Format, Use the knob or arrow keys to focus on the Format parameter item. Press ENTER or 

the Knob to enter the parameter editing state, then move the cursor to the specified position by the 

up and down arrow keys or the knob, and press ENTER or the knob to select the current option. 

 

5.6.2 Cartesian coordinates display format 

Nine of the twelve available data formats use rectangular displays to present measurement data. This 
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display is also known as Cartesian, XY, or linear coordinates. The Cartesian coordinate display is 

especially suitable for clearly displaying the frequency response information of the device-under-test 

(DUT). 

● The excitation data (frequency, power, or time) is linearly scaled and displayed on the X-axis 

● The measured response data is displayed on the Y-axis 

 

Log amplitude scheme: 

● Display amplitude (no phase) 

● Y: dB 

● Typical measurements: Return loss, insertion loss, or gain 

 

Phase format: 

The phase of the signal is measured relative to the calibration reference plane, within a range of ±180 

degrees. 

● Display phase (no amplitude) 

● Y: Phase (degrees) 

● Each 180-degree trace is “wrapped” for easy scaling 

● Typical measurement: Linear phase shift. 

 

Unfold phase: 

● Same phase, but no 180-degree entanglement. 

Note: Phase unwrapping is accomplished by comparing the phases of two adjacent data points. If the 

phase difference between the two points is greater than 180 degrees, or the DC offset phase 

of the first data point is greater than 180 degrees, then the phase measurement may not be 

accurate. 

 

Group delay format: 

● Displays the transmission (propagation) time of signal in the device 

● Y: Time (s) 

● Typical measurement: Group delay 
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Linear amplitude scheme: 

● Only positive values are displayed 

● Y: No Unit (U, suitable for proportional measurements)  

  Watts (W, suitable for disproportionate measurements) 

● Typical measurements: Reflection and transmission coefficients (amplitude), time domain 

transformation 

 

SWR format: 

● Displays the reflection measurements calculated from the formula (1+ R) / (1-R), where R is the 

reflection coefficient 

● Valid for reflection measurements only 

● Y: No units 

● Typical measurements: SWR 

 

Real number format: 

● Show only the real part of the measured complex data 

● Can display both positive and negative values 

● Y: No units 

● Typical measurements: Time domain, auxiliary input voltage signals for maintenance purposes 

 

Imaginary number format: 

● Only imaginary parts of the measured data are displayed 

● Y: No units 

● Typical measurement: Network impedance matching 

 

5.6.3 Polar coordinates 

The polar coordinate format is used to view the amplitude and phase of the reflection coefficients in 

S11 or S22 measurements. 
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You can use a cursor to display the following items: 

● Linear or log amplitude (in dB) 

● Phase (in degrees) 

 

Figure 5-5-4 Polar diagram 

 

● The dotted circle indicates the reflection coefficient. The outermost circle represents the reflection 

coefficient with a value of 1. The center of the circle represents the reflection coefficient with a 

value of 0. 

● The radial line shows the phase angle of the reflected signal. The right-most position corresponds 

to the zero-phase angle (that is, the reflected signal has the same phase as the incident signal). 

The phase differences of 90°, ±180°, and -90° correspond to the top, leftmost, and bottom of the 

polar display, respectively. 

 

5.6.4 Smith circle diagram 

Smith diagrams are a tool for mapping complex reflectance coefficients to test the impedance of 

equipment. In the Smith chart, the linear impedance plane is reshaped to form a cyclic grid from which 

the resistance and reactance (R+ Jx) can be read. 

You can use a cursor to display the following items: 

● Resistance (in Ohms) 

● Reactance as equivalent capacitance (in Ephraeras) or inductance (in Henrys) 
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Figure 5-5 Schematic diagram of Smith circle 

 

Smith diagram interpretation: 

● Each point on the Smith chart represents a complex impedance (r±jx) consisting of a real 

resistance (r) and an imaginary reactance (x). 

● The horizontal axis (solid line) shows the real part of the difference between impedance and 

resistance. The horizontal axis always represents the system impedance. The rightmost 
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value is infinite ohms (open path). The leftmost value is zero ohms (short circuit). 

● The dotted circle intersecting the horizontal axis represents a constant resistance. 

● A dashed arc tangent to the horizontal axis represents a constant reactance. 

● The top half of Smith's circle is the region where the reactance component is positive and 

hence inductance is generated. 

● The lower half is the region where the reactance component is negative and therefore 

generates capacitance. 

 

There is also a Reverse Smith circle diagram (also called an Admittance Smith Chart): 

Same as the standard Smith circle, with the following exceptions: 

● The polar grid is reversed from right to left. 

● Admittance (in Siemens) instead of resistance. 

 

5.7 Scale 

5.7.1 Scale/ reference level and position 

The “Scale”, “Reference Level”, and “Reference Position” Settings (as well as the format) determine 

how the data trace will appear on the vector network analyzer screen. 

Operating steps: 

Press Scale, Use the knob or arrow keys to focus on the reference level and reference position 

parameter items under the Scale menu bar. Press ENTER or the knob to enter the parameter editing 

state, then move the cursor to the specified position by the up and down arrow keys or the knob, and 

press ENTER or the knob to select the current option. 

Scale: Sets the vertical indexing value of the rectangular coordinate display format. In polar 

coordinates and Smith chart formats, the scale sets the value of the outer perimeter. Range: 0.001 

dB/div to 1000 dB/div. Scale do not apply in logarithmic scale type. 

Automatic scaling: Automatically sets the vertical indexing value and reference value to fit the 

working data trace in the screen grid area. The excitation value and reference position are not affected. 

The vector network analyzer determines the minimum possible scaling factor that will allow all display 

data to appear on the 80% vertical grid. The selected reference values center the trace on the screen. 

All autoscaling: Automatically scales all data traces in the working window to fit vertically into the 
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grid area of the screen. 

Reference level: Sets the value of the guide in rectangular format. Range: -1000 dB to 1000 dB. In 

polar coordinates and Smith's circle chart formats, and logarithmic scale type, the reference level 

does not apply. 

Reference position: Sets the position of the guide in Rectangular coordinate format. Zero is the 

bottom line and 10 is the top line. The default position is 5 (middle of the screen). Reference positions 

do not apply in polar coordinates, Smith chart formats and logarithmic scale type. 

 

5.7.2 Scaling coupling 

When “Scale Coupling” is enabled, tracks of the same format will have the same “Scale”, “Reference 

Level”, and “Reference Position”. You can choose to couple the scales for traces in the same window, 

for all traces in all Windows, or uncouple them. 

Operating steps: 

Press Scale, use the knob or arrow keys to focus on the Scale → Scale Coupling parameter item. 

Press ENTER or Knob to enter the editing state, select Off / Window / All, then move the cursor to 

the specified position by up and down arrow keys or Knob, press ENTER or Knob to select the current 

option 

Note: Traces of the same format have the same scale, reference level, and reference position. 

 

Coupling Method: 

Close: No coupling. Each trace is scaled individually. This is the default setting. 

Window: All traces of the same format in each selected window share the same scale settings 

All: Coupled between all selected windows, all traces of the same format in all selected windows 

share the same scale settings. 

● When window or full coupling is enabled, the scale settings for the working trace will be adopted 

by other coupling traces of the same format 

● If traces of a different format exist, all traces of that format will be set as the least numbered trace 

in that format 

● Once enabled, the scale settings for all coupling traces of the same format can be changed with 

any coupling trace in the working state 
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Selected Windows: 

Available when selecting a window or all methods. The selected window participates in scaling 

coupling. By default, all windows are selected. Cancel the check box to disable zoom coupling for this 

window. 

 

About “Auto Scaling” and “Scaling Coupling”: 

Automatic scaling using the coupling method affects the work trace in the work window. All traces 

coupled to this trace will be set with the new scale of the working trace. This will cause some traces 

to not appear on the screen. 

 

Full automatic scaling using the coupled method 

● Close: All traces in the working window are automatically scaled separately. 

● Window: All traces in each selected window are automatically scaled to conform to a common 

set of scaling factors. 

● All: All traces in all selected Windows are automatically scaled to conform to a common set of 

scaling factors. 

 

5.7.3 Electrical delay 

Electrical delay is a mathematical function that simulates the variable length of a lossless transmission 

line. Linear phase shifts through the device can be compensated using the electrical delay function. 

Use this feature to determine only the linear phase deviation of the device. Electrical delay can be set 

separately for each measuring trace. 

Operating steps: 

Press Scale, use the knob or arrow key to bring focus to the Electrical Delay parameter item. Press 

ENTER or Knob to enter the editing state. After the editing is completed, move the cursor to the 

specified position by up and down direction keys or Knob. Press ENTER or Knob to select the current 

option. 

 

Delay time: Specifies the value of the delay added or removed, expressed in time or distance. This 

compensates for the linear phase shift through the device. Electrical delay can be set separately for 

each measuring trace. 
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Speed coefficient: Specify the velocity factor applied to the device media inserted after 

measurement calibration. The value is 0.66 for polyethylene insulated cables and 0.7 for PTFE 

insulators.1 corresponds to the speed of light in a vacuum. 

 

Distance unit: Select meters, inches, or feet. When you change this value, the step size does not 

change automatically. 

 

5.7.4 Amplitude offset and amplitude slope 

The “amplitude offset” allows the amplitude (rather than phase) data to be offset by a fixed or slope 

value in Db. The amplitude offset setting affects only the work trace. If the display format is “Linear 

Amplitude” or “Real Number” (unitless), the dB is converted and the correct offset is implemented. 

 

Operating steps: 

Press Scale, use the knob or arrow keys to bring focus to the Constants → Mag Offset / Mag Slope 

parameter item. 

Press ENTER or Knob to enter the editing state. After the editing is completed, move the cursor to 

the specified position by up and down direction keys or Knob. Press ENTER or Knob to select the 

current option. 

Amplitude deviation: Offset the entire data trace at the specified value. 

Margin slope: Offset the data trace by some value that changes with frequency. The offset slope 

starts at 0 Hz. 

 

5.7.5 Phase deviation 

Phase offset mathematically adjusts the phase measurement to a specified degree (up to 360°). This 

feature can be used in the following ways: 

● Improved display of phase measurements. This is the same way as changing the reference level 

in the amplitude measurement. Change the phase response to the center or align the response 

on the screen. 

● Simulate Projection phase shift in measurements. For example, if you know that you need to add 

a cable and that the length of the cable will add a certain phase shift to the measurement, you 

can use a phase shift to increase the length and simulate the entire device measurement. 



SHN900A User Manual 

www.siglent.com                                                                                69 

 

Operating steps: 

Press Scale, use the knob or arrow keys to bring focus to the Constants → Phase Offset parameter 

item. Press ENTER or Knob to enter the editing state. After the editing is completed, move the cursor 

to the specified position by up and down direction keys or Knob. Press ENTER or Knob to select the 

current option. 

 

5.7.6 Divisions 

Sets the number of divisions on the Y axis. An even number from 4 to 30 must be used. Once set, it 

is commonly applied to all the traces displayed in the linear scale type on the Y axis within that window.  

Operating steps: 

Press Scale, use the knob or arrow keys to focus on the Advanced → Divisions parameter item. 

Press ENTER or Knob to enter the editing state. Set the value of the Y-axis divisions in the Cartesian 

coordinate format. After the editing is completed, move the cursor to the specified position by up and 

down direction keys or Knob. Press ENTER or Knob to select the current option. Range: even 

numbers from 4 to 30. Divisions do not apply in polar coordinates, Smith chart formats and logarithmic 

scale type. 

 

5.7.7 Scale type 

The scale types include linear scale and logarithmic scale, which are expressed as the scale 

distribution of the Y axis in the coordinate system. In a logarithmic scale type, the upper and lower 

limits of the Y-axis determine how the data trace is displayed on the VNA screen. The scale type can 

be set separately for each measuring trace. 

Operating steps: 

Press Scale, use the knob or arrow keys to focus on the Advanced → Scale Type parameter item. 

Press ENTER or Knob to enter the editing state. After the editing is completed, move the cursor to 

the specified position by up and down direction keys or Knob. Press ENTER or Knob to select the 

current option. 

Note: The logarithmic scale type can only be selected when the display format is linear magnitude 

scheme, real number format or imaginary number format. Other formats are linear scale type. 
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Scale type: 

● Linear Scale Type 

● Log Scale Type 

Linear: Y-axis scale linear distribution. The display mode can be set by setting scale, reference level 

and position. 

Log: The Y-axis scale is logarithmic. The display range can be set by setting the maximum and 

minimum values of the Y axis. 

Max Value: Set the upper limit of the Y-axis in the logarithmic scale type. 

Min Value: Set the lower limit of the Y-axis in the logarithmic scale type. 

 

5.8 Avg BW And IFBW 

5.8.1 Overview 

The dynamic range is the finite difference between the maximum input power level and the minimum 

measurement power level (noise floor) of the analyzer. In evaluating a characteristic accompanied by 

a large change in the amplitude (the start and stop band of a filter for example), it is important to 

increase the dynamic range. The noise floor can be reduced by narrowing the IF bandwidth or turning 

on Sweep Averaging. 

For minimizing very low noise, Averaging is more effective than reducing IF bandwidth. Generally, 

Averaging takes slightly longer than IF bandwidth reduction to lower noise, especially if many 

averages are required. Also, changing the IF bandwidth after calibration results in uncertain accuracy. 

 

5.8.2 Averaging 

Averaging is a feature that the VNA averaging on each data point before stepping to the next data 

point. You determine the number of measurements by setting the averaging factor. The higher the 

averaging factor, the greater the amount of noise reduction. 

Averaging setting: 

Press the “Avg BW” key, then enter the Averaging and Bandwidth menu. 
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Figure 5-6 Avg BW menu 

 

A. Averaging Enable. 

B. Sweep Averaging factor. (an integer between 1 

and 999) 

C. Averaging Restart. 

 

 

5.8.3 IF Bandwidth 

The received signal of VNA is converted from its source frequency to a lower intermediate 

frequency (IF). Reducing the IF receiver bandwidth reduces the effect of random noise on a 

measurement. Each tenfold reduction in IF bandwidth lowers the noise floor by 10 dB. However, 

narrower IF bandwidths cause longer sweep times. 

IF Bandwidth setting: 

1. Using the Softkey for setting: Press the “Avg BW” key, Press “Avg BW” > Averaging > IF 

Bandwidth > Enter the IF Bandwidth value. 
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Figure 5-7 Set the IF from the menu bar 

 

2. Using a mouse for setting: Click the “BW=xx” icon on the menu bar and select IF Bandwidth. 

 

Figure 5-8 Set the IF from the status bar 

 

5.8.4 Smoothing 

Trace smoothing averages several adjacent data points to smooth the displayed trace. The number 

of adjacent data points that get averaged together is also known as the smoothing aperture. You can 

specify the aperture as either the number of data points or the percentage of the x-axis span. 

Trace Smoothing reduces the peak-to-peak noise values on broadband measured data. It smooths 

trace noise and does not increase measurement time significantly. 

 

Smoothing setting: 

Using the Softkey for setting: Press the “Avg BW” key, “Avg BW” > Smoothing then enter the 

Smoothing menu. 
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Figure 5-9 Smoothing menu 

A. Smooth On|Off When is On, applies smoothing 

to the displayed trace. 

B. Percent of Smooth: Specify the percent of the 

swept stimulus span to smooth. For example, 

for a trace that contains 100 data points, and a 

smoothing percent of span = 11%, then the 

number of data points that are averaged is 11. 

C. Smooth Points: Specify the number of adjacent 

data points to average. 

 

 

Tips: 

● Start with a high number of display points and reduce until you are confident that the trace is not 

giving misleading results. 

● Do not use smoothing for high-resonance devices, or devices with wide trace variations. It may 

generate misleading information. 

● Smoothing is set independently for each trace. 

 

5.9 Preset instructions 

Invokes preset Settings to restore system Settings to the specified just started state. 

Operating instructions: 

● Preset types are available through Preset → Preset Option, Select “Default”, “Last”, or 

“User”. 

● Press the Preset key, and the device invokes either default Settings or user Settings. 

 

Table 5-1 Some default setting values 

Parameter name Parameter value 

RF Power 

RF state ON 

RF level -10 dBm 
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Frequency 

Frequency range 100 kHz-26.5 GHz 

Frequency step size 132.4995MHz 

Frequency points 201 

Sweeping 

Sweeping points 201 

Sweeping type Linear frequency 

Sweeping time delay 0 s 

Sweeping mode automatic 

Trigger 

Trigger mode continuous 

Trigger source internal 

Measurement 

S parameter S11 

Display format 

Data display format Log Mag 

Scale 

Scale 10 dB 

Reference level 0 dB 

reference position 5 

Scale coupling OFF 

Delay time 0 s 

Delay distance 0 m 

Distance unit meter 

Speed coefficient 1 

System impedance 50 Ω 

Phase deviation 0° 

Amplitude deviation 0 dB 

Average 

Average state OFF 

Smooth state OFF 

Calibration 
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Calibration state unloaded calibration data 
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6 Measurement Calibration 

6.1 Overview 

Usually, DUTs can't be measured directly and accurately due to cabling, adapters, probes, and more. 

Calibration, compensation, and fixture simulation are introduced to help achieve higher accuracy. 

These functions meet different measurement requirements, but they all can be expressed as a matrix 

multiplication of the scattering parameter matrix and a specific compensation matrix. The order of the 

matrix multiplication has a large influence on the result. So it's important to understand the order of 

applying these functions and to design a suitable physical connection to the DUT and expected 

measurement network. 

Internal source power calibration and receiver calibration are applied before the scattering parameter 

calculation, and the S parameter calibration is applied to the calculation results. This provides the 

highest measurement accuracy at the calibration reference plane.  

From the reference plane, the order of applying functions is as follow: 

 

 

 

Figure 6-1 The order of applying functions 

 

At first, adapter removal/ insertion, port extension, 2-port de-embedding are applied to remove the 

needless networks in the physical connections of the DUT and move the measurement plane to the 

DUT. Then, Port match, N-port embedding/ de-embedding, port impedance conversion are used to 

embed or de-embed expected virtual networks. If balance scattering parameters are measured, 

balance conversion, differential port match, differential port impedance conversion, common port 
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impedance conversion can be helpful if needed. 

 

6.2 Calibration type 

The following table is a comparison of some common S-parameter calibration types: 

Table 6-1 S-parameter calibration types 

Calibration type precision Allow pass-through methods 

TRL Very high All, except the unknown direct 

SOLT high All 

Enhanced Response high 
Defined through or flush through (zero-length 

through) 

Port 1 (reflection) high Not Applicable 

Open Circuit Response/ 

Short Circuit Response 
low Not Applicable 

Direct Response low 
Known through or flush through (zero-length 

through) 

 

The following are the actual S-parameter calibration types used by this vector network analyzer. 

Table 6-2 The vector network analyzer S parameter calibration types 

Port number Calibration type Calibration item 

Port 1 

Response (Open) Open, Load (optional) 

Response (Short) Short, Load (optional) 

OSL Open, Short, Load 

Port 2 

Response (Thru) 1 → 2 Thru, Isolation (optional) 

Response (Thru) 2 → 1 Thru, Isolation (optional) 

Enhanced Response (Thru) 1 → 2 
Port1:Open, Short, Load 

Thru, Isolation (optional) 

Enhanced Response (Thru) 2 → 1 
Port2:Open, Short, Load 

Thru, Isolation (optional) 

SOLT 

Port1: Open, Short, Load 

Port2: Open, Short, Load 

Thru, Isolation (optional) 



SHN900A User Manual 

78                                                                               www.siglent.com 

SOLR 

Port1: Open, Short, Load 

Port2: Open, Short, Load 

Unknown Thru, Isolation (optional) 

TRL 

Port1: Reflect (Open or Short) 

Port2: Reflect (Open or Short) 

Thru, Line 

 

TRL:  

Application: Used to precisely calibrate any pair of ports when no calibration kits are readily Available. 

 

Note: Difference matching calibration may be required (Delta Match Cal) 

Overall accuracy: Very high 

Calibration kits required: Straight, reflection, line, or similar combination 

Corrected system error: 

● Directivity 

● Isolation 

● Frequency response  

transmission tracking 

● Source match 

● Load match 

● Frequency response  

reflection tracking 

 

SOLT: 

Application: Used to accurately calibrate any number of ports 

Overall accuracy: High 

Required calibration kits: short circuit, open circuit, load, through) or ECAL electronic calibration parts 

module 

● Directivity 

● Isolation 

● Frequency response  

transmission tracking 

● Source match 

● Load match 

● Frequency response  

reflection tracking 

 

Enhanced Response: 

Application: Calibrate two ports when only one direction (forward or reverse) is needed for 
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measurement. Because no secondary sweep is required, the measurement is faster. 

● The reflection calibration element (open, short circuit, or load) is connected to the source 

port to be calibrated. 

● The defined through-through or flush through-through calibrator kits are connected between 

port pairs. 

● The mechanical calibration kit is much faster than the SOLT. You can also use ECAL. 

 

To select an enhanced response, do the following: 

Keys operation:  

Press Cal, using the knob or arrow keys, to focus on the Cal → Basic Cal parameter item. Select 

port1 & port2 from the interface menu, Select Enhanced Response 1 → 2 or Enhanced Response 

2 → 1 in the Cal Type, Press ENTER or the knob to select the current option. 

Overall accuracy: High 

Required calibration kits: Short circuit, open circuit, load, defined through or flush through 

Corrected system error: 

● Directivity (Source port) 

● Isolation 

● Frequency response transmission tracking (receiver port) 

● Source match (source port) 

● Load matching (receiver port) is used only to generate transmission trace items 

● Frequency response reflection tracking (source port) 

 

One port (reflection): 

Application: Used to accurately calibrate any test port suitable for reflection measurement only 

Overall accuracy: High 

Required calibration kits: Short circuit, open circuit, and load or ECAL module 

Corrected system error: 

● Directivity 

● Frequency response reflection tracking 
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● Source match 

 

Open circuit response / short circuit response: 

Application: Quick calibration of any test port suitable for reflection measurement only 

Overall accuracy: Low 

Calibration kits required: Open circuit or short circuit. 

Corrected system error: 

● Frequency response reflection tracking 

 

Direct / Transport Tracking (isolation optional): 

Application: Quick calibration of any pair of test ports suitable for transmission measurements only. 

Isolation calibration is generally not recommended. 

Overall accuracy: Low 

Required calibration kit: Through 

Isolation: Each load corresponds to a vector network analyzer test port. 

Corrected system error: 

● Isolation 

● Frequency response transmission tracking 

 

Power calibration types: Transmitter calibration (internal source power calibration) and receiver 

calibration. 

 

6.3 Checking Calibration Status 

6.3.1 Execution Status of Error Correction for Each Channel 

User can check the execution status of error correction for each channel with the error correction 

status. 

The error correction status is indicated in the channel status bar in the lower part of the window by 

the symbols in the below table. 
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Symbol Execution Status of Error Correction Accuracy 

No Cor Error correction: Off (No Correction) Lowest 

C N-Port Error correction: On (Full N Port Correction) Highest 

C* N-Port Error correction: On (Interpolation is being executed) Uncertain 

CΔ N-Port Error correction: On (Stimulus settings change) Uncertain 

 

No Cor 

It indicates there is no Correction. The following will cause the VNA to turn Error Correction OFF for 

the channel: 

● Decrease the start frequency. 

● Increase the stop frequency. 

 

C N-Port 

Full N Port correction, where N is the number of fully calibrated ports. This correction is applied to 

SParameters. 

 

C* N-Port 

"C* " appears in the status bar when a measurement is being interpolated. Interpolation occurs when 

you change any of the following settings: 

 Start frequency increased 

 Stop frequency decreased 

 Increase number of points  

 Change sweep type. 

 

CΔ N-Port 

"CΔ" appears in the status bar when one or more of the following stimulus settings change. The 

resulting measurement accuracy depends on which parameter has changed and how much it has 

changed. For optimum accuracy, recalibrate using the new settings. 

 Sweep time 

 IF Bandwidth 
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 Port power 

 

6.3.2 Execution Status of Error Correction for Each Trace 

User can check the status of the error correction actually executed for each trace with the trace status 

area. 

For a trace for which error correction is executed, the applied calibration type is indicated in the trace 

status area by the symbols in the table below. 

Symbol Calibration type 

RO Open response calibration 

RS Short response calibration 

RT Thru response calibration 

ER Enhanced response calibration 

F1 1-port calibration 

F2 Full 2-port calibration/2-port TRL calibration 

 

If none of the symbols described above is displayed, error correction is not executed for the trace. 

 

6.3.3 Acquisition Status of Calibration Coefficient for Each Channel 

User can check the acquisition status of the calibration coefficient for each channel with the calibration 

property. 

The calibration property displays the acquisition status of the calibration coefficient between test ports 

for each channel in matrix format. The following figure shows an example of when the calibration 

coefficients have been acquired for the full 2-port calibration between test ports 1 and 2. 
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F : Full Port Calibration 

R : Response Calibration 

-- : Nothing 

 

6.3.4 Procedure to turn on/off calibration property display 

There are two methods to turn on/off the display of calibration property. 

Method 1: Click the channel error correction execution status symbol in the channel status bar to open 

and close, as shown in the left figure below. 

Method 2: Press "Cal” on the front panel > Cal > Correction, as shown in the right figure below. 
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6.4 S parameter calibration 

6.4.1 S parameter calibration Kit management 

6.4.1.1 Overview 

For most applications, the default calibration kit models provide sufficient accuracy for your calibration. 

However, several situations may exist that would require you to create a custom calibration kit: 

● Using a connector interface different from those used in the predefined calibration kit models. 

● Using standards (or combinations of standards) that are different from the predefined calibration 

kits. For example, using three offset SHORTs instead of an OPEN, SHORT, and LOAD to perform 

a 1-port calibration. 

● Improving the accuracy of the models for predefined kits. When the model describes the actual 

performance of the standard, the calibration is more accurate. For example, A 7 mm LOAD is 

determined to be 50.4 Ω instead of 50.0 Ω. 

● Modifying the THRU definition when performing a calibration for a non-insertable device. 
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● Performing a TRL calibration. 

 
Operation instructions: 

Press “Cal” on the front panel, Cal > Cal >Cal Kit to enter the Manage Cal Kits page. You can edit, 

import, and create or delete calibration kits. 

 

Figure 6-2 Manage Cal Kits 

 

A. Edit the Existing Cal Kit. 

B. Import the customized Cal Kit. 

C. Save the existing Cal kits and change the file name. 

D. Create a new custom Cal Kit. 

E. Select the Cal Kit. 

F. Save the current Cal kits (both factory and custom). 

G. Recall the Cal Kits. 

H. Restore the default factory Cal kits. 
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6.4.1.2 Connector Tab 

At the bottom of each Tab, 'OK' is used to save the edited file, and 'Cancel' is used to close the 

calibration suite edit session and the file will not be saved. “Help” is used to view the Help documents. 

 

Figure 6-3 The Connectors Tab interface 

 

A. Connector Family: Click the down arrow to select the connector family associated with the Cal 

Kit. 

B. Add: Starts the Add Connector dialog box which allows you to add a new connector type to the 

calibration kit. 

C. Delete: Delete the selected connector family. 

D. Frequency Range: Define the lowest and the highest frequency at which the standard is used 

for calibration. 

E. Gender: Gendered or Genderless 

F. Impedance: Specify the impedance of the standard. 

G. Transmission Media: The medium of the connector, COAX or WAVEGUIDE 
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6.4.1.3 Standards Tab 

Allows you to Add, Edit, or Delete Cal standards in a Cal kit. 

1) In the “Standard” tab, click “Add” to add the Standard sample. 

 

Figure 6-4 add standard interface 

 

2) Standards dialog box help, the following fields apply to ALL standard types. 

 

Figure 6-5 The help dialog of the Standard 

 

A. Identification 

Standard ID: Number in list of standards 

Label: Type of standard. This usually appears in prompts for standards. 

Description: Description of standard. 
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B. connector 

Indicates the type and gender (Male, Female, None) of the standard. 

Thru and Isolation standards have two connectors. 

C. Frequency Range 

Min: Defines the lowest frequency at which the standard is used for calibration. 

Max: Defines the highest frequency at which the standard is used for calibration. 

D. Delay Characteristics 

Delay: Defines the one-way travel time from the calibration plane to the standard in seconds. 

Z0: Defines the impedance of the standard. 

Loss: Defines energy loss in Gohms, due to skin effect, along a one-way length of coaxial cable. 

 

3) Open Standard 

C0, C1, C2, C3: Specify the fringing capacitance. 

 

Figure 6-6 Open Characteristics 

 

4) Short Standard 

L0, L1, L2, L3: Specify the residual inductance. 

 

Figure 6-7 Short Characteristics 

 

5) Load Standard 

 

Figure 6-8 load Characteristics 
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6) THRU Standard 

 

Figure 6-9 THRU Characteristics 

7） DATA-BASED 

 

Figure 6-10 DATA-BASED Characteristics 

 

6.4.1.4 SOLT Tab 

Allows you to assign single or multiple standards to SOLT Calibration Classes. 

1) For each Cal Kit Class, select Available Standards from the left list, then click >> to copy the 

standard to the Cal Kit 
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2) Use Move Up and Move Down to change the ORDER of the standards. 

 

Figure 6-11 SOLT Tab dialog box 

 

6.4.1.5 TRL Tab 

Allows you to assign single or multiple standards to Calibration Classes. 

1) For each Cal Kit Class, select Available Standards from the left list, then click >> to copy the 

standard to the Cal kit. 

2) Use Move Up and Move Down to change the ORDER of the standards. 
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Figure 6-12 TRL dialog box 

 

A. TRL THRU 

All THRU calibration methods are supported in a TRL Cal EXCEPT Unknown Thru. 

● The THRU standard can be either a zero-length or non-zero length. However, a zero-length 

THRU is more accurate because it has zero loss and no reflections, by definition. 

● The THRU standard cannot be the same electrical length as the LINE standard. 

● If the insertion phase and electrical length are well-defined, the THRU standard may be used 

to set the reference plane. 

● The THRU standard and LINE standard have the same characteristic impedance and are 

perfectly matched. They define the reference impedance of the calibration. 

● If a THRU standard with the correct connectors is NOT available, an adapter removal Cal 

can be performed. 

 

B. TRL REFLECT 
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● The REFLECT standard can be anything with a high reflection, as long as it is the same 

when connected to one or more VNA ports. 

● The REFLECT standard on each port is identical. 

● The actual magnitude of the reflection need not be known. 

● The phase of the reflection standard must be known within 1/4 wavelength. 

● If the magnitude and phase of the reflection standard are well-defined, the standard may be 

used to set the reference plane 

 

C. TRL LINE 

The LINE and THRU standards establish the reference impedance for the measurement after the 

calibration is completed. TRL calibration is limited by the following restrictions of the LINE standard 

● Must be of the same impedance and propagation constant as the THRU standard. 

● The electrical length need only be specified within 1/4 wavelength. 

● Cannot be the same length as the THRU standard. 

● Must be an appropriate electrical length for the frequency range 

 

D. TRL MATCH 

If the LINE standard of appropriate length or loss cannot be fabricated, a MATCH standard may be 

used instead of the LINE. 

● The MATCH standard is a low-reflection termination connected to both Port 1 and Port 2. 

● The MATCH standard may be defined as an infinite length transmission line OR as a 1-port 

low reflect termination, such as a load. 

● When defined as an infinite length transmission line, both test ports must be terminated by 

a MATCH standard at the same time. When defined as a 1-port load standard, the loads are 

measured separately. The loads are assumed to have the same characteristics. 

● The impedance of the MATCH standard becomes the reference impedance for the 

measurement. For best results, use the same load on both ports. The load may be defined 

using the data-based definition, the arbitrary impedance definition, or the fixed load definition. 

 

E. Calibration Reference Z0 

● System Z0: The system impedance is used as the reference impedance. Choose when the 



SHN900A User Manual 

www.siglent.com                                                                                93 

desired test port impedance differs from the impedance of the LINE standard. Also, choose 

when skin effect impedance correction is desired for coax lines. 

● Line Z0: The impedance of the line standard is used as the reference impedance or center 

of the Smith Chart. Any reflection from the line standard is assumed to be part of the 

directivity error. 

 

F. Test Port Reference Plane 

● Thru Standard: The THRU standard definition is used to establish the measurement 

reference plane. Select if the THRU standard is zero-length or very short. 

● Reflect Standard: The REFLECT standard definition is used to establish the position of the 

measurement reference plane. Select if the THRU standard is not appropriate AND the delay 

of the REFLECT standard is well defined. 

 

6.4.1.6 Greate a custom Cal Kit 

There are two methods to create a custom Cal Kit: 

Method 1: Create custom Cal Kit based on existing Cal kits 

1. Press “Cal” > Cal > Cal Kit > F503ME > Save. Select the existing F503ME Cal Kit then save it to 

a local file named “F503ME123.xkt”. 

 

Figure 6-13 Creating a Custom Cal Kit dialog box 
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Figure 6-14 Save the ECal Kit 

 

2. In the Manage Cal Kits dialog box, click “Import” to Import the new calibration “F503ME123.xkt”. 

 

 

Figure 6-15 Import the new ECal Kit 

 

3. Select the newly imported calibration, click “Edit” to enter the calibration editing interface, and 

modify the calibration name as “F530ME-ABC”. 
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Figure 6-16 Edit the new import ECal Kit 

 

4. Click the Connectors, Standards, SOLT, and TRL Tabs to modify the corresponding parameters 

as you need. 

5. Click “OK” for the changed Cal Kit to take effect. 

 

Figure 6-17 View the newly created Cal Kit 
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Method 2: Create a custom Cal Kit directly for new connector types. 

1. Press “Cal” > Cal > Cal Kit > Insert... 

2. Enter the name and description of the custom Cal Kit. 

3. Refer to Method 1, click the Connectors, Standards, SOLT, TRL tab to modify the corresponding 

parameters. 

4. Click “OK” to make the created calibration effective. 

 

6.4.2 S Parameter calibration wizard 

S parameter user calibration can be started after selecting the required S parameter calibration type 

in the calibration wizard and setting the corresponding parameters. 

Operating instructions: 

Press the Cal key, use the knob or the arrow key to make the focus fall on Basic Cal, and press Enter 

to enter the setting interface of the calibration kit: 

 

Figure 6-18 Calibration wizard interface 

 

Select the number of ports to be calibrated from the port menu in the calibration wizard interface, and 

select the corresponding calibration kit model in the Cal Kit pull-down option. Select the gender 

properties of the calibration connector from the DUT Connector drop-down option, and select the 

corresponding calibration method from the Cal Type drop-down option, as shown in the figure below: 
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Figure 6-19 Calibration wizard interface 

 

After the calibration is set, a specific calibration item interface will appear as shown in the figure below. 

Here, taking the two-port SOLT calibration method as an example, it includes several calibration items: 

OPEN, SHORT, LOAD, THRU, ISOLATION, among which the ISOLATION calibration item may not 

be calibrated. There is no sequence relation between these calibration terms. Simply select the 

corresponding calibration kit and click the corresponding calibration item menu on the interface.  

After completion of the corresponding calibration item, the percentage of calibration progress will be 

displayed in the lower-left corner of the interface. When all the calibration steps are completed, the 

calibration progress bar will show 100%. Click Finish to exit the calibration interface, calibration results 

are automatically loaded in the current screen. 

 

Figure 6-20 Calibration wizard interface 

 

To Save the current calibration data for future use, press the Save Recall button and use the knob or 

arrow keys to bring the focus to the Save State menu bar. Select State+Cal Data from the Save Type 

drop-down option, click Save State As and enter the file name, and click OK to Save the current 

calibration Data and the current setting State. 
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Figure 6-21 Calibration wizard interface 

 

6.4.3 Open Response Calibration 

When a single port is used for open-circuit response calibration, the reflection tracking error in the 

error model of the test device can be calculated by only connecting the OPEN calibration element to 

the test port. If the LOAD calibration element is used for isolation calibration at the same time, the 

directional error can be calculated. 

 

Figure 6-22 Schematic diagram 

 

Operating steps: 
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1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band and other 

parameters. 

3. Select Cal → Basic Cal to enter the Settings screen. 

4. Select only Port1 or Port2, select the required calibration kit in the Cal Kit, select the Type of 

calibration element connector, Female or Male, in the DUT Connector, select Response(Open) 

in the Cal Type, and click Next to proceed to the next step. 

5. Connect the OPEN calibration element to the test port according to the interface prompts, click 

Open for calibration, and click Finish to exit the calibration interface after calibration, complete 

the calibration, and save the calibration data. 

 

6.4.4 Short circuit response calibration（One Port） 

Like the open-circuit response calibration, the single-port short-circuit response is connected to the 

port with the SHORT calibration element, and the reflection tracking error can be calculated. If the 

LOAD calibration element is used for isolation calibration at the same time, the directional error can 

also be calculated. 

 

Operating steps: 

1. Preset Vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band and other 

parameters. 

3. Select Cal → Basic Cal to enter the setting interface. 

4. Select only Port1 or Port2, select the required calibration kit in the Cal Kit, select the Type of 

connector, Female or Male, in the DUT Connector, select Response(Short) in the Cal Type, 

and click Next to proceed to the next step. 

5. Connect the Short calibration element to the test port according to the interface prompts, click 

Short for calibration, and click Finish to exit the calibration interface, complete the calibration, 

and save the calibration data. 

 

6.4.5 Full 1 port OSL calibration 

All 1-port OSL calibration connects the OPEN, SHORT, and LOAD calibration elements to the test 
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ports in turn to calculate the reflection tracking error, directional error, and source matching error in 

the error model of the test device. 

 

Figure 6-23 Schematic diagram 

 

Operating steps: 

1. Preset Vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and other 

parameters. 

3. Select Cal → Basic Cal to enter the setting interface. 

4. Select only Port1 or Port2, select the desired calibration kit in the Cal Kit, select the Type of 

calibration connector, Female or Male, in the DUT Connector, select OSL (Open, Short, Load) 

in the Cal Type, and click Next to proceed to the next step. 

5. According to the interface prompts, first connect the Open calibration component on the test port, 

click Open to calibrate, then connect the Short calibration component on the test port, click Short 

to calibrate, and finally connect the Load calibration component on the test port, click Load to 

calibrate. After calibration is completed, click Finish to exit the calibration interface, complete 

calibration, and save the calibration data. 

 

6.4.6 Transmission response calibration (two ports) 

Two-port transmission response calibration is to connect the THRU calibration kit between two ports 

to calculate the transmission tracking error in the test device error model. If the LOAD calibration kit 

is used for isolation calibration at the same time, isolation error (crosstalk error) can also be calculated. 
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Figure 6-24 Schematic diagram 

 

Operating steps: 

1. Preset Vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and other 

parameters. 

3. Select Cal → Basic Cal to enter the setting interface. 

4. Select both Port1 and Port2, select the desired calibration kit in the Cal Kit, select the Type of 

calibration connector, Female or Male, in the DUT Connector, Select Response (Thru) 1 → 2 

or Response(Thru) 2 → 1 in the Cal Type (the difference is to test S21 or S12), and click Next 

to proceed to the next step. 

5. Connect the Thru calibration element between the test ports according to the interface prompts, 

click Thru for calibration, and click Finish to exit the calibration interface, complete the calibration, 

and save the calibration data. 

 

6.4.7 Enhanced response calibration (two ports) 

Two-port enhanced response calibration connects the Thru calibration element between two ports, 

and only connects the Open, Short, and Load on one port for calibration, or connects the LOAD 

element to both ports for isolation calibration. 

Operating steps: 

1. Preset Vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and other 

parameters. 

3. Select Cal → Basic Cal to enter the setting interface. 

4. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the type of 

calibration connector, Female or Male, in the DUT Connector, Select Enhanced Response 1 
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→ 2 or Enhanced Response (Thru) 2 → 1 in the Cal Type (the difference is that S21 or S12 is 

tested during THRU calibration), and click Next to proceed to the next step. 

5. According to the interface prompts, connect Open, Short, and Load on a test port to complete 

the calibration successively, and then connect the THRU calibration kit between the two ports to 

perform the Thru calibration. After the calibration is completed, click Finish to exit the calibration 

interface, complete the calibration and save the calibration data. 

 

6.4.8 SOLT calibration (two ports) 

Two-port SOLT calibration connects the Open, Short, and Load calibration elements to each test port 

in turn and the THRU calibration kit between the two test ports. All 12 error parameters of the two 

ports can be calculated, including 6 forward and 6 reverse errors, including directional, source 

matching, reflection tracking, transmission tracking, isolation (crosstalk), and load matching errors. It 

is also possible to connect the LOAD element to both ports for isolation calibration. 

 

Figure 6-25 Error model diagram 

 

Operating steps: 

1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and other 

parameters. 

3. Select Cal → Basic Cal to enter the Settings screen. 

4. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the type of 

calibration connector, Female or Male, in the DUT Connector, select SOLT in the Cal Type, and 

click Next to proceed to the next step. 
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5. According to the interface prompts, connect the Open, Short, and Load calibration elements to 

Port 1 successively, and click the corresponding Open, Short, and Load items successively to 

complete the Port 1 calibration. 

6. According to the interface prompts, connect the Open, Short, and Load calibration elements to 

Port2 successively, and click the corresponding Open, Short, and Load items successively to 

complete the Port 2 calibration. 

7. According to the interface prompts, connect the THRU calibration kit between the two ports to 

perform the Thru calibration. 

8. After the calibration, click Finish to exit the calibration interface, complete the calibration, and 

save the calibration data. 

 

6.4.9 SOLR unknown through calibration (two ports) 

In contrast to the two-port SOLT calibration, the error term in the test unit can be calculated without 

knowing the S-parameter of the THRU straight-through calibration. The calibration method is similar 

to that of SOLT in that it is possible to connect the LOAD to both ports for isolated calibration. 

Operating steps: 

1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and other 

parameters. 

3. Select Cal → Basic Cal to enter the Settings screen. 

4. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the Type of 

calibration Connector, Female or Male, in the DUT Connector, select SOLR in the Cal Type, 

and click Next to proceed to the next step. 

5. According to the interface prompts, connect the Open, Short, and Load calibration elements to 

Port 1 successively, and click the corresponding Open, Short, and Load items successively to 

complete the Port 1 calibration. 

6. According to the interface prompts, connect the Open, Short, and Load calibration elements to 

Port 2 successively, and click the corresponding Open, Short, and Load items successively to 

complete the Port 2 calibration. 

7. Connect the THRU calibration kit between the two ports according to the interface prompts. The 

parameters of the THRU do not have to be known. Carry out unknown through Thru calibration. 

8. After the calibration, click Finish to exit the calibration interface, complete the calibration, and 
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save the calibration data. 

 

6.4.10 TRL Direct Reflection Transmission Line Calibration (Two Ports) 

The two-port TRL calibration method does not need to know the index parameters of the calibration 

kit, and all the error items in the error model of the test device can be figured out through three simple 

connection methods. TRL calibration scheme will use the THRU straight through calibration element, 

reflection calibration kit (Open or Short), and a small section of transmission line. 

Operating steps: 

1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and other 

parameters. 

3. Select Cal → Basic Cal to enter the Settings screen. 

4. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the Type of 

calibration kit Connector, Female or Male, in the DUT Connector, select TRL in the Cal Type, 

and click Next to proceed to the next step. 

5. According to the interface prompts, connect the THRU calibration kit, Reflect (Open or Short) 

calibration element, and Line on a Port 1 in turn, and click the corresponding Thru, Reflect, and 

Line items in turn to complete the Port 1 calibration. 

6. According to the interface prompts, connect the THRU calibration element, Reflect (Open or 

Short) calibration element, and transmission line on a Port 2 in turn, and click the corresponding 

Thru, Reflect, and Line items to complete the Port 2 calibration. 

7. After the calibration, click Finish to exit the calibration interface, complete the calibration, and 

save the calibration data. 

 

6.4.11 Partial Overwrite calibration 

When the ports are calibrated, some error items in the error model may be not acceptable. For 

unacceptable error items, the partial overwrite calibration chooses suitable calibration items to 

calibrate the ports again. Taking the two-port SOLT calibration as an example, the following 

describes the partial overwrite calibration for achieving full two-port open calibration after completing 

full two-port SOLT calibration. 
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Operating steps: 

1. Select Cal → Basic Cal to enter the Settings screen. 

2. Select both Port 1 and Port 2, select the desired calibration kit in the Cal Kit, select the 

type of calibration connector, Female or Male, in the DUT Connector, select SOLT in the 

Cal Type, and click Next to proceed to the next step. 

3. According to the interface prompts, connect the Open calibration element to Port 1, and 

click the corresponding Open item to complete the Port 1 open calibration.  

4. According to the interface prompts, connect the Open calibration element to Port 2, and 

click the corresponding Open item to complete the Port 2 open calibration. 

5. Click Overwrite to finish partial overwrite calibration. 

 

Notes 

1. Uncalibrated ports can’t be calibrated directly using partial overwrite calibration. 

2. Partial overwrite calibration requires that sweep points, IF bandwidth, and other parameters 

are the same as the values set by the previous calibration method. 

 

6.5 Internal source power calibration 

The vector network analyzer has been calibrated for the output power of the transmitter before it 

leaves the factory, but the factory calibration may not guarantee sufficient accuracy in all cases. To 

improve the accuracy, the user can conduct an internal source power calibration before performing 

any tests.  
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Figure 6-26 Transmitter power calibration 

 

Before attempting power calibration, power loss compensation at different frequency points can be 

set as shown in the figure below. Click “+” successively to add corresponding frequency and loss 

values. After setting, click OK to save the data. 

 

Figure 6-27 Set the interface 
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Power calibration operation steps: 

1. Connect the port-under-test to a compatible power meter (Keysight U2000 series, R&S NRP 

series, etc..) and probe to ensure normal communication between the vector network analyzer 

and the power meter. 

2. Preset vector network analyzer. 

3. Set internal source output power, IF bandwidth, sweep points, test frequency band and other 

parameters. 

4. Select Cal → Power Cal to enter the Settings screen. 

5. Select the test channel and select the power output port. 

6. Set parameters such as power offset, capacity limit, reading times, maximum iteration times, etc. 

7. Click Take Cal Sweep to start the power output measurement. 

8. Click OK to complete the calibration and exit the power calibration interface after the 

measurement is completed. 

 

6.6 Receiver calibration 

The vector network analyzer receiver power has been factory calibrated, but the factory calibration 

may not guarantee sufficient accuracy in every situation. The user can conduct a receiver power 

calibration before the test to improve the test accuracy. To ensure the calibration accuracy of the 

receiver, it is better to calibrate the power of the internal source before the calibration of the receiver. 
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Figure 6-28 Receiver calibration setting interface 

 

Operating steps: 

1. Preset vector network analyzer. 

2. Set internal source output power, IF bandwidth, sweep points, test frequency band, and other 

parameters. 

3. Select Cal → Receiver Cal to enter the Settings screen. 

4. Select the test channel, select the internal source output port, select the receiver port 

5. Connect the two ports using an appropriate specification RF cable. 

6. Set parameters such as power offset. 

7. Calibrate R or Calibrate T or Calibrate Both can be clicked to begin receiver calibration. 

8. Click OK to complete the calibration and exit the receiver calibration interface. 

 

6.7 Port extension 

Eliminating the errors of test fixturing can be a difficult task. The port extension function of a vector 

network analyzer is a good method to eliminate the error of test fixtures. The calibration of S 

parameters is usually carried out by the user at the plane where the RF cable is connected to the test 

fixture, typically a connector (SMA, N-type, etc..). The actual device to be tested is located in the test 

fixture. The device to be tested and the test fixture are generally connected by a microstrip line. As a 

result, the actual measurement plane of the device to be tested does not coincide with the calibration 

reference plane (the connector, as mentioned previously) which will introduce calibration errors.  

After the S parameter calibration is performed, the reference plane can be extended to the specified 

measurement plane by simply adding the added microstrip line length, speed factor, loss, and other 

parameters in the setting interface, to carry out more accurate testing. 
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Figure 6-29 Port extension setting interface 

 

Manual port extension operation steps: 

1. Perform the appropriate calibration type (SOLT, etc..) on the associated cabling before entering 

Port Extensions. 

2. Select Cal → Port Extension → Port Extension to enter the Settings screen. 

3. Select the port that needs to be extended, the unit of length, and input the velocity coefficient.  

The velocity coefficient is different, and the propagation time of electromagnetic waves on the 

transmission line is different. Input the length of the extended transmission line and the time will 

be calculated automatically.  

If the transmission line has loss, the loss of the transmission line can be added, including DC and 

AC loss.  

The AC loss can be selected as LOSS1 at the single-frequency point or LOSS1 and LOSS2 at 

the dual-frequency point. 

Among them, the fitting algorithm for two forms of AC loss are: 

1) Single-frequency point loss Loss1: 

Loss(f) = Loss1 * (f/Freq1) ^ 0.5 

2) Dual-frequency point loss Loss1,Loss2: 

Set the low frequency point to LOSS1 and the high frequency point to LOSS2,  

Loss(f) = Loss1 * (f/Freq1) ^ n, n = lg [abs(Loss1/Loss2)] / lg (Freq1/Freq2). 

4. Select whether to coupling to the system speed factor. If unchecked, the speed factor is set only 

for the specified port, and when checked, for all ports. 
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5. Check the Port Extensions ON button and the Port extension will take effect. 

 

Manual port extensions require the user to manually enter the parameters of the extended 

transmission line, while automatic port extension does not require prior knowledge of the transmission 

line parameters. The calibration plane can be automatically extended to the actual reference plane 

by simply performing an open or short circuit calibration on the actual reference plane of the DUT. 

The automatic port extension function is not available in the following cases: 

1. The sweep type is set to power sweep. 

2. The frequency offset is set to on. 

3. Waveguide transmission line port extension. 

 

Figure 6-30 Automatic port extension setting interface 

 

Automatic port extension operation steps: 

1. Perform the appropriate calibration type (SOLT, etc..) on the associated cabling before entering 

Port Extensions. 

2. Select Cal → Port Extension → Auto Port Extension to enter the Settings screen. 

3. Select the port you want to extend. Refer to practical application scenarios, select Port 1 or Port 

2, or both ports. 

4. Select the frequency span of the test.  

There are three frequency spans to choose:  

Current Span: The frequency span of the current interface setting. 
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Active Marker: The frequency point currently marked, In this case, Loss2 can be ignored when 

+setting loss, only Loss1 can be set. 

User Span: Use the start and end frequencies set by the user. 

5. Set whether the loss should be included or not. Select this box to automatically measure the loss 

in the transmission line and apply it to the calibration. 

6. The mismatch adjustment option is only available when the inclusion loss item is selected. The 

mismatch increases the ripple on the trace lines of S11 and S22. If the ripple is large, the trace 

display of S11 and S22 will be greater than 0dB, resulting in unstable values when S parameters 

are used. Selecting the adjustment mismatch item can increase the loss of the fixture so that the 

peak value of the ripple is below 0dB. Although this will increase the error, it can prevent the 

numerical instability of S parameters from appearing when it is used. 

7. Click Next to enter the measurement interface. Before the measurement, make sure that the 

device has been removed from the test fixture. In this way, the open-circuit measurement can be 

performed. Of course, the test fixture can also refer to the plane Short circuit to conduct the Short 

measurement. It can carry out one of the Open or Short measurements or simultaneously carry 

out the Open and Short measurements. When two measurements are used, the result will be the 

average of the two measurements, and the accuracy will be improved 

 

Figure 6-31 Automatic port extension calibration interface 

 

6.8 Fixture measurement function 

In addition to the port extension function, the vector network analyzer also provides several other 

functions for test fixtures: 

1. Port match (2-port embedding) 

2. Port impedance conversion 

3. 2-port de-embedding 

4. N port embed/ de-embed (port 4/6/8) 

5. Differential port match 
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6. Differential port impedance conversion 

7. Common port impedance conversion 

 

Port match operation steps: 

1. Ensure that the user has completed the S parameter. 

2. Select Cal → Fixtures → Fixture Setup → Port Match to enter the Settings screen. 

3. By selecting the port and the parameter representation form of the matching module, the S2P file 

(AKA Touchstone file) of the matching module can be directly exported or the circuit model of the 

matching module can be used. It supports 9 topologies which are combined by L, R, G, and C. It 

is necessary to manually set the parameter values of L, R, G, and C components. Checking the 

Enable Port Matching On All Ports tab means that all ports are matched. When the frequency 

range in the S2P file of the imported matching module is less than the frequency range set by 

the current interface, the system will extrapolate the S2P file by default. In other words, all the 

uncovered low-frequency parameters are replaced by the first point in the S2P file and all the 

uncovered high-frequency parameters are replaced by the last point in S2P file making the 

frequency range of the S2P file the same as the frequency range of the current interface. 

4. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 
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Figure 6-32 Port match 

 

Port impedance conversion operation steps: 

1. Ensure that the user has completed the S parameter. 

2. Select Cal → Fixtures → Fixture Setup → Port Z to enter the Settings screen. 

3. Choose the port, the default system port characteristic impedance is 50 Ω, you can fill in the 

required resistance values in the R and JX columns, Then the S parameter displayed will be 

automatically converted to the S parameter corresponding to the new characteristic impedance. 

Checking the Enable Port Z Conversion On All Ports tab means port matching is performed 

on all ports. 

4. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 
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Figure 6-33 port impedance conversion 

 

2-port de-embed operation steps: 

1. Ensure that the user has completed the S parameter calibration. 

2. Select Cal → Fixtures → Fixture Setup → 2-Port DeEmbed to enter the Settings screen. 

3. Select the port and select the form of de-embedding to import an S2P File. Click User S2P File 

to import the S parameter of the fixture part that needs to be removed.  

Checking the Enable De-Embedding On All Ports tab means that all ports are de-embeddable.  

When the frequency range in the S2P file of the imported matching module is smaller than the 

frequency range set by the current interface, the system will extrapolate the S2P file by default. 

All the low-frequency parameters not covered are replaced by the first point in the S2P file, and 

all the high-frequency parameters not covered are replaced by the last point in the S2P file, 

making the frequency range of the S2P file the same as that of the current interface.  

4. Checking the Reverse Adapter Ports entry represents the part of the reverse connection that 

will need to be de-embedding. By default, the system reverses the imported S2P file. 

5. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 
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Figure 6-34 de-embedding interface 

 

N-port embedding / de-embedding operation steps: 

1. Ensure that the user has completed the S parameter calibration. 

2. Select Cal → Fixtures → Fixture Setup → N-Port DeEmbed to enter the Settings screen. 

3. Select the topology type.  

There is only 1 topology types:  

A (using network 1) 

Select the port of the vector network analyzer in the VNA item, select the Network port 

configuration that needs to be embedded or de-embedded in the Network, and select the Embed 

operation or De-embed operation under each Network. Finally, load the S2P file corresponding 

to the operating network. Checking the Enable 4/ 6/ 8-Port Embed / De-embed On All Ports 

tab means that all ports are matched.  

 

When the frequency range in the S2P file of the imported matching module is less than the 

frequency range set by the current interface, the system will extrapolate the S2P file by default.  

In other words, all the uncovered low-frequency parameters are replaced by the first point in the 

S2P file, and all the uncovered high-frequency parameters are replaced by the last point in the 

S2P file, making the frequency range of the S2P file the same as the frequency range of the 
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current interface.  

4. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 

 

Figure 6-35 De-embedding interface 

 

Differential port match operation steps: 

1. Ensure that the user has completed the S parameter calibration. 

2. Select Cal → Fixtures → Fixture Setup → Differential Port Match to enter the Settings screen. 

3. By selecting the port and the parameter representation form of the matching module, the S2P file 

of the matching module can be directly imported or the circuit model of the matching module can 

be used.  

It is necessary to manually set the parameter values of L, R, G, and C components if the circuit 

model is used.  

Checking the Enable Differential Port Matching tab means that all ports are matched.  

When the frequency range in the S2P file of the imported matching module is less than the 

frequency range set by the current interface, the system will extrapolate the S2P file by default. 

In other words, all the uncovered low-frequency parameters are replaced by the first point in the 

S2P file and all the uncovered high-frequency parameters are replaced by the last point in the 

S2P file making the frequency range of the S2P file the same as the frequency range of the 

current interface. 

4. Click Close to complete the setting and click Apply Fixtures to ON to take effect. 
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Figure 6-36 Differential port match 

 

Differential and common port impedance conversion operation steps: 

The operation of differential port impedance conversion and common port impedance conversion is 

similar to that of port impedance conversion, please refer to the instructions of the latter. 

 

6.9 Adapter removal / insertion function 

Adapters are often used when the network analyzer is used to test the DUT. The vector network 

analyzer provides the function of removing and inserting adapters. Before the function of removing 

and inserting adapters is enabled, the vector network analyzer needs to carry out full 2-port calibration. 
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Figure 6-37 Adapter removal and insertion functions 

 

Adapter removal operation steps: 

1. Connect the test cable of the vector network analyzer to the adapter, and configure the 

parameters of the network analyzer. First, perform the full 2-port calibration. 

2. Select Cal → Adapter Removal to go to the Settings screen and select Remove in the Adapter 

tab. 

3. Remove the adaptor from the test cable, Select Cal → Adapter Removal → Calibration to enter 

the Adapter Removal configuration screen. Select the port connected to the adaptor to be 

removed, select the calibration kit type, and select the polarity of the calibration kit. Click Next to 

connect the Open, Short and Load calibration elements in turn for full 1 port calibration. 

4. Click Finish to complete the calibration and click Adapter Removal to ON to complete the Adapter 

Removal operation. 



SHN900A User Manual 

www.siglent.com                                                                                119 

 

Figure 6-38 Adapter removal and insertion function calibration interface 

 

Adapter insertion operation Steps: 

1. Remove any test cables from the ports of the analyzer and perform a full 2-port calibration. 

2. Select Cal → Adapter Removal to go to the Settings screen and select Insert in the Adapter 

tab. 

3. Connect the adapter on the test cable, select Cal → Adapter Removal → Calibration to enter 

the Adapter Removal configuration screen. Select the port connected with the adaptor to be 

inserted, select the calibration kit model, select the polarity of the calibration kit, and click Next 

to connect the Open, Short, and Load calibration elements in turn for full 1 port calibration. 

4. Click Finish to complete the calibration and click Adapter Removal to ON to complete the 

Adapter insertion operation. 

“Adapter Rotate” is also known as the “equal exchange adapter and equal length adapter” 

calibration method. Before the unknown pass-through method was introduced, the switching 

adapter method was often used as a faster alternative to the more tedious adapter removal 

method. 

 

6.10 Ecal 

6.10.1 ECal Overview 

ECal is a new automatic calibration technology for vector network analyzers. Every ECal module 

contains electronic standards that are automatically switched into position during a measurement 

calibration. These electronic standards have been measured at the factory and the data stored within 

the memory of the ECal module. The analyzer uses this stored data, along with the measured data, 

to calculate the error terms for a measurement calibration. ECal offers the following advantages: 

● The calibration process is simple. The electronic calibrator only needs to be connected to the 

VNA once to complete the test items required by the dual-port calibration, without the need for 
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multiple calibration connections. 

● A shorter time is required for calibration. 

● There are fewer uncertain factors in the calibration process, and the probability of electronic 

calibration being affected by misoperation is reduced because there is no need for multiple 

connection processes. 

 
Use ECal to perform calibration 

1. Connect the USB port on the ECal module with the USB port on the front panel of VNA via a USB 

cable. the module indicates “READY”. When you connect the module, the type of module, 

frequency range, and connector type are automatically recognized. 

2. Connect a port on the ECal module to the test port to be calibrated. 

3. Press Cal > ECal on the front panel to enter the ECal menu interface. 

 

Figure 6-39 ECal menu 

A. ECal Config. Select the number of ports to 

calibrate. Then select the port number 

configuration. 

B. Confidence Check. Check the validity of Ecal 

calibration.  

C. Orientation. Select “Auto” (the default setting) the 

VNA automatically senses the model and direction 

in which an ECal module port is connected to the 

VNA ports. Select “Manual” to manually set the 

specified port. 

D. Characterization. View the characterization 

information stored in the ECal module 

 

6.10.2 ECal Config 

Press “Cal” on the front panel , Press Cal > ECal > ECal to enter the menu interface of ECal setting. 
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Figure 6-40 ECal config menu 

 

A. Select the number of ports to calibrate and configure the port number. Using ECal, you can 

perform 1-Port Reflection calibration, Full 2-Port calibration, Full 3-Port calibration, and Full 4-

Port calibration. 

B. Select the Cal Type 

C. When “Orientation” is Auto, click “Next” to enter the automatic alignment directly. When 

“Orientation” is Manual, click “Next” to specify the calibration port and go to auto-calibration. 

 

6.10.3 Confidence Check 

1. Press “Cal” on the front panel, press Cal > ECal > Confidence Check to enter the menu interface 

of Confidence Check. 
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Figure 6-41 Confidence Check 

 

2. Compare the data-trace with the memory trace and verify that the measurement is correct. 

3. The steps to compare when both data and memory traces are displayed are as below: 

● Press “Math” on the front panel, Press “Math” > Memory > Math > Data + Memory. 

● Press “Scale” on the front panel, Press “Scale” > Scale > Auto Scale. 

● Determine if the differences between trace lines are acceptable. 

 

6.10.4 Orientation 

The ECal module automatically detects the connection between SNA's test ports and ECal module's 

ports. You can turn off this function to set ports manually. 

 

Manual port setting procedure for Full 2-Port calibration 

1. Press “Cal” on the front panel, Press “Cal” > ECal > Orientation > Manual. 

2. Specify a test port of the VNA. 

3. Specify an ECal port for the port of the VNA you specified. 
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Figure 6-42 Manual port setting 

 

6.10.5 Characterization 

Press “Cal” on the front panel, press “Cal” > Cal > Characterization > Factory to view all the 

parameters of the stored Characterization in the ECal module. 
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Figure 6-43 The factory information of Cal Kit 

A. The date when the characteristics were measured 

B. The stimulus conditions when the characteristics were measured 

C. The information of the Connector type 
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7 Data Analysis 

7.1 Marker 

The marker can display defined measurement data of traces. Each trace can set nine ordinary 

markers and one reference marker. 

 

7.1.1 Ordinary marker: 

Press the Marker button on the front panel, click Add Marker in the Marker submenu to create a 

marker, then set the required test frequency. if there are many markers on the trace, click Select to 

select the desired marker. After the marker is created, the measurement value of the marker will be 

displayed at the top right of the window, and the value format is the same as the format of the trace. 

We can click the Delete Marker command under the marker submenu to delete the marker and select 

the marker to delete from the pop-up menu. When a trace is deleted, all markers on the trace will be 

deleted. Click the All Off command under the Marker submenu or the Marker Setup submenu to 

delete all markers on the current trace. 

 

7.1.2 Reference marker: 

Press the Marker button on the front panel, click Reference Marker in the Marker submenu, make 

the On option selected then the Reference Marker will be created. By default, the Reference Marker 

is created at the location of the current ordinary Marker. If there is no ordinary Marker on the current 

trace, the Reference Marker will be created at the center of the trace. Reference Markers are denoted 

by an R. After creating a Reference Marker, set the Reference Marker as value discretization, fixed 

marker, and coupling, we can set the data format of Reference Marker’s display value and view the 

Reference Marker’s value in the marker table, but the Reference Marker cannot be set as a difference 

(delta) marker. Click Reference Marker in the Marker submenu, select the Off option to delete the 

Reference Marker. 

 

7.1.3 Marker setting: 

Press the Marker button on the front panel, set the current marker in the Marker Setup submenu, we 

can make the following settings for the currently selected marker: 

1. Difference (delta) display: The difference display mode is closed by default, to open the 
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difference display mode, click the Delta to select the On option, then the marker’s value will 

display the difference between the ordinary marker and the reference marker, and the marker’s 

value is marked with "Δ". If a reference marker has not been added to the trace, the reference 

marker will be automatically set on the trace. To display the absolute value of the marker, click 

the Delta again to select the Off option. 

2. Value discretization: The value discretization mode is closed by default. Due to the limited 

number of sampling points set on the trace, the data of other points except the sampling points 

are based on the interpolation value of the sampling point data, which is approximate to the actual 

data, not the real measured data. By setting the value discretization of the marker, the value of 

the marker can only be taken at the sampling point, which ensures that the marker’s value is from 

the measurement data and not interpolated data. To open the value discretization mode, click the 

Discrete to select the On option, at this time, the data of the marker is only selected from the 

sampling points, when the coordinate value of the marker is not in the sampling point, the marker 

is automatically moved to the nearest sampling point. To turn off the value discretization, click the 

Discrete to select the Off option. 

3. Fixed marker: The fixed marker mode is closed by default. Fixed markers have a fixed excitation 

position (x-axis coordinate), its response value (Y-axis coordinate) will change according to the 

trace data update. To keep the fixed value of the marker unchanged, click the Type command to 

select the Fixed option, then the marker’s value will keep the current value unchanged, and the 

marker does not move up or down with the trace update. To restore the marker real-time update, 

click the Type command again to select the Normal option. 

4. Data format: The newly created marker uses the current trace’s data format by default. To 

change the data format of the marker, click the Format and select the corresponding data format 

in the pop-up menu. The following data formats are available:  

● Trace Default  

● Log/Phase  

● Lin/Phase  

● Re/Im  

● R+jx  

● G+jB  

● Log Magnitude  

● Lin Magnitude  

● Phase  

● SWR  

● Delay  

● Real  

● Imaginary  
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Figure 7-1 Data format interface 

 

5. Marker coupling: The newly created marker turns off coupling by default. At this time, the marker 

is only set on a single trace, and the markers on different traces do not affect each other. If we 

need multiple markers on different traces to share settings, we can use the marker coupling 

function. Click the Coupled command, and select the range of the marker coupling in the pop-

up menu for coupling operation. When the marker coupling mode is on, the markers of the same 

number and X-axis (such as frequency or time) on all traces in the coupling range share the 

settings, and the marker’s setting on the current trace will be used by default. If the current marker 

is not in the coupling range, the marker with the same number on the trace with the smallest trace 

number is used.  

Note: when the marker coupling mode is on, the marker on the trace within the coupling range 

will automatically move to the same X-axis coordinate.  

6. Marker table: The newly created marker closes the marker table by default. If we need to display 

all marker data in the form of a table, we can use the marker table function. Click the Marker 

Table to select the On state, a table will appear at the bottom left to display all marker’s values, 

click the Marker Table again to select the Off option to close the marker table.  
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7.1.4 Marker Display: 

Press the Marker button on the front panel, set the display effect for the current cursor in the Marker 

Display submenu: 

● Show Readout: The system is turned on by default. If this switch is turned off, the cursor reading 

will be hidden. 

● Active Trc Only: The system is turned off by default. If this switch is turned on, only the cursor 

reading of the current working trace will be displayed. 

● Align: The system is turned on by default. If this switch is turned off, the cursor of different traces 

will not be aligned and displayed. 

● X Pos: Set the display position of the cursor reading on the X-axis. 

● Y Pos: Set the display position of the cursor reading on the Y-axis. 

● Decimal Places: By default, the Auto Decimal Places check box is checked. When unchecked, 

the decimal places for the stimulus value and response value of the cursor reading can be set. 

 

7.1.5 Marker function: 

Press the Marker button on the front panel, use the current marker to set the excitation in the Marker 

Function submenu. Use the currently selected marker to achieve the following functions:  

● Marker → Start: Set the current marker position (X coordinate) as the sweeping starting point. 

● Marker → Stop: Set the current marker position (X coordinate) as the sweeping ending point. 

● Marker → Center: Set the current marker position (X coordinate) as the sweeping center point. 

Note: When using this command, the sweeping boundary value far from the current marker will 

be changed to reduce the sweeping range, so that the marker position becomes the new 

sweeping center point.  

● Marker → Span: This function is only available when the current marker is a difference (delta) 

marker. Set the sweeping range between the current marker position and the reference marker 

position (x coordinate). 

● Marker → Ref Level: Set the response value (Y coordinate) of the current marker to the 

reference level of the current trace. 

● Marker → Delay: Referring to the phase slope of the current marker position, the line length is 

adjusted to the receiver input, this function helps to smooth the phase trace around the current 

marker. For the equipment without constant group delay in the measurement frequency span, 
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another electrical delay adjustment is needed. This function can be used to measure electrical 

length or deviation from a linear phase. This function requires the measured phase difference, 

so it is only suitable for proportional measurements. 

● Marker → CW Freq: Set the current marker position (frequency) to continuous wave (CW) 

frequency. This function requires the x-axis field of the current marker, otherwise, it is invalid. 

After changing CW frequency with this command, enable power or CW sweeping to apply the 

changed CW frequency setting. 

● Marker → SA: If the current mode is SA, the center frequency is set to the current marker value; 

If it is not SA mode, then switch to SA mode, set the center frequency to the current marker value, 

and set span to 10 times of the previous step freq. 

 

7.1.6 Marker search function: 

The marker can be used to search the maximum value, minimum value, peak value, and target value 

of the trace in the specified search domain. It can also search for multi-peak value, multi-target, 

bandwidth filtering, and band-stop filtering. 

 

7.1.6.1 Search domain: 

The search domain is the frequency span included in a marker search operation. Each marker has 

an independent search domain, and the default is full span, which is the same as the current sweep 

range. The X coordinate movement range of the marker is limited in its search domain. The user can 

set up to 16 custom search domains. The search domains are independent of each other and allowed 

to overlap. The search field can be set for each marker, and multiple markers are allowed to share 

one search domain.  

To set a custom search domain, press the Search button on the front panel, click the Domain 

command in the Search submenu, and click the Add command in the pop-up menu. Then click the 

Domain command again, click and select the newly created custom search domain in the pop-up 

menu, and enter the required values in the Start and Stop text boxes below the domain command. 

When the search domain of the current marker is not full span, the indicator "Δ" will appear on the x-

axis to identify the search domain of the current marker. To delete a user-defined search domain, click 

the Domain command, select the search domain to be deleted in the pop-up menu, then click the 

Domain command again, and then click Delete in the pop-up menu. If the search domain of the 

marker is deleted, its search domain is automatically set to full span. 
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7.1.6.2 Max and min search: 

Press the Search button on the front panel and click the Max Search command in the Search 

submenu to move the current marker to the maximum response value in the search domain. Press 

the Search button on the front panel and click the Max Search command in the Search submenu to 

move the current marker to the maximum response value in the search domain. Click the Min Search 

command to move the current marker to the minimum response value in the search domain. 

 

7.1.6.3 Peak search: 

Press the Search button on the front panel to search the peak in the Peak submenu. Before searching 

for the peak value, the effective peak value to be searched should be defined first. The validity of the 

peak value is determined by the search domain, peak polarity, threshold, and deviation: 

Peak polarity: According to the polarity, the peaks are divided into two categories:  

Positive and negative. The positive peak value refers to situations where the measured value is 

greater than the measured value at both ends of a span, and the negative peak value refers to the 

peak value that the measured value is less than the measured value at both ends of a span. Click the 

Peak Polarity command in the Peak submenu to select the peak polarity. The Both option means 

that both positive and negative peaks are regarded as valid peaks for the search.  

Threshold: For the positive peak, only the peak whose measured value is greater than the threshold 

is considered valid; for the negative peak, only the peak whose measured value is less than the 

threshold is considered valid; when the polarity of the peak is set to Both, the threshold is not used 

as the basis for judging the validity of the peak. To set the threshold, click the Threshold command 

in the Peak submenu to enter the required value.  

Deviation: The deviation value of peak value refers to the smaller difference between the measured 

value of peak value and the measured value of an adjacent peak with the opposite polarity. Only the 

peak value with a deviation greater than the rated value is considered valid. To set the deviation value, 

click the Excursion command in the Peak submenu to enter the required value.  

 

After determining the effective peak range and search domain, the peak search can be started. There 

are several peak searching modes available: 

Using the Peak Search command in the Peak submenu, the peak with the largest measured value 

among the effective positive peaks or the peak with the smallest measured value among the effective 

negative peaks will be included in the search according to the peak polarity setting. If the current peak 

polarity is set to Both, the peak with the largest measured value among the effective positive peaks 

is searched. 
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Use the Peak Right → Search command in the Peak submenu to search the nearest effective peak 

from the current marker position to the right.  

Use the Peak Left ← Search command in the Peak submenu to search the nearest effective peak 

from the current marker position to the left.  

Use the Next Peak Search command in the Peak submenu to search for the effective positive peak 

value next lower than the current marker measurement value or the effective negative peak value 

next higher than the current marker measurement value according to the peak polarity setting. If the 

current peak polarity is set to Both, the effective peak next lower than the current vernier 

measurement value is searched.  

 

7.1.6.4 Target search: 

Press the Search button on the front panel to search the target in the Target submenu. Before 

searching the target, set the target value and transition type: 

Target value: The target value refers to the response value to search (Y coordinate). If the response 

value of a point on the trace is equal to the target value, then the point is the target point to search. 

To set the target value, click the Target Value command in the Target submenu to enter the required 

value.  

Transition type: The target points are divided into two types, positive and negative. The positive 

target conversion type means that the measured value on the right side of the target point is greater 

than that on the left side, while the negative target conversion type means that the measured value 

on the right side of the target point is less than that on the left side. Click the Transition command in 

the Target submenu to select the conversion type to search for. The Both option means that both 

positive and negative target conversion types are regarded as valid targets.  

 

After the target value, transition type and search domain are determined, the target search can be 

started. The vector network analyzer has the following target search modes: 

Use the Target Search command in the Target submenu to search for the nearest effective target 

from the current marker position to the right. When no effective target can be found from the right, 

search from the starting point of the search domain to the right.  

Use the Target Right → Search command in the target submenu to search the nearest valid target 

from the current marker position to the right.  

Use the Target Left ← Search command in the Target submenu to search the nearest valid target 

from the current marker position to the left.  
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7.1.6.5 Multi-peak search: 

Press the Search button on the front panel to search for multiple peaks in the Multi Peak & Target 

submenu. Before searching for multiple peaks, you need to set the threshold, deviation, and peak 

polarity in the Peak Threshold, Peak Excursion and Peak Polarity commands in the submenu to 

define the peak validity. After setting the above parameters, click the Multi Peak Search command 

to search all effective peaks from the starting point of the search domain to the right, and mark the 

peaks with a marker. Since there can only be 9 common markers on a single trace, only the first 9 

effective peaks can be found when there are many effective peaks.  

 

7.1.6.6 Multi-target search: 

Press the Search button on the front panel to search for multiple targets in the Multi Peak & Target 

submenu. Before multi-target search, you need to set the target value and conversion type in the 

Target Value and Transition submenu to define the target validity. After setting the above parameters, 

click the Multi-Target Search command to search all valid targets from the starting point of the search 

domain to the right, and mark the searched targets with a marker. Since there can only be 9 common 

markers on a single trace, only the first 9 valid targets can be found when there are many valid targets.  

 

7.1.6.7 Tracking search: 

When using the above search function, the marker position is only based on the current sweeping 

result, and will not be dynamically updated with the trace update after the search. Tracking mode can 

be used to update search results with trace data. Press the Search button on the front panel, click 

the Tracking command, and select the search type in the pop-up menu; the search in the tracking 

mode uses the search parameter settings in the above search.  

 

7.1.6.8 Bandwidth search 

The bandwidth search is a function for determining the bandwidth of the trace, center frequency, cut-

off points (on the higher frequency and the lower frequency sides), Q and insertion loss based on the 

position of the active marker or peak marker. 

Press the Search button on the front panel to search the bandwidth in the Bandwidth submenu. Click 

BW Search Enable and select the On option to search the bandwidth. After the bandwidth search is 

completed, a small triangle will be used to mark the cut-off frequency of the trace, and the bandwidth, 

center frequency, cut-off frequency, quality factor, and insertion loss will be displayed in the upper 

right corner of the window. To turn off the bandwidth search, click BW Search Enable again and 

select the Off option. You can set whether to alarm when the bandwidth search fails in the Sound On 
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Fail command.  

 

Figure 7-2 Bandwidth search example 

 

7.1.6.9 Notch search 

The notch search function is used to obtain the bandwidth, center frequency, cutoff points (high-

frequency side and low-frequency side), Q and insertion loss of a trace based on the active marker 

or peak marker position. The notch search function starts from the left side of the active marker 

position and ends when points that meet the conditions are found. 

Press the Search button on the front panel to search the band stop in the Notch submenu. Click the 

Notch Search Enable command and select the On option to perform the band stop search. After the 

band stop search is completed, a small triangle will be used to mark the cut-off frequency of the trace, 

and the bandwidth, center frequency, cut-off frequency, quality factor, and insertion loss will be 

displayed in the upper right corner of the window. To turn off the band stop search, click the Notch 

Search Enable command again and select the Off option. You can set whether to alarm when the 

band stop search fails in the Sound On Fail command.  

The following values are displayed for Bandwidth and Notch Search: 

● Bandwidth (BW): The difference in frequency between the higher frequency cut-off and 

lower frequency cut-off points (High - Low). 

● Center frequency (Center): Frequency at the middle point between the lower frequency 

cut-off and higher frequency cut-off points. (High + Low)/2. 

● Lower frequency cut-off point (Low): Lower frequency of 2 measurement points, both 
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separated by the defined bandwidth / notch value from the active marker position. 

● Higher frequency cut-off point (High): Higher frequency of 2 measurement points, both 

separated by the defined bandwidth / notch value from the active marker position. 

● Q: Ratio of Center Frequency to Bandwidth (Center Frequency / Bandwidth). 

● Insertion loss (loss): The measured value of the position of the center frequency at the 

time the bandwidth/notch search is executed. 

 

7.2 Mathematical operation / Memory Operations 

The vector network analyzer supports saving the current data-trace in memory. It can perform four 

kinds of mathematical operations on the current data-trace and memory trace. In addition, it can 

calculate and display statistical data (mean, standard deviation, and peak-peak) on the data-trace. In 

addition, through the built-in formula editor, you can use multiple types of traces from the same or 

different channels to build custom formulas. When the mathematical operation with memory trace 

needs to be carried out, the current data needs to be stored in memory first. Click Data → Memory 

to complete the storage operation. In the Display menu bar, you can select three display modes: 

Display data-trace only, display memory trace and display data-trace and memory trace at the same 

time. The four mathematical operations of data-trace and memory trace are as follows, in which the 

values on data-trace and memory trace are linear: 

● Data/Memory: Divide the measured data by the data in the stored trace. This function can be 

used to calculate the ratio of two traces (such as calculating gain or attenuation), which can also 

be regarded as the normalization operation of test data. 

● Data*Memory: The current measurement data is multiplied by the data in memory.  

● Data+Memory: Current measurement data plus data in memory.  

● Data–Memory: Current measurement data minus data in memory. For example, you can use 

this function to store measured data, The error is then subtracted from the DUT measurement. 

 

7.3 Conversion 

The vector network analyzer supports parameter conversion, which can convert the S parameter of 

the current trace to the required parameter mode. The vector network analyzer supports the following 

8 conversion types. 
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● Z-Reflect: Impedance in reflection measurement Zr. 

Z𝑟 = 𝑍𝑜𝑎 × 
1 + 𝑆𝑎𝑎

1 − 𝑆𝑎𝑎
 

● Z-Transmit: Impedance in transmission measurement Zt. 

𝑍𝑡 =  
2 × √𝑍0𝑎 × 𝑍0𝑏

𝑆𝑎𝑏
− (𝑍0𝑎 + 𝑍0𝑏) 

● Z-Trans-Shunt: Impedance in parallel transmission Zt. 

𝑍𝑡 =
1

𝑌𝑡
 

● Y-Reflect: Reflection measurement admittance Yr. 

𝑌𝑟 =
1

𝑍𝑟
 

● Y -Transmit: Admittance in transmission measurement Yt. 

𝑌𝑡 =
1

𝑍𝑡
 

● Y -Trans-Shunt: Admittance in parallel transmission Yt. 

𝑌01 =
1

𝑍01
 

𝑌02 =
1

𝑍02
 

𝑌𝑡 =  
2 × √𝑌01 × 𝑌02

𝑆𝑎𝑏
− (𝑌01 + 𝑌02) 

● 1/S: Reciprocal of S parameter. 

● Conjugation: Convert the measured value to a complex conjugate number. 
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Figure 7-3 Parameter conversion type 

 

When both the fixture simulation measurement function and the port impedance function are in the 

“on” state, the system will use the value set in the port impedance conversion. In other cases, the 

system Z0 (preset value: 50 Ω) will be used. The operation steps for selecting the conversion type are 

as follows:  

1. Click Math → Analysis → Conversion enter the selection interface. 

2. Select the corresponding conversion type, effective immediately. 

 

7.4 Equation editor 

In the equation editor, we can input the algebraic formulas of standard mathematical operators and 

functions, and reference the data available in the vector network analyzer. After a valid formula is 

entered and enabled, the working trace will be displayed as the result of the set formula and updated 

in real-time. 

For example, enter the formula 𝑆21/(1 − 𝑆11). The trace is calculated by dividing each S21 data point 

by 1 and subtracting the value of the corresponding S11 data point. For a 201 point sweep, the 

calculation is repeated 201 times, once per point.  

The operation steps of the equation editor are as follows:  

Click Math → Analysis → Equation Editor enter the equation editor interface. 
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Figure 7-4 Formula editor interface 

 

In the formula edit box, enter functions, operators, and data to form the formula.  

After setting the formula, click OK to exit the formula editing interface and click the Equation status 

to On to take effect.  

 

Introduction to formula editor interface: 

● Enable: Select the box to enable the currently entered formula, and clear the box to disable the 

currently edited formula. If the data traces used are from other channels instead of formula traces, 

these channels must have the same number of data points to be valid channels. 

● Functions and Constants: It stores some commonly used functions and constants, as well as 

other functions set by the system. 

● Parameter: Select the items that need to be measured only from the working channel. 

● History Equation: Used to save previously-stored formulas. 

● Store Equation: Store the current input formula to facilitate subsequent use. 

● : Move the cursor to the left without clearing the characters.  

● →: Move the cursor to the right without clearing the character.  

● Backspace: Clear the character while moving the marker to the left. 

● Clear: Clear the currently entered formula. 

● Numbers, operators, and constants: Numbers, common operators, and constants. 
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Description of functions and constants in formula editor: 

Common functions Description 

Abs (complex a) Returns the sqrt(a.re*a.re+a.im*a.im) 

Acos (scalar a) Returns the arc cosine of a in radians 

Asin (scalar a) Returns the arc sine of a in radians 

Atan (scalar a) Returns the arc tangent of a in radians 

atan2 (complex a) Returns the phase of a = (re, im) in radians 

atan2 (scalar a, scalar b) Returns the phase of (a, b) in radians 

Conj (complex a) Returns the conjugate of a 

Cos (complex a) Takes a in radians and returns the cosine 

Cpx (scalar a, scalar b) Returns a complex value (a+ib) from two scalar 

values 

Exp (complex a) Returns the exponential of a 

Im (complex a) Returns the imaginary part of a as the scalar part 

of the result (zeroes the imaginary part) 

Ln (complex a) Returns the natural logarithm of a 

log10 (complex a) Returns the base 10 logarithm of a 

Mag (complex a) Returns sqrt(a.re*a.re+a.im*a.im) 

Phase (complex a) Returns atan2(a) in degrees 

Pow (complex a,complex b) Returns a to the power b 

Re (complex a) Returns the scalar part of a (zeroes the 

imaginary part) 

Sin (complex a) Takes a in radians and returns the sine 

Sqrt (complex a) Returns the square root of a, with phase angle in 

the half-open interval (-pi/2, pi/2] 

Tan (complex a) Takes a in radians and returns the tangent 

 

Constant 

e 2.71828182845904523536 

PI 3.14159265358979323846 

 

Advanced function Description 

A (complex a, complex b, complex c, complex F11 conversion = ((1+a)*(1-d) + b*c)/(2*b) 
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d) 

A (scalar i, scalar j) returns A(Sii, Sji, Sij, Sjj) 

B (complex a, complex b, complex c, 

complex d) 

F12 conversion = Z0*((1+a)*(1+d) - b*c)/(2*b) 

B (scalar i, scalar j) returns B(Sii, Sji, Sij, Sjj) 

C (complex a, complex b, complex c, 

complex d) 

F21 conversion = (1/Z0)*((1-a)*(1-d)-b*c)/(2*b) 

C (scalar i, scalar j) returns C(Sii, Sji, Sij, Sjj) 

D (complex a, complex b, complex c, 

complex d) 

F22 conversion = ((1-a)*(1+d) + b*c)/(2*b) 

D (scalar i, scalar j) returns D(Sii, Sji, Sij, Sjj) 

H11 (complex a, complex b, complex c, 

complex d) 

H11 conversion = Z0*((1+a)*(1+d) - b*c)/((1-

a)*(1+d) + b*c) 

H11 (scalar i, scalar j) returns H11(Sii, Sji, Sij, Sjj) 

H12 (complex a, complex b, complex c, 

complex d) 

H12 conversion = 2*c/((1-a)*(1+d) + b*c) 

H12 (scalar i, scalar j) returns H12(Sii, Sji, Sij, Sjj) 

H21 (complex a, complex b, complex c, 

complex d) 

H21 conversion = -2*b/((1-a)*(1+d) + b*c) 

H21 (scalar i, scalar j) returns H21(Sii, Sji, Sij, Sjj) 

H22 (complex a, complex b, complex c, 

complex d) 

H22 conversion = (1/Z0)*((1-a)*(1-d) - b*c)/((1-

a)*(1+d) + b*c) 

H22 (scalar i, scalar j) returns H22(Sii, Sji, Sij, Sjj) 

Kfac (complex a, complex b, complex c, 

complex d) 

k-factor = (1 - abs(a)^2 - abs(d)^2 + (abs(a*d - 

b*c)^2)/(2*abs(b*c)) 

Kfac (scalar i, scalar j) returns kfac(Sii, Sji, Sij, Sjj) 

MAPG (complex a, complex b, complex c, 

complex d) 

maximum available power gain = abs (b/c)*(kfac 

(a,b,c,d) - sqrt (kfac (a,b,c,d)^2 - 1)) 

MAPG (scalar i, scalar j) Returns MAPG(Sii, Sji, Sij, Sjj) 

MSG (complex a, complex b, complex c, 

complex d) 

maximum stable power gain = abs(b)/abs(c) 

MSG (scalar i, scalar j) Returns MSG(Sii, Sji, Sij, Sjj) 

mu1 (complex a, complex b, complex c, 

complex d) 

μ-factor = (1 - abs(a)^2) / (abs(d - conj(a) * (a*d-

b*c)) + abs(b*c)) 

mu1 (scalar i, scalar j) Returns mu1(Sii, Sji, Sij, Sjj) 



SHN900A User Manual 

140                                                                               www.siglent.com 

mu2 (complex a, complex b, complex c, 

complex d) 

μ-factor = (1 - abs(d)^2) / (abs(a - conj(d) * (a*d-

b*c)) + abs(b*c)) 

mu2 (scalar i, scalar j) Returns mu2(Sii, Sji, Sij, Sjj) 

T11 (complex a, complex b, complex c, 

complex d) 

T11 conversion = -(a*d - b*c)/b 

T11 (scalar i, scalar j) Returns T11(Sii, Sji, Sij, Sjj) 

T12 (complex a, complex b, complex c, 

complex d) 

T12 conversion = a/b 

T12 (scalar i, scalar j) Returns T12(Sii, Sji, Sij, Sjj) 

T21 (complex a, complex b, complex c, 

complex d) 

T21 conversion = -d/b 

T21 (scalar i, scalar j) Returns T21(Sii, Sji, Sij, Sjj) 

T22 (complex a, complex b, complex c, 

complex d) 

T22 conversion = 1/b 

T22 (scalar i, scalar j) Returns T22(Sii, Sji, Sij, Sjj) 

Y11 (complex a, complex b, complex c, 

complex d) 

Y11 conversion = (1/Z0)*((1-a)*(1+d) + 

b*c)/((1+a)*(1+d) - b*c) 

Y11 (scalar i, scalar j) Returns Y11(Sii, Sji, Sij, Sjj) 

Y12 (complex a, complex b, complex c, 

complex d) 

Y12 conversion = (1/Z0)*(-2*c)/((1+a)*(1+d) - 

b*c) 

Y12 (scalar i, scalar j) Returns Y12(Sii, Sji, Sij, Sjj) 

Y21 (complex a, complex b, complex c, 

complex d) 

Y21 conversion = (1/Z0)*(-2*b)/((1+a)*(1+d) - 

b*c) 

Y21 (scalar i, scalar j) Returns Y21(Sii, Sji, Sij, Sjj) 

Y22 (complex a, complex b, complex c, 

complex d) 

Y22 conversion = (1/Z0)*((1+a)*(1-d) + 

b*c)/((1+a)*(1+d) - b*c) 

Y22 (scalar i, scalar j) Returns Y22(Sii, Sji, Sij, Sjj) 

Z11 (complex a, complex b, complex c, 

complex d) 

Z11 conversion = Z0*((1+a)*(1-d) + b*c)/((1-

a)*(1-d) - b*c) 

Z11 (scalar i, scalar j) Returns Z11(Sii, Sji, Sij, Sjj) 

Z12 (complex a, complex b, complex c, 

complex d) 

Z12 conversion = Z0*(2*c)/((1-a)*(1-d) - b*c) 

Z12 (scalar i, scalar j) Returns Z12(Sii, Sji, Sij, Sjj) 

Z21 (complex a, complex b, complex c, 

complex d) 

Z21 conversion = Z0*(2*b)/((1-a)*(1-d) - b*c) 
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Z21 (scalar i, scalar j) Returns Z21(Sii, Sji, Sij, Sjj) 

Z22 (complex a, complex b, complex c, 

complex d) 

Z22 conversion = Z0*((1-a)*(1+d) + b*c)/((1-

a)*(1-d) - b*c) 

Z22 (scalar i, scalar j) Returns Z22(Sii, Sji, Sij, Sjj) 

 

Channel parameter data 

data Corrected data 

data(scalar i) Corrected data of trace i (trace number) 

mem Memory data 

mem(scalar i) Memory data of trace i (trace number) 

xAxis X-axis data 

xAxis(scalar i) X-axis data of trace i (trace number) 

S11 – S22 S-parameter data 

 

Common H parameter, Y parameter, Z parameter, F parameter, and T parameter definition (2-

port network): 

1. Mixing Parameter(H) 

(
𝑉1

𝐼2
) = (𝐻) (

𝐼1

𝑉2
)      (𝐻) = (

𝐻11 𝐻12

𝐻21 𝐻22
) 

 

2. Admittance parameter(Y) 

(
𝐼1

𝐼2
) = (𝑌) (

𝑉1

𝑉2
)      (𝑌) = (

𝑌11 𝑌12

𝑌21 𝑌22
) 

 

3. Impedance parameter(Z) 

(
𝑉1

𝑉2
) = (𝑍) (

𝐼1

𝐼2
)      (𝑍) = (

𝑍11 𝑍12

𝑍21 𝑍22
) 

 

4. transmission parameter(F) 

(
𝑉1

𝐼2
) = (𝐹) (

𝑉2

−𝐼2
)      (𝐹) = (

𝐴 𝐵
𝐶 𝐷

) 
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5. Scattering transmission parameter(T) 

(
𝑎1

𝑏1
) = (𝑇) (

𝑏2

𝑎2
)      (𝑇) = (

𝑇11 𝑇12

𝑇21 𝑇22
) 

 

𝑎1 =
𝑉1 + 𝐼1𝑍0

2 ∙ √𝑍0

           𝑎2 =
𝑉2 + 𝐼2𝑍0

2 ∙ √𝑍0

 

 

𝑏1 =
𝑉1 − 𝐼1𝑍0

2 ∙ √𝑍0

           𝑏2 =
𝑉2 − 𝐼2𝑍0

2 ∙ √𝑍0

 

 

S parameter convert to H parameter, Y parameter, Z parameter, F parameter and T parameter 

(2-port network): 

 

1. S parameter convert to H parameter 

𝐻11 = 𝑍0 ∙
(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

 

 

𝐻12 =
2 ∙ 𝑆12

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21
 

 

𝐻21 =
−2 ∙ 𝑆21

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21
 

 

𝐻22 =
1

𝑍0

∙
(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

 

 

2. S parameter convert to Y parameter 

𝑌11 =
1

𝑍0
∙

(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

 

 

𝑌12 =
1

𝑍0
∙

−2 ∙ 𝑆12

(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21
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𝑌21 =
1

𝑍0
∙

−2 ∙ 𝑆21

(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21
 

 

𝑌22 =
1

𝑍0
∙

(1 + 𝑆11)(1 − 𝑆22) + 𝑆12𝑆21

(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

 

 

3. S parameter convert to Z parameter 

𝑍11 = 𝑍0 ∙
(1 + 𝑆11)(1 − 𝑆22) + 𝑆12𝑆21

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21

 

 

𝑍12 = 𝑍0 ∙
2 ∙ 𝑆12

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21
 

 

𝑍21 = 𝑍0 ∙
2 ∙ 𝑆21

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21
 

 

𝑍22 = 𝑍0 ∙
(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21

 

 

4. S parameter convert to transmission parameter 

A =
(1 + 𝑆11)(1 − 𝑆22) + 𝑆12𝑆21

2 ∙ 𝑆21

 

 

B = 𝑍0 ∙
(1 + 𝑆11)(1 + 𝑆22) − 𝑆12𝑆21

2 ∙ 𝑆21

 

 

C =
1

𝑍0
∙

(1 − 𝑆11)(1 − 𝑆22) − 𝑆12𝑆21

2 ∙ 𝑆21

 

 

D =
(1 − 𝑆11)(1 + 𝑆22) + 𝑆12𝑆21

2 ∙ 𝑆21

 

 

5. S parameter convert to T parameter 
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𝐷𝑠 = 𝑆11𝑆22 − 𝑆12𝑆21 

 

𝑇11 =
−𝐷𝑠

𝑆21
 

 

𝑇12 =
𝑆11

𝑆21
 

 

𝑇21 =
−𝑆22

𝑆21
 

 

𝑇22 =
1

𝑆21
 

 

Description of formula editor’s operator: 

Operator Description 

+ plus 

- minus 

* multiply 

/ divide 

^ power 

( opening parenthesis 

) closing parenthesis 

, comma, parameter separator 

= equal 

E exponent 

 

Note: operator priority: 

1. ^ 

2. *, / 

3. +, - 
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7.5 Trace statistics 

Click Math → Analysis → Statistics, set the status to On to open the statistics function. The upper 

right corner of the interface will display the mean value, standard deviation, and peak to peak value 

of the current working trace. 

 

Figure 7-5 Statistical data interface 

 

7.6 Limit test 

Overview 

Limit Line is a test form that can visualize test data and results. The limit test compares the measured 

data with the defined limit and provides the qualified or unqualified judgment information of each 

measured data point. Limit line and limit test are not suitable for smith chart and polar display formats, 

and limit line and limit test functions are automatically disabled for these display types. 

 

Limit table setting 

Click Math → Analysis → Limit and the pop-up dialog box is shown in the figure below. Limit test, 

sound type, limit table, global pass/fail can be set in this interface. 
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Figure 7-6 Limit test interface 

 

Limit test: 

● Limit test on: Check this box to compare the data with the limit and display “pass” or “Fail” 

judgment result. 

● Limit line on: Check this box to display the limit on the screen. 

● Sound on fail: When this box is selected, when the point on the trace fails in the limit test, a 

beep will sound. 

 

Sound type: 

● Sound on fail: When this box is checked, the equipment will beep when the test fails. 

● Sound on pass: When this box is checked, the equipment will beep when the test passes. 

 

Limit table: 

● Show table: Check this box to open a table at the bottom of the screen to create and edit 

limits. 

● Load table: Call the saved limit table, The saved format of the limit table is CSV by default. 
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Global pass / fail: 

Pass / fail indicator is a convenient way to monitor all measurement status. 

Global pass / fail on - Check this box to display the global pass / fail status. 

Policy - Select which of the following requirements must be met for the global pass/fail status to 

display “pass”: 

● All tests must pass - This setting will read the results from the limit test. If all tests (limit test 

is on) pass, the global pass/fail status will be “pass”. 

● All measurements must pass - Unless all measured data points are within the established 

test limits and the limit test is “on”, the global pass/fail status will be “fail”. 

Note: In this mode, if there is a test that does not set the limit test to the on state, the global pass / 

fail will display “fail”. 

 

Limit line setting 

Click Math → Analysis → Limit Table → Limit to open the limit line setting interface, we can also 

click Math → Analysis → Limit → Show Table to open the limit line setting interface, as shown in 

the figure below. 

 

Figure 7-7 Limit line setting interface 

 

Limit line type: 

⚫ Unused: Invalid limit line. 

⚫ Max: Above this limit line, the measurement fails. 

⚫ Min: Below this limit line, the measurement fails. 

⚫ Delete: Delete limit line. 

Begin stimulus: Frequency of the limit line’s starting point. 

End stimulus: Frequency of the limit line’s ending point. 

Begin response: Response of the limit line’s starting point. 
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End response: Response of the limit line’s ending point. 

 

7.7 Point Limit test 

Overview 

Point Limit is a test form that can visualize test data and results. The limit test compares the measured 

data with the defined limit and provides the qualified or unqualified judgment information of the 

measured data point. Point Limit and limit test are not suitable for smith chart and polar display 

formats, and point limit and limit test functions are automatically disabled for these display types. 

 

Point Limit table setting 

Click Math → Analysis → Point Limit and the pop-up dialog box is shown in the figure below. Point 

Limit Test, Sound Type, Point Limit Table can be set in this interface. 

 

Figure 7-8 Point Limit test interface 

 

Point Limit test: 

● Point Limit test on: Check this box to compare the data with the limit and display “pass” or 

“Fail” judgment result. 
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● Point Limit on: Check this box to display the limit on the screen. 

● Sound on fail: When this box is selected, when the measurement point fails in the limit test, 

a beep will sound. 

 

Sound type: 

● Sound on fail: When this box is checked, the equipment will beep when the test fails. 

● Sound on pass: When this box is checked, the equipment will beep when the test passes. 

 

Point Limit table: 

● Show table: Check this box to open a table at the bottom of the screen to create and edit 

point limits. 

● Load table: Call the saved limit table, The saved format of the limit table is CSV by default. 

 

Point Limit setting 

Click Math → Analysis → Limit Table → Point Limit to open the point limit setting interface, we can 

also click Math → Analysis → Limit → Point Limit→ Show Table to open the point limit setting 

interface, as shown in the figure below. 

 

Figure 7-9 Point Limit setting interface 

 

Point Limit type: 

⚫ Unused: Invalid point limit. 

⚫ On: Open point test limit. 

⚫ Delete: Delete point limit. 

Stimulus: Frequency of the point limit. 
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Lower Limit: Lower limit of response value for point limit. 

Upper Limit: Upper limit of response value for point limit. 

 

7.8 Ripple limit test 

Overview 

The ripple limit test function can be performed independently of the limit test function, and the ripple 

limit can be set to evaluate whether the measurement result is qualified or unqualified. Ripple is 

defined as the difference between the maximum value and the minimum value within the specified 

excitation range. The ripple limit function is only applicable to the measured point value, not to the 

interpolation. 

Ripple table setting 

Click Math → Analysis → Limit → Ripple to open the ripple test setting interface, we can set ripple 

test, sound type, and ripple table in this interface. 

 

Figure 7-10 Ripple test setting interface 

 

Ripple test: 

● Ripple test on: Check this box to set the ripple test to “on” state and display “pass” or “Fail”. 
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● Ripple line on: Check this box to display the ripple limit line on the screen. 

● Sound on fail: When this box is checked, the VNA will beep when the test fails. 

Sound type: 

● Sound on fail: When this box is checked, the equipment will beep when the test fails. 

● Sound on pass: When this box is checked, the equipment will beep when the test passes. 

Ripple table: 

● Show table: Check this box to display a table at the bottom of the screen for creating and 

editing limits. 

● Load table: Call the saved ripple limit table. 

● Save table: Save the ripple limit table, the saved format of the ripple table is CSV by default. 

 

Ripple limit line setting 

Click Math → Analysis → Limit Table → Ripple to open the ripple limit setting interface, we can 

also click Math → Analysis → Limit → Ripple → Show Table to open the ripple limit setting interface, 

as shown in the figure below. 

 

Figure 7-11 Ripple limit setting interface 

 

Type: 

● Unused: Invalid ripple test line. 

● On: Open ripple test limit line. 

● Delete: Delete ripple test limit line. 

 

Begin stimulus: Frequency of ripple limit line’s starting point. 

End stimulus: Frequency of ripple limit line’s ending point. 

Max ripple: Maximum value of ripple test. 

Absolute: The difference between the maximum and minimum in the frequency band. 
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Margin: The difference between the absolute value of ripple and the limit value. 

 

7.9 Bandwidth limit test 

Overview 

The bandwidth limit test function can be used to test the bandwidth of a bandpass filter. The bandwidth 

limit test can find the peak value in the bandwidth, and find the frequency points lower than the 

specified value of the peak value on the left and right sides of the peak point, and the frequency 

between these two points is the filter bandwidth, and then compare the obtained bandwidth with the 

minimum and maximum allowable bandwidth specified in advance.  

 

Bandwidth test setting 

Click Math → Analysis → Limit → Bandwidth to open the broadband test setting interface, we can 

set bandwidth test, sound type, and target bandwidth in this interface. 

 

Figure 7-12 Bandwidth test setting interface 

 

Bandwidth test: 

● Bandwidth test on: Check this box to set the bandwidth limit test state to on. 
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● Bandwidth marker on: Check this box to display the bandwidth on the screen. 

● Sound on fail: When this box is selected, an alarm will sound when the bandwidth limit test 

fails. 

 

Target bandwidth: 

● N dB points: Specifies the bandwidth threshold in dB. 

● Min bandwidth: Enter the lower limit of bandwidth in Hz. 

● Max bandwidth: Enter the upper limit of bandwidth in Hz. 

Note: If the data format is Smith chart or polar coordinate format, the bandwidth test is skipped. 

 

7.10 Time domain 

7.10.1 Transform 

Overview 

A vector network analyzer is usually used to measure the frequency domain characteristics of the 

DUT. For the time domain characteristics of the DUT, the frequency domain parameters can be 

obtained by inverse Fourier transform. The time-domain characteristics use time as the horizontal 

axis to display the measurement results. Then the characteristics of the DUT can be observed from 

two different visual angles of frequency domain and time domain by the vector network analyzer.  

Time Domain Settings 

Click Math → Time Domain → Time Domain Setup → Transform to open the time domain 

transform setting interface, we can set the start time, stop time, center time, span, transform mode in 

this interface. 
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Figure 7-13 Time domain setting interface 

 

Transform switch: Check the transform switch to switch to time-domain mode.  

Start time: Set the start time of transformation displayed.  

Stop time: Set the stop time of transformation displayed.  

Center time: Set the center time of transformation displayed. 

Time span: Set the time span of the transformation displayed on the screen of VNA. 

Transform mode: 

● Low pass impulse: High resolution, suitable for viewing the small response of the device 

propagating low-frequency signal. In this low pass impulse mode, the frequency expands to DC 

and negative frequency. Therefore, when we click Set Low Pass Frequencies, the starting 

frequency will be automatically adjusted, which will affect the calibration accuracy. Therefore, it 

is necessary to calibrate after setting the time domain measurement parameters.  

● Low pass step: The simplest way to determine the discontinuities caused by inductors and 

capacitors in equipment that propagate low frequency signals.  

● Bandpass: The simplest method, which can be used with any frequency sweep, it is most useful 

when measuring devices with limited bandwidth. Capacitance and inductance reactance will not 

be shown. For the same frequency range and number of points, the bandwidth of bandpass mode 

is twice that of impulse mode, which will hide the closely spaced response and reduce the 

response resolution. The measurement range is inversely proportional to the frequency step. 

 

Set low pass frequencies:  

It can only be used in low pass mode. After clicking Set Low Pass Frequencies, the measurement 

range is inversely proportional to the starting frequency. Recalculate the start frequency and step 
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frequency as the harmonics of the starting frequency. Calculate the starting frequency according to 

the formula of low pass start frequency = stop frequency/points. The calculated value must not be 

less than the minimum frequency of the vector network analyzer. The number of points or stop 

frequency may change. 

 

7.10.2 Gating 

Overview 

The gating function of a vector network analyzer is the most useful feature in time domain transform. 

When the time domain characteristics of the equipment need to be viewed, the gating function can 

only choose the required time-domain response, eliminate unnecessary time domain response, and 

then view the frequency domain characteristic curve of the required response through Fourier 

transform. The gating function enables the DUT to be characterized without connectors or adapters. 

Gate Settings 

Click Math → Time Gating → Gating Setup → Gating to open the gating setting interface, then we 

could set the start time, stop time, center time, span, gate type, and gate shape in this interface.  

 

Figure 7-14 Gating setting interface 

 

Gating switch: Open or close the gating function. 

Start time: Set the start time of gating. 

Stop time: Set the stop time of the gate. 

Center time: Set the center time of the gate. 

Time span: Set the time span of the gate. 

Gate type: Sets the type of filtering performed by the gating function. 
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● Bandpass: Keep the response in the gating span. 

● Notch: Remove response using the gating span. 

Gate shape: Set the filter characteristics of the gating function. There are four options: minimum, 

normal, wide, and maximum. 

 

The parameter definition of the gating function is shown in the figure below: 

Bandwidth ripple

Sidelobe level

Gate shape

Gate marker

-6dB

T1

Gate start ti me Gate stop tim e

 

Figure 7-15 Diagram of gating 

 

Parameter description of gating function: 

Gate shape Bandwidth ripple Sidelobe level 

Minimum ±0.1 dB -25dB 

Normal ±0.1 dB -45dB 

Wide ±0.1 dB -52dB 

Maximum ±0.01 dB -80dB 

 

7.10.3 Window 

Overview 

There will be sudden changes in the start and stop of frequency domain parameter measurement, 

which will lead to overshoot and ringing in the time domain. The window function is helpful to reduce 

the overshoot and ringing in the process of frequency domain and time domain conversion.  

Window Settings 

Click Math → Time Gating → Gating Setup → Window to open the window setting interface, we 

can set the window size, The size of the window should be balanced between response resolution 

and dynamic range. Setting the minimum window can get the best response resolution, and setting 



SHN900A User Manual 

www.siglent.com                                                                                157 

the maximum window can get the maximum dynamic range.  

 

Figure 7-16 Window setting interface 

 

Three methods of setting window size: 

● Minimum-maximum: Use the mouse or touch screen to move the slider to change the 

window size. 

● Kaiser Beta: Use the value of Kaiser Beta to change the window size. 

● Impulse width: Use the value of impulse width to change the window size. 

 

Figure 7-17 Diagram of maximum and minimum window 

 

7.10.4 Coupling 

Overview 

Trace coupling allows to change the measured time-domain parameters and make all other measured 
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parameters in the channel change the same. For example, to view the frequency-domain and time-

domain measurement parameters at the same time, first turn on the coupling switch and select all the 

gating parameters in the coupling setting interface, at the same time, the parameters of gate span are 

changed in time domain measurement, the frequency-domain measurement parameters will be 

changed automatically to reflect the effect the time domain gate span parameters are modified. The 

trace coupling is only applicable to Y-axis scale / reference settings. The results of trace coupling do 

not change the measured data.  

Coupling Settings 

Click Math → Time Gating → Gating Setup → Coupling to open the coupling setting interface, we 

can set transmission parameters and gating parameters in this interface. 

 

Figure 7-18 Coupling setting interface 

 

Coupling switch: Click to enable coupling. At this time, all measurements in the channel are coupled. 

The following conversion parameters and gating parameters can be used for coupling. 

 

Transform parameters: 

● Stimulus: Setting of the start time, stop time, center time, and span. 

● State (On/Off): State of the transform. 

● Window: Kaiser Beta and pulse width parameter. 

● Mode: Low pass pulse, low pass step, bandpass. 

● Distance marker unit: When selected, all measured distance marker units are coupled. 

 

Gating parameters: 
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● Stimulus: Setting of the start time, stop time, center time, and span. 

● State (On/Off): Switch of gating function. 

● Shape: “Minimum”, “normal”, “wide” and “maximum”. 

● Type: Bandpass and notch filtering. 

 

7.10.5 Marker 

Overview 

When a marker is added to a time-domain parameter, the distance parameter is automatically 

displayed in the marker reading. These settings only affect the display of all markers of the active 

measurement (Unless the distance marker unit is coupled in the trace coupling box). 

Marker Mode and Units 

Click Math → Time Gating → Gating Setup → Marker to open marker setting interface. Set the 

marker mode, units, and velocity factor in this interface. 

 

Figure 7-19 Marker setting interface 

 

Marker mode: Specify the marker mode to determine the correct marking distance displayed. 

Generally, Auto can be selected when measuring S parameter, and Reflection or Transmission can 

be selected when measuring any ratio parameter. 

Auto: If the measurement parameter is S parameter, Reflection or Transmission will be selected 

automatically. If the measurement parameter is a non-S parameter, Reflection will be selected 

automatically. 

● Reflection: Displays the distance from the source to the receiver and the return path, then 

divides by 2 (compensated return path). 
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● Transmission: Displays the distance from the source to the receiver. 

● Units: Specifies the unit for the displayed marker distance value, there are three options: 

meter, feet, inches. 

 

Velocity factor: Set the velocity factor of the transmission line, where the value of PE is 0.66, PTFE 

is 0.7 and the corresponding value of vacuum is 1.  

 

7.10.6 Advance 

Description 

In time-domain low-pass pulse and step transformation modes, users can choose to use the automatic 

extrapolation function provided by the instrument to determine the DC component value, or customize 

the extrapolation value. 

 

DC Value 

 

 

DC Value Setting 

Entry: Math → Time Domain → Time Domain Setup → Advance → DC Value 
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Auto Extrapolate Switch: (Auto Extrapolate) Used to turn on or off the automatic extrapolation 

processing of the instrument. 

User Manual Entry: Users can manually enter custom DC values or click on the Extrapolate button 

to obtain the values extrapolated by the instrument based on the latest data. In addition, the UI also 

provides convenient input of Open, Short, and Load configuration values, allowing users to freely 

choose appropriate extrapolation values based on the DUT type. 
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8 Guide For the TDR Option 

8.1 Overview 

Measured frequency responses can be transformed to the time domain to analyze the time-domain 

characteristics of the DUT. The TDR option provides the time domain reflection/transmission analysis 

functions and eye diagram simulation function, which can help users save time and money by 

minimizing the need for other test equipment Time domain analysis also has some irreplaceable 

advantages: 

1. Time-domain analysis shows the positions and properties of the impedance discontinuities on 

DUT. It can be easy to acquire the impedance value at any point on the transmission line by 

analyzing the time domain reflection characteristics. It's helpful to locate the faults on 

transmission lines. 

2. Using the time domain gating function to remove the influences of the impedance discontinuities, 

it becomes possible to simulate the frequency domain characteristics of DUT after the faults are 

removed. 

3. The eye diagram simulation function doesn't need any external waveform generators. The VNA 

uses a built-in virtual bit pattern generator to provide the input signal. It's a very important tool for 

signal integrality analysis. 

4. If you want to design a compensation network for high-speed digital signal transmission by 

emphasis/ de-emphasis or equalization, the advanced waveform function in TDR waveform will 

be of vital use for you. You don't need to change the DUT connection or any extra devices, it's 

easy to simulate the eye diagrams with the different compensation methods. 

5. You can directly inject jitter into the input signal for eye diagram simulations. A statistical eye 

diagram is introduced to simulate the probability density of the output signals. 

 

When using the TDR option, there are some notes: 

1. When opening the TDR option or switching the DUT topology, calibration and deskew data will 

be cleared. Please finish the calibration wizard before measuring to get the correct results. Save 

the calibration data and recall it when required, which can avoid unnecessary calibration 

operations. 

2. Please operate in the bottom toolbar of the TDR menu as far as possible. The function in the 

TDR option desends on the time domain transform, so changing settings in the right toolbars can 

lead to incorrect transform results. 

3. Don't close the eye diagram module while the eye diagram is drawing, or an unexpected error 
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might occur. Unless necessary, don't switch between the TDR/TDT module and the eye diagram 

module, for the last eye diagram will be drawn when it's switched to the eye diagram module, 

which might take a long time. 

4. It's NOT recommended to add too many traces, or the trace data update will be slow. 

5. If there are too many windows or too much information in a window to observe the information or 

traces, it will be useful to maximize the window or trace. 

8.2 Open/Close/Preset TDR Option 

To switch on the TDR option, use the order Math->TDR->TDR, then the button "On" will be selected. 

The TDR toolbar will appear at the bottom of the screen, and the TDR option function will be open to 

the user. If you have the trial license for the TDR option, an information dialog will appear to notify 

you that the trial times will decrease. If the trial times expire, a permanent license is needed to switch 

on the TDR option. 

 

Figure 8-1 TDR Option interface 

 

To close the TDR option, use the order Math->TDR->TDR again, then the button “ Off ” will be selected, 

VNA will restore the state before the option opened. Click the  button at the top right corner of the 

TDR toolbar will close the TDR option too. 
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Click the Preset button in the Basic bar of the Setup tab in the TDR toolbar and the VNA will preset 

the TDR option: Clear the calibration data, allocate the traces and windows automatically, and reset 

the settings in the option. After the TDR option is started, the calibration wizard will need to be run 

again. 

 

8.3 TDR Setup Wizard 

The TDR setup wizard pops up when the TDR option is switched on for the first time. Click the 

checkbox “Show this wizard next start-up” to decide whether the wizard pops up when opening the 

option or not. The wizard can be opened by clicking the Setup Wizard button in the Basic bar of the 

Setup tab in the TDR toolbar. 

 

Figure 8-2 TDR Setup Wizard 

 

The wizard will guide you to finish the DUT topology selection, port extension setup, DUT length 

measurement, and stimulus rise time setting. The calibration type can be selected in the Error 

Correct bar on the first page of the wizard, and the wizard will also guide you to finish the calibration 

you select. The calibration operation will be illustrated in detail in the section “TDR calibration”. 

If you don't need to finish the setup in the wizard immediately, you can close the wizard. But the 

calibration is necessary before accurate measurement or analysis. 
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8.4 Calibration for TDR Option 

There are two calibration types in the TDR option: Deskew or Deskew & Loss Compensation. The 

former only moves the reference plane to the end of the cables connected to the ports of VNA, 

ignoring the signal loss in the cables. And the latter tries to compensate the loss in the cables. 

 

Figure 8-3 TDR Calibration Tab 

 

In addition, the TDR option can still easily use various original calibration types, and also supports the 

use of electronic calibration components for calibration; the calibration operation is the same as before. 

To use the original calibration type, click the Basic Cal button in the Basic Settings column of the 

Setup tab in the toolbar at the bottom of TDR to calibrate according to the instructions in the pop-up 

dialog box; To use electronic calibration components for calibration, click the ECal button to perform 

electronic calibration in the pop-up dialog box. 

8.4.1 Deskew 

Click the Deskew button in the Basic bar of the Setup tab in the TDR toolbar to open the Deskew 

dialog. Connect all cables and fixtures to the VNA, and connect the other ends of the fixtures to 

nothing or the OPEN calibration kit. Then click the Deskew button in the dialog, and click the Finish 

button after a green "ok" mark appears at the Deskew button to finish the Deskew calibration. 

Click the Option button to open the Deskew Option dialog, in which you can select the calibration 

type or operate the calibration one-by-one for each port. The calibration type can be selected by the 

Standard Type pull-down menu. It's set to Open by default. If you choose the Short option, you 

should connect the SHORT calibration kit to the port to finish the calibration. You can calibrate only 

one port at a click on the corresponding Port button, but you should finish the calibration of all ports 

to finish the task in the dialog. 
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Figure 8-4 TDR Deskew Wizard 

 

8.4.2 Deskew & Loss Compensation 

Click the Deskew&Loss button in the Basic bar of the Setup tab in the TDR toolbar to open the 

Deskew & Loss Compensation wizard. The wizard can be divided into 3 steps, which guide you to 

finish the Deskew and Loss Compensation calibration. 

At the first step, a Deskew calibration is required. The method is the same as the operation introduced 

in the section “Deskew”. 

At the second step, the calibration operation depends on the correct DUT topology. Under the 

topology Single-Ended 1 Port, you need to connect the cables and fixtures to the VNA, connect the 

other ends of the fixtures to nothing or an OPEN calibration element. Click the Measure button in the 

wizard, wait for the green "ok" mark to appear at the Measure button to finish the second step of 

calibration. Under other DUT topologies, you need to connect two cables and fixtures, which are 

connected to the ports as the wizard instructs, to both ends of a THRU calibration kit. Click the 

Measure button in the wizard, wait for the green "ok"  mark to appear at the Measure button, then 

execute the next operation. 

At the third step, you can connect the LOAD calibration element to every port, and click the 

corresponding Port button to execute the calibration step. The step is optional, so it's not necessary 

to finish the calibration wizard. 
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If you finish all necessary calibration operations, click the Apply button to save and apply new 

calibration data, and click the Finish button to close the wizard.  

 

Figure 8-5 TDR Deskew&Loss Wizard 

 

At any step of the wizard, it's allowed to execute a calibration operation repeatedly, new measured 

data will replace original data. You can click the Close button to close the wizard, which will give up 

all data measured in the wizard unless you have clicked Apply button to save them. 

8.5 TDR Channel Setup 

When the TDR function is activated, the current state is saved, and all existing traces and channels 

are deleted, and a new channel is added for the option. When the option is closed, all traces and the 

channel being used are deleted, and the instrument is returned to the state before TDR was opened.  

The current channel settings can be changed in the TDR toolbar at the bottom of the screen, usually 

in the Setup tab. 

 

Figure 8-6 TDR Setup Tab 
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8.5.1 DUT Topology 

In addition to the Setup wizard, the DUT topology can be changed in the DUT topology pull-down 

menu in the Basic bar of the Setup tab. The traces and windows are allocated automatically 

according to the DUT topology. 

If the DUT topology is changed, the calibration and deskew data will be cleared. Recalibration 

becomes necessary before an accurate measurement or analysis. If the calibration data is hoped to 

be held, save the state in time and recall it when required. 

 

8.5.2 DUT Length 

The DUT length means the time that the signal takes to transmit through the DUT or reflect the incident 

plane and is required to show the time-domain responses of DUT in full. The sweep frequency span 

and points of the channel are set according to the DUT length, and the span of the transformation is 

automatically calculated by the DUT length when the time domain traces are set in the time axes. It's 

not recommended to change the sweep settings by other methods. 

 

Figure 8-7 DUT Length measure wizard 

 

In addition to the Setup wizard, the DUT length can be set in the DUT Length textbox in the Basic 

bar of the Setup tab. It's a convenient way to set the suitable value by measuring the DUT length in 

the DUT Length dialog. Click the Auto button on the left of the textbox to open the dialog, connect 
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the DUT according to the picture and instructions in the dialog, click the Measure button and wait for 

the green "ok" mark to appear, click the Finish button to close the dialog, and finish the DUT length 

setting. If the measurement result is out of the default range, an information dialog will pop up to notify 

the users that the DUT length will be set to the maximum or minimum. 

 

8.5.3 Stimulus Magnitude in Time Domain 

The stimulus magnitude in the time domain can be set in the Stim. Ampl. textbox in the Basic bar of 

the Setup tab, which defines the magnitude of the impulse or step stimulus signal for the time-domain 

responses of the traces under the format Volt. 

 

8.5.4 Port Impedance 

The port impedance can be set in the Ref. Z textbox in the More Function bar of the Setup tab, 

which defines the reference impedance to calculate the impedance values of the traces under the 

format Impedance. 

 

8.5.5 Velocity Factor & Dielectric Constant 

The velocity factor is the ratio of the velocity of the electric signal in the DUT to that in the vacuum. 

VNAs calculate the distances by the transmission or reflection time based on this factor, which 

provides the accurate positions of the impedance discontinuities. There is a functional relationship 

between the velocity factor and the dielectric constant of the materials. When either is changed, the 

other will be calculated by the equation below: 

Velocity Factor =
1

√𝐷𝑖𝑒𝑙𝑒𝑐𝑡𝑟𝑖𝑐 𝐶𝑜𝑛𝑠𝑡𝑎𝑛𝑡
 

 

The velocity factor and dielectric constant can be set in the Velocity Factor and Dielectric Const. 

textboxes in the More Function bar of the Setup tab. 

 

8.5.6 Power Level 

The power level is the power of the test signal transmitted to the DUT, which can be set in the Source 
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Power spinbox in the More Function bar of the Setup tab. 

 

8.5.7 Average 

The average function means that the final measure results are equal to the average of the measure 

results in the several sweeps in the same setting, and the number of sweeps needed depends on the 

averaging factor. The average function can decrease the random errors to some degree, but slow 

down the update of trace data. It's necessary to keep the characteristics and connection of the DUT 

unchanged during an average sweep. 

To enable or disable the average function, click the Averaging checkbox in the Average tar of the 

Setup tab. The average factor can be set in the textbox to the right of the checkbox. 

 

Figure 8-8 Avg/BW setting 

 

8.5.8 IF Bandwidth 

The IF bandwidth is the bandwidth of the intermediate-frequency filters in the receivers. A narrow IF 

bandwidth leads to lower trace noise levels and longer sweep times. 

The IF bandwidth can be set in the IF Bandwidth textbox in the Average tar of the Setup tab. 

 

8.5.9 Trigger Mode 

The trigger mode gates the channel sweep state change when the trigger signal is detected. The 

trigger mode Hold/Stop means that sweep can't be started even if the trigger signal is detected. 

Single means that only one sweep is triggered by the trigger signal. Upon sweep completion, the 

trigger mode is set to Hold/Stop. Continuous/Run means that the trigger signal starts and 

continuously sweeps. 

To switch the trigger mode to Continuous/Run, click the Run button at the top of the TDR toolbar. To 

switch the trigger mode to Single, click the Stop/Single button at the top of the TDR toolbar. 
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8.6 TDR Trace Setup 

Without taking the set coupling into account, the settings as follows are applied to a single trace. 

Usually, the traces in the TDR option are in a time-domain coupling and marker coupling, meaning 

that the correlated settings are applied to all the traces. In addition, there is a set of default trace 

configurations for every DUT topology. 

 

8.6.1 Select a Trace 

In addition to clicking the trace or trace information bar on the screen, the Trace pull-down menu at 

the top of the TDR toolbar has the same function. 

 

8.6.2 Trace Scale Settings 

In the TDR option, there are several automatic scale settings to use, and it is allowed to change the 

scale or reference value manually. 

 

8.6.2.1 Auto Scale 

To apply the automatic scale settings, click the Auto Scale button at the top of the TDR option and 

click the suitable option in the pull-down menu. Every option in the menu represents a set of automatic 

scale settings. 

Option X means that the horizontal axis of the current trace is set automatically. For the traces in the 

time domain, the scale and reference value are calculated by the DUT length. For the traces in the 

frequency domain, the horizontal axis is set to the frequency sweep setting of the channel. 

Option Y means that the vertical axis of the current trace is set automatically. The scale and reference 

value are calculated by the maximum and minimum of the trace data. 

Option X&Y means that the horizontal and vertical axes of the current traces are set automatically. 

The method is the same as introduced above. 

All Trace means that the horizontal and vertical axes of all the traces are set automatically. The 

method is the same as introduced above. 

 



SHN900A User Manual 

172                                                                               www.siglent.com 

8.6.2.2 Manual Scale Setup 

Manual calibration Settings are implemented through the Scale setting option in the TDR menu. 

Horizontal is used to set the Horizontal coordinate and the reference point position, Vertical is used 

to set the Vertical coordinate and the reference value. Users click the corresponding edit box to enter 

the value through the number button on the front panel. 

 

Figure 8-9 Scale Setup by manual 

 

The vertical axis of the traces in the frequency domain has no concern with the sweep setting of the 

channel, only to set the displayed span of the trace data. 

8.6.3 Memory Trace Management 

Memory trace management is in the Data/Mem pull-down menu at the top of the TDR toolbar. Click 

the Data->Mem order in the menu, and the current trace data is saved to the memory trace. Other 

orders in the menu are display modes of the data trace and the memory trace for the current trace: 

The option Off means the data trace and the memory trace are invisible. The option Memory means 

only the memory trace shows in the window. The option Data means only the data trace shows. The 

option Data&Mem means both of them are visible. 

8.6.4 Measure Parameter & Format 

The measurement parameters and formats of the traces can be set in the Parameter tar of the 

TDR/TDT tab. 

The physical significance of measurement parameters and formats in the frequency domain is the 

same as the general parameters of the VNA. In the time domain, T parameters are used as 

measurement parameters, meaning that the ratio of the magnitudes of the response signals received 

to the stimulus signals when a unit step / impulse stimulus signal is transmitted to DUT at time zero, 

in a span. For a specified DUT, S parameters are functions of the signal frequency, while T parameters 

are functions of the time under a specified stimulus type. T parameters show the unit step / impulse 
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response of the DUT, which is of vital importance in the time domain system analysis. 

 

Figure 8-10 measure parameter setting 

 

The formats of T parameters include Log Mag, Lin Mag, and Real, which are the same as S 

parameters; moreover, Impedance and Volt are added. T parameters show the time domain 

responses, so the values are always real numbers. In the other words, the imaginary parts are always 

zero. Therefore, Imaginary or phase formats aren't provided for T parameters in the TDR option. The 

magnitude of Log Mag and Lin Mag formats is intrinsically the absolute values of the real parts of T 

parameters. 

Impedance format is usually used for the reflection T parameters under a unit step stimulus. It 

calculates the impedance value of each point in the signal transmitting path by the reflection T 

parameters (reflection coefficients) under the unit step stimulus, which is on the base of the port 

impedance. The distances are calculated by the delay of transmission and the velocity factor. In the 

Impedance format, the positions and properties of impedance discontinuities in the DUT are shown 

on the traces visually, which provides a piece of important information for fault detection and removal. 

In the Impedance format, the TDR option regards the T parameters as the reflection coefficients ρ, 

and calculates the impedance by the equation as follow: 

Z = 𝑍0  
1 + 𝜌

1 − 𝜌
 

 

Volt format means the trace shows the time domain waveform of the response signal received under 

the specified stimulus. The magnitude of the stimulus signal is defined by the value in the Stim. Ampl. 

textbox in the Basic bar of the Setup tab. Intrinsically, the Volt format means the trace data is a 

product of the T parameters and the magnitude of the stimulus signal. 

Click the measure parameter button in the grids on the left of the Parameter bar, the measurement 

parameter of the current trace switches to the corresponding parameter. To switch on or off the time 

domain transform of the current trace, click the pull-down menu in the left of the Measure line. To 

switch to balance or unbalance parameters, click the pull-down menu in the right of the Measure line. 
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To change the format, click the Format pull-down menu. 

 

8.6.5 Stimulus in Time Domain 

The stimulus type can be set in the Stimulus pull-down menu in the Parameter bar of the TDR/TDT 

tab. There are two stimulus types to choose: The option Lowpass Step means T parameters show 

the unit step responses and the option Lowpass Impulse means T parameters show the unit impulse 

responses. 

The rise time or impulse width of the stimulus signal can be set in the Rise Time or Impulse Width 

textbox. Intrinsically, it controls the beta value of the Kaiser window function applied in the time domain 

transformation to weaken the sidelobes. Because the transformation is based on the finite frequency 

domain data, the data truncation at the end of frequency domain data leads to some problems, such 

as the extension of the rise time or impulse width of the responses signal and the appearance of 

sidelobes, which is called "truncation effect". Applying the Kaiser window lowers the sidelobe levels, 

but aggravates the extension of the rise time or impulse width and brings down the resolution ratio of 

transformation. The longer the rise time or impulse width of the stimulus signal, the larger the beta 

value of the Kaiser window function, the stronger effects explained above are introduced into the 

transformation. 

 

8.6.6 Smoothing 

The smoothing function makes the trace data smooth by replacing the original trace data with the 

average of the data nearby. If the local change ratios of trace data are relatively large, the smoothing 

leads to large data errors. Therefore, the smoothing function is available for the traces whose measure 

parameters are reflection S parameters. 

To switch on or off the smoothing function, click the Smoothing checkbox in the Parameter bar of 

the TDR/TDT tab. 

 

8.6.7 Trace Allocation 

The TDR option will delete all existing traces and windows, allocate all the traces and windows 

automatically for the DUT topology, and set the traces to default settings if the trace allocation function 

is activated. The operation deletes all original traces and their settings, but the channel settings 

remain. There are three allocation methods to choose from: The option Mixed means that the traces 

in the time and frequency domain are allocated. The option All T means that only traces in the time 
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domain are allocated. The option All S means only traces in the frequency domain. Note that in Single-

ended 1 Port topology, only the option Mixed is available. 

To use the trace allocation function, click the button of the corresponding method in the Allocation 

box in the Trace Control bar of the TDR/TDT tab. 

 

Figure 8-11 Trace Control Tab 

 

8.6.8 Trace Setup Coupling 

In the TDR/TDT Tab of TDR, users can select the Coupling box of the Scale, Marker, or Gating menu 

option to enable Time domain setting coupling, Marker coupling, or Gate coupling for traces. 

8.6.9 Time Domain Gating 

The time-domain gating function transforms the time domain response into the frequency domain 

after removing a part of the response. Usually, the function is used to simulate the expected frequency 

domain response after removing some faults by removing the abnormal responses resulting from the 

impedance discontinuities. The operation procedure includes enabling the time domain 

transformation, setting the parameter to remove partial time-domain responses, observing the other 

traces in the frequency domain whose gating settings are coupled with the trace, or close the time 

domain transformation to observe the frequency responses. 

The time-domain gating settings in the TDR option can be changed in the Gating bar of the TDR/TDT 

tab. 

To switch on or off the time domain gating function, click the Gating checkbox. 
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Figure 8-12 TDR Gating Tab 

To change the function type of the gating range, click the ratio button in the Type box. The option 

Notch means that the responses in the gating range will be ignored, while the option Bandpass 

means that the responses beyond the gating range will be ignored. 

The scroll-wheel and textbox can be used to change the start and stop position of the time domain 

gating range. 

8.6.10 DC Value 

Description 

In time-domain low-pass pulse and step transformation modes, users can choose to use the automatic 

extrapolation function provided by the instrument to determine the DC component value, or customize 

the extrapolation value. 

 

DC Value Setting: 

Entry: TDR → TDR/TDT → DC 

Auto Extrapolate Switch: (Auto Extrapolate) Used to turn on or off the automatic extrapolation 

processing of the instrument. 

User Manual Entry: Users can manually enter custom DC values or click on the Extrapolate button 

to obtain the values extrapolated by the instrument based on the latest data. In addition, the UI also 

provides convenient input of Open, Short, and Load configuration values, allowing users to freely 

choose appropriate extrapolation values based on the DUT type. 
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8.7 TDR Data Analysis & Output 

The general marker search function is available in the TDR option for data analysis, and there are 

some shortcuts provided at the top of TDR toolbar for marker management and search for 

maximum/minimum with tracking. In addition, the functions of the rise time search and delta time 

search are introduced as the time domain trace data analysis tools in the TDR option. 

To correct the errors of impedance calculation resulting from the complicated distribution of 

mismatches in the DUT, a peeling algorithm is introduced to reveal the actual impedance value of 

every point on the passive DUTs. 

The shortcuts to save/recall the state files, output the trace data to the files, and save the screenshot 

are provided in the File pull-down menu at the top of the TDR toolbar. 

 

8.7.1 Marker Setup 

In addition to the general ways to manage the markers in the VNA, the Marker pull-down menu at the 

top of the TDR toolbar is a way to add or delete markers. 

The order in the first group of the Marker Search pull-down menu is shortcuts to manage the common 

marker tracking marker. The option Off closes the search function of the current marker, while the 

Max or Min starts the tracking search for maximum or minimum. 

 

8.7.2 Rise Time Search 

Rise time search is only available for the trace in the time domain, which searches for the rising or 

falling edge, sets a label to the start and stop, and displays the transition type and time at the top left 

corner of the window if successful. It's a tracking search, the results update if the trace data changes. 

To switch on or off the rise time search, click the Rise Time (10-90%) or Rise Time (20-80%) option 

in the Marker Search pull-down menu. Selecting the suitable search type depends on the 

requirements. 

 

8.7.3 Delta Time Search 

Delta time search is only available for the trace in the time domain, which searches for the difference 

between the time where two traces rise or fall to a specified relative level in respective transition edge. 

If successful, a label will be set to the relative level on both traces, and the results will be displayed 
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at the top left corner of the window that contains the start trace of the search. It's a tracking search, 

the results update if the trace data changes. 

Click the △Time... order in the Marker Search pull-down menu to open the △Time dialog, and the 

settings of delta time search can be changed here. 

Click the Trace (Start) pull-out menu to change the start trace of the search, click the Trace (Stop) 

pull-out menu to change the stop trace. A trace in the time domain can start one search at most as a 

start trace, while it's allowed that more than one searches set the same trace as the stop trace. 

The target relative level of the search can be set in the Position (%) textbox in the dialog. 

To switch on or off the search, click the △Time Enable checkbox. 

 

8.7.4 Peeling 

If there are two or more impedance mismatches on the DUT, a part of the incident wave is reflected 

at the first mismatch, the incident energy arriving at the next mismatch reduces, so the reflection at 

the next mismatch might seem weaker than that in reality. Calculating impedance using reflection 

coefficients might lead to obvious errors after the first mismatch. To avoid the effect of the masking 

phenomena explained above, a new approach to calculate impedance, called the peeling algorithm, 

is introduced in the TDR option. The algorithm divides the DUT into many sections, calculates the 

impedance of the next section by the impedance of the last section as the reference value, and the 

incident and reflected energy in reality. 

The algorithm presupposes that the energy sum of input equals that of output at any points on the 

path the signal transmits through, which means that the signal transmits through the DUT without loss. 

This is an imperfection of the algorithm, and transmission loss always decreases the accuracy. 

Because of the recurrence method in the algorithm, the accuracy also decreases with the distance 

increases. 

If the peeling function is enabled, the TDR option calculates impedance in the way explained above, 

instead of the traditional way. The function is available only if the format of the trace is Impedance of 

the reflection T parameters. To switch on or off the function, click the Peeling checkbox in the 

Parameter bar of the TDR/TDT tab. 

8.7.5 File & Data Output 

In the File pull-down menu at the top of the TDR toolbar, there are some shortcuts for file operation 

and data output. 

The order Save State... is used to save the current state and calibration data as a .CSA file, and 
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Recall State... is used to restore them from the files. 

The order Save Trc Data... is used to save the current trace data to .CSV file, and Save SnP... saves 

all available S parameters data as an .SNP file whose format depends on the DUT topology. 

Screenshot... is used to save the screenshot as a .PNG file. 

 

8.8 Eye Diagram Simulation 

8.8.1 Overview 

Eye diagrams are used to analyze the influence of the intersymbol interference and noise on 

transmission performance, which is an important tool for signal integrity analysis. The eye diagram 

simulation function, included with the TDR option, is built on a virtual digital signal generator and the 

frequency characteristics of the DUT. It simulates that a virtual input digital signal transmits through 

the DUT, and analyzes the output signal to get an eye diagram. This is different from the traditional 

way of using an oscilloscope to draw eye diagrams. There is no need to provide an external digital 

signal to the input port of the DUT. To simulate different input signals, change the stimulus settings in 

the eye diagram module. 

 

Figure 8-13 Eye/Mask Tab 

 

The data analysis of eye diagrams in the option will try to get the numerical characteristics of the 

diagram and mark them on the diagram if required, which is designed to help the users obtain the key 

information quickly. 

The jitter injection and statistical eye diagram function are provided to analyze the influence of the 

jitter in the input signal on the transmission performance. 

The mask test on the eye diagram and preinstalled mask patterns are a convenient method of 

estimating whether the eye diagram meets the design requirements. 
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To start an eye diagram simulation after completing the simulation settings, click the Draw Eye button 

in the Trigger box of the Eye/Mask tab. 

8.8.2 Stimulus Bit Pattern 

There are 3 bit pattern types to choose in the option: Pseudo-Random Binary Sequence (PRBS), 

K28.5 comma code, and the user's bit pattern. 

 

For more information about PRBS, refer to the section Bit Pattern Length. K28.5 comma code is 

defined in an industry-standard developed by IBM which includes comma (control) characters. The 

user's bit pattern is imported from the user-defined files. The introduces of the bit pattern types in the 

table as follow: 

 

Type Bit Pattern Length Generator 

PRBS 
Depends on the users,  

limited in 2n-1, n = 3,5,7,9,11,13,15 
Generated by a virtual PRBS generator 

K28.5 20 “00111110101100000101” (20 bits) 

User limited between 2 and 8192 Imported from a user-defined file 

 

8.8.2.1 Bit Pattern Type 

To change the input bit pattern types, click the Type pull-down menu in the Stimulus box of the 

Eye/Mask tab. 

The option Statistical in the menu is used to switch on the statistical eye diagram mode, which cannot 

change the bit pattern types for the normal eye diagram simulation. 

8.8.2.2 Bit Pattern Length 

The bit pattern length of K28.5 code is 20 bits, and that of the user pattern depends on the text in the 

file. Only the length of PRBS can be changed in the eye diagram simulation module by clicking the 

Length pull-down menu in the Stimulus box. 

A set of Linear Feedback Shift Register (LFSR) is simulated to generate virtual PRBS, whose 

maximum period is selected to equal the bit pattern length. The maximum of the period of PRBS, 

generated in a set of LFSR of n level, is 2n-1. In the other words, in ideal conditions, the sequence 

will iterate all possible binary numbers of n bits. The initial condition of the LFSR is random, PRBS 

generated becomes random to find the worst bit pattern of n bits for transmission performance. Eye 

diagram simulation always includes all n-bit input patterns to show the worst transmission 
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performance of DUT, if PRBS is set as the input signals. So it's recommended to use PRBS as a bit 

pattern to draw eye diagrams. 

The bit pattern length of PRBS is limited in 2n-1, and n = 3, 5, 7, 9, 11, 13, 15. That means the bit 

pattern will be generated by LFSR of n level, to include the worst condition as far as possible. The 

larger length is selected, the degree of the simulation perfection for intersymbol interference becomes 

better, but running time becomes longer. 

 

8.8.2.3 User Pattern 

If the eye diagram is required to simulate the specific bit pattern as the input signal, select the option 

USER in the Type pull-down menu, and click the User Pattern button to open the Bit pattern Editor 

dialog to set the user-defined pattern. In the dialog, you can load .txt files to import the text as the bit 

pattern and edit the bit pattern in the textbox. Close the dialog after loading or saving the bit pattern 

file, the pattern will be used for the next eye diagram simulation. 

The text file to load must contain 0 and 1, but any other characters; and the length of text must be 

between 2 and 8192.  

 

8.8.3 Stimulus Signal Setup 

8.8.3.1 Logic Level 

To change the logic level of the input signal, set the value in the One Lv. or Zero Lv. textbox in the 

Stimulus box of the Eye/Mask tab at the bottom of the TDR toolbar. 

8.8.3.2 Data Rate 

The data rate of the signal is the number of bits transmitted per second, which reflects the base 

frequency of the signal. Considering the lowpass characteristics of transmission systems in reality, 

the transmission becomes bad with a large data rate, and the signal integrity analysis becomes 

important. 

To change the data rate of the input signal, set the value in the Data Rate textbox in the Stimulus 

box of the Eye/Mask tab at the bottom of the TDR toolbar. 

8.8.3.3 Rise Time 

The rise time of the signal reflects the steepness of the transition edge. The smaller rise time means 

the higher degree of steepness, the larger proportion of high-frequency parts, and the more serious 

high-frequency losses can be during transmission. It's effective to widen the eye by reducing the rise 

time properly. But too small a rise time leads to ringing phenomena at the logic level of the output 
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signal, resulting in the decrease of the eye height. 

To change the rise time type or value of the input signal, operate the Rise Time pull-down menu or 

textbox in the Stimulus box of the Eye/Mask tab at the bottom of the TDR toolbar. 

8.8.4 Eye Diagram Analysis 

During the eye diagram simulation, the option analyzes the eye diagram automatically and try to get 

the numerical characteristics as follow: Rise Time, Fall Time, Jitter, Crossing Percent, Opening 

Factor, The Ratio of Signal to Noise, Duty Cycle Distortion, Level One, Level Zero, Level Mean, 

Amplitude, Height, Width. And Rise Time, Fall Time, Jitter (peak-peak value), Amplitude, Height, 

Width are allowed to be marked on the eye diagram to conveniently obtain the characteristics of the 

eye diagram. 

 

8.8.4.1 Analysis Result Overlay 

To switch on or off the data analysis markers on the diagram, click the Overlay checkbox in the Result 

bar of the Eye/Mask tab at the bottom of the TDR toolbar. 

 

8.8.4.2 Rise Time in Data Analysis 

To change the rise time type for data analysis of eye diagrams, click the Rise Time Def. pull-down 

menu in the Result bar of the Eye/Mask tab at the bottom of the TDR toolbar. 

 

8.8.5 Eye Diagram Scale Management 

By default, the eye diagram is displayed in the automatic scale settings, which show the details as 

clearly as possible. They can also be manually changed. 

The scale settings in the vertical axis can be changed manually. But those in the horizontal axis 

depend on the data rate of the input signal, which can't be changed after the simulation starts. 

To switch to a scale setting mode, click the Auto Scale or Manual radio button in the Scale/Mask bar 

of the Eye/Mask tab at the bottom of the TDR toolbar. 

To change the scale or offset values in Manual scale mode, set the value in the Scale/Div or Offset 

textbox. The Offset value here is the value that the center vertical scale line refers to. 
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Figure 8-14 Eye/Mask setting 

 

8.8.6 Mask Test for Eye Diagram 

Mask patterns are some areas where the eye diagram is forbidden to pass, which transfer the design 

requirements of the transmission systems into the numerical characteristics of eye diagrams. They 

usually rule the tolerance of logic 0, 1 level and rise or fall time. If the eye diagram passes through 

the areas, the TDR option judges that the eye diagram can't meet the requirement, leading to the 

failure of the mask test. According to different communication standards, or at the different nodes in 

a communication system, different mask patterns should be applied. The first step to mask test is to 

select or design a suitable mask pattern based on the requirements. 

To select or change the mask pattern applied, click the Mask Pattern button in the Scale/Mask bar 

to open the Mask Pattern dialog. 

In the File tab of the dialog, preinstalled standard patterns or user-defined mask files (.MSK format) 

can be loaded. In the Scale tab, the Margin of the mask, start Position of a bit, Delta time of a bit, 

and Logic Level can be set in textboxes. In the Edit tab, the positions of vertices in the mask pattern 

can be changed by set values in the textboxes. Dragging the vertices in the left window also makes 

sense, but it's recommended to drag with a mouse connected to the VNA, because the points may 

be too close together for easy entry using touch operation. 

Close the dialog after saving the modifications to a mask file, the new pattern will be applied to the 

next mask test. 

To switch on or off the mask test, click the Mask Test checkbox in the Scale/Mask bar of the 

Eye/Mask tab at the bottom of the TDR toolbar. 

 

8.8.7 Jitter & Statistical Eye Diagram 

Jitter is the transient deviation from the corresponding ideal position of a signal over successive trigger 
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events. High jitter worsens the transmission performance. It's divided into the Deterministic Jitter (DJ) 

and the Random Jitter (RJ). RJ is generated by some unpredictable factors and is independent of the 

input bit patterns. The models for RJ usually have a Gaussian distribution, and the magnitudes are 

represented in root mean square (RMS) values. DJ is generated by some repeatable and predictable 

factors and usually has a finite magnitude value. The jitter related to the input bit patterns in DJ is 

called the Data Dependent Jitter (DDJ), while the other jitter in DJ is called the Periodic Jitter (PJ). 

 

Figure 8-15 Eye jitter setting 

 

To change the settings of the jitter injection, click the Advanced Waveform button in the Stimulus 

box of the Eye/Mask tab, or click the buttons in the Adv Waveform bar of the Setup tab, to open the 

Advanced Waveform dialog. Click the Jitter button at the top of the dialog to switch to enter the jitter 

setting interface. 

To change the jitter type injected into the input signal, click the Random or Periodic ratio button in 

the Type box. To set the jitter parameters, set the values in the corresponding textboxes. 

To select the jitter magnitude units, click the Jitter Unit pull-down menu. The unit UI means that the 

time difference value between the zero time of two adjacent transition edges in the signal, which is 

the default jitter magnitude unit. 

To set the probability limit to display in the statistical eye diagram, click the Display Limit pull-down 
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menu. If the probability of the signal appearing is lower than the display limit, it will be ignored and set 

to zero in the statistical eye diagrams. 

To switch on the jitter injection for the next simulation after completing the jitter settings, click the 

Enable checkbox in the jitter setting interface. When the jitter injection function is switched on, the 

statistical eye diagram mode is enabled at the same time, the input bit pattern type is switched to 

Statistical. 

To switch to the statistical eye diagram mode in manual, select the option Statistical in the Type pull-

down menu in the Stimulus box. In the statistical mode, the input bit pattern is set to PRBS with a 

fixed length, so the statistical eye diagrams might be slightly different in several simulations of the 

same settings. The probabilities are represented by colors in the statistical eye diagrams: Warm colors 

indicate a large probability, red represents the largest ones; cold colors indicate a small probability, 

with deep blue representing the smallest values. 

8.9 TDR Advanced Waveform Function 

The Advanced waveform function is applied in both modules of the TDR option, TDR/ TDT analysis, 

and eye diagram simulation, which includes viewpoint setting, emphasis/ de-emphasis, de-

embedding, and Continuous Time Linear Equalization (CTLE). 

The corresponding settings in the Advanced Waveform dialog, which can be opened by clicking the 

buttons in the Adv Waveform bar of the Setup tab or the Advanced Waveform button in the 

Stimulus box of the Eye/Mask tab. 

To switch the dialog to the interface for setting the specified function, click the corresponding button 

at the top of the dialog. 

8.9.1 View point 

To switch the viewpoint of the waveform to stimulus or responses, click the corresponding View ratio 

button at the top of the dialog. The function is available in transmission parameters measurement and 

eye diagram simulations. 

Click the ratio button before the DUT icon, switch the viewpoint to stimulus, and the trigger mode is 

set to Hold /Stop, the transmission parameters show the stimulus signal only processed by emphasis 

/de-emphasis, which is the signal transmitted to the DUT. Setting the trigger mode to Continuous 

/Run, the viewpoint will be set to responses automatically. 

Click the ratio button after the DUT icon, switch the viewpoint to responses, and set the trigger mode 

to Continuous /Run. The transmission parameters show the responses processed by emphasis /de-

emphasis, DUT, and equalization. 
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8.9.2 Emphasis/De-emphasis 

Because of the lowpass characteristics of transmission systems, the high-frequency components in 

the signal have higher losses than those at lower frequencies and the phenomenon becomes more 

serious as the transmission distance increases. The phenomenon is the main contributor to signal 

distortion during transmission. To control this distortion, the emphasis /de-emphasis technology is 

introduced to compensate for these additional losses by increasing the relative levels before the 

transmission. Transition edges in the time domain represent high-frequency components in the 

frequency domain. Emphasis /De-emphasis technology is designed to increase the level variation of 

the edges by adjusting the levels of the bits close to the edges. The parameters to adjust the levels 

of the first bit before or after the edges, and those for the two bits after the edges, are provided in the 

TDR option and are defined as Pre Cursor, Post 1 Cursor, Post 2 Cursor. By changing these 

parameters, it's easy to simulate the influence of the different emphasis/de-emphasis strategies on 

the transmission performance in eye diagram simulations. 

 

Figure 8-16 Emphasis setting 

 

To change the parameters, set the value in the textbox in the Emphasis interface, and click the 

Enable checkbox to enable the function. The function is available in transmission parameters 

measurement and eye diagram simulations. 

 

8.9.3 De-embedding 

The TDR option provides a port de embedding function, which is the same as the port de embedding 

function in the fixture measurement function. 

By clicking the Enable button on the left side of the De embedding tab, the TDR option port de 

embedding function main switch can be turned on/off. 
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Figure 8-17 TDR De-embedding Settings 

 

Then, select the port to be de embedded through the port in the image or the radio box on the right, 

click the Load button to load the SNP file that records the embedded network characteristics, and 

click the Enable checkbox on the right to enable the de embedding function on the selected port. 

8.9.4 Equalization 

To control the signal distortion resulting from the additional loss of high-frequency signal components, 

equalization technology is introduced to amplify the high-frequency parts properly after receiving the 

signal to balance the loss over various frequency spans. A high pass filter and a continuous-time 

linear equalizer (CTLE) can be implemented. The CTLE simulation function in the TDR option allows 

the user to adjust the system function of the equalizer, to simulate the influence of the equalization on 

the transmission performance in eye diagram simulations. 

 

Figure 8-18 Equalization setting 

 

The equalizer system function provided by the TDR option is as follows ; By adjusting the DC gain 

and zero pole position, the system function of the equalizer can be modified to simulate and evaluate 

different linear equalization strategies. 

H(s) =
K(s + ωz)

(s + ωp1)(s + ωp2)
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The TDR option also provides a solution to describe the characteristics of the equalizer using the 

frequency response recorded in the CSV file: The TDR option simulates the equalizer using the 

frequency response recorded in the CSV file, The response value of the equalizer at the scanning 

frequency is obtained using amplitude phase linear interpolation method (when it exceeds the 

frequency range recorded in the file, the response value at the minimum frequency is taken when it 

is less than the minimum frequency, and the response value at two frequencies from low to high is 

taken when it is greater than the maximum frequency). The file format can refer to the following 

examples: 

!SIGLENT Technologies 

!VNA TDR-option Equalization File 

# Hz dB 

1000000000,-1.53E+01,-3.27E-01 

2000000000,-1.52E+01,-7.34E+01 

3000000000,-1.03E+01,-8.63E+01 

4000000000,-9.88E+00,-1.00E+02 

 

Notes: 

1. The data format is indicated by the line starting with "#" (the data format is not case sensitive), 

with the first data in each line being the frequency, and the last two data representing the 

response value (complex) of the equalizer at that frequency. If the second data of the response 

value is omitted, the default value is zero. Support the following data formats to express 

frequency response. If the format description is omitted, the default is MA: 

DB: The previous data represents the frequency response amplitude in logarithmic form, while 

the latter data represents the phase of the response in angular format. 

MA: The previous data represents the amplitude of the frequency response, while the latter data 

represents the phase of the response (angle based). 

RI: The previous data represents the real part of the response value, while the latter data 

represents the imaginary part of the response value. 

2. The comment should start with '!' and ignore the comment content when reading. 

3. The frequency is required to be arranged in ascending order. If the frequency of a row is lower 

than the previous row, the data in that row will be ignored. 

4. The frequency response recorded in the file should include at least 2 frequency points, but not 

more than 10000 frequency points. 
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Set the relevant parameters through the fine-tuning box in the Equalization tab, or load a CSV file, 

select the radio box in the Type box on the left to describe the characteristics of the simulation 

equalizer, and select whether to enable the equalization function through the Enable check box on 

the left. This function is only effective for transmission parameter measurement and eye graph 

simulation. 

 

8.10 Hot TDR measurement 

8.10.1 Overview 

When conducting measurements, VNA usually assumes that the zero input response of the DUT is 

zero. That is to say, assuming that all signals received by the port receiver are triggered by test signals 

sent by the port transmitter to the DUT; The signal received by a receiver at a certain port should be 

equal to the sum of the signal vectors transmitted and reflected by the test signals sent by the 

transmitters at each port on the DUT to reach that port. According to the above assumption, VNA 

obtains the response generated by the test signal excitation at each port through measurement, and 

calculates the S parameter matrix of the DUT based on this. 

 

If the zero input response of the DUT is not zero, when using VNA measurement, the signal received 

by the port receiver is equal to the vector sum of the response caused by the test signal sent by VNA 

and the zero input response of the device. Based on this, calculating the S parameter may result in 

significant errors. Therefore, such interference may reduce the accuracy of VNA measurement and 

can be suppressed in some cases. 

 

If the zero input response amplitude of the DUT is small, the VNA power level can be appropriately 

increased without damaging the equipment and DUT, and the response amplitude caused by the VNA 

test signal can be increased, which can have a certain inhibitory effect on such interference. 

 

If the zero input response of DUT obeys some statistical law, and the mean value in the time domain 

is zero (such as obeying Normal distribution); the average function can be enabled and the average 

frequency can be appropriately increased to suppress the impact of such interference on the 

measurement by averaging the responses measured multiple times. 
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If it is necessary to use VNA to measure the device in operation, and the tested device sends a digital 

signal with a known data rate to the test port during operation; In this case, the zero input signal of 

the DUT is not zero, and using the above method may not achieve good interference suppression 

effect. In frequency domain measurement, as interference signals are generally concentrated on a 

few frequencies, the impact on the entire frequency domain measurement may not be severe; In the 

TDR option, due to the superposition of interference signals in the time domain and actual input 

responses, the time-domain measurement results will be severely distorted. 

 

Using the Hot TDR mode in the TDR option to measure such devices can suppress the impact of 

such interference on time-domain measurements. Due to the fact that VNA always scans several 

frequency points during frequency domain measurements to estimate the frequency characteristics 

of DUT within the testing frequency range; when the scanning frequency point coincides with the 

frequency of the interference signal, the test results at that frequency point will be affected by 

interference. In Hot TDR mode, VNA will search for scanning frequency settings to avoid interference 

signals based on their data rate, thereby eliminating the impact of interference signals on frequency 

domain measurement results. 

 

8.10.2 Usage Guidelines 

Before using the Hot TDR mode to measure equipment in operation, it is necessary to ensure that 

the test signal sent by VNA to the equipment does not cause equipment malfunction. Properly select 

the VNA power level to prevent excessive testing signal amplitude from damaging the tested 

equipment; Observe the changes in the reflected signal received by VNA during the process of 

reducing the power level. If there is a significant change in the reflected signal, the power level should 

be significantly lowered to prevent equipment failure. 

 

When conducting measurements, if it is found that there are peaks in the frequency domain 

measurement results with constantly changing amplitudes at some frequencies, the time domain 

measurement results will fluctuate severely; It can be determined that the device's own signal output 

causes serious interference to time-domain measurement, and Hot TDR can be used to eliminate it. 

 

On the right side of the Setup tab on the bottom toolbar of TDR, you can set the Hot TDR mode. 

Enter the data rate of the signal emitted by the device in the Data Rate fine-tuning box; if the data 

rate of the signal emitted by the device is unknown, an approximate value can be obtained using the 

cursor on the frequency measurement results. The data rate error should be less than ± 0.5% to 
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prevent failure in searching for scan frequencies that avoid interference. 

 

Then, click on the "Avoidance Spurious" button and click "Yes" in the pop-up dialog box; VNA will 

check whether the current scan is affected by interference and search for scan frequency settings to 

avoid interference signals after confirming interference. If no interference is detected with the current 

scanning frequency, it will prompt that the interference signal has not been detected and continue to 

use the current scanning frequency setting for measurement. If a suitable scanning frequency is not 

found, it will prompt that a suitable scanning setting has not been found; this may be due to incorrect 

input data rates or excessive frequency components of interference signals, making it difficult to 

completely eliminate them. If the search is successful, the TDR option will enable the Hot TDR mode 

and use the scan frequency found for measurement. When the Hot TDR mode is enabled, the Avoid 

Spurious button will change to the Close Hot TDR button, which is used to turn off the Hot TDR mode; 

A mark  will appear on the right side of the button indicating that the Hot TDR mode is enabled. 

 

After enabling the Hot TDR mode, due to changes in the original scanning frequency setting, 

recalibration may be necessary to obtain more accurate measurement results. In addition, after 

changing the DUT length or scanning frequency setting in Hot TDR mode, the original Hot TDR setting 

becomes invalid and may need to be reconfigured to eliminate the influence of interference signals. 

 

Figure 8-19 Hot TDR setting 
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9 Guide for the SA Option 

9.1 Overview 

Spectrum Analysis function is based on the VNA hardware, by adjusting the local oscillator signal and 

mirror suppression algorithm processing to obtain the signal spectrum, so as to achieve spectrum 

analysis function. 

9.2 User Interface 

 

 

A. Active Entry Shortcuts such as adding, deleting, tagging, and taking screenshots. 

B. Trace Status Indicate the main working state of state, the port of RF input, Attenuation mode, 

Average Type, Current Marker operation. 

C. Display the SA setting dialog box SA parameter reset, SA processing flow chart. 

D. SA Measurement items 

E. Indicate and control the main sweep parameters Such as starting frequency, bandwidth 

resolution/video resolution, and termination frequency. 
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F. Status Bar Display trigger mode 

 

9.3 Create a Spectrum Analysis Channel 

Press [Meas] > S-Params > Mode > SA. The SA channel selection dialog box will displayed after the 

SA measurement mode was selected. Select “Active Channel” (delete the existing measurement) or 

“New Channel” then click OK. A Spectrum Analysis measurement is displayed on the current channel 

or on a new channel and New Window. 

 

Figure 9-1 SA mode channel selection dialog box 

 

In the interface of the SA channel selection dialog box, the “show setup dialog” check box is selected 

by default. When user clicks “OK”, a SA Setup dialog box will be displayed that can set related 

parameters.  

 

If the show Setup Dialog check box is deselected, the SA Setup dialog box will not be displayed when 

the SA function is enabled. If the user wants to modify the SA parameters, there are two ways to enter 

the SA Setup dialog box. 
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● Press [Sweep] > Sweep > SA Setup… to recall the SA Setup dialog box. 

● Press [Power] > Power > SA Setup… to recall the SA Setup dialog box. 

 

9.4 Spectrum Analyzer Settings 

The SA Setup dialog box has three tabs: SA Tab, Source Tab and Advanced Tab. 

The SA Tab configures the SA frequency range, CF step, sweep points, RBW, VBW, Average type 

and RF Input .Receiver. 

The Source Tab is the configuration of signal parameters when uses the internal source for spectrum 

analysis. 

The Advanced Tab the configuration of relevant parameters related to signal processing. 

 

Figure 9-2 The SA Tab setting interface 

 

9.4.1 SA Tab Setting 

SA Tab Setting is mainly related to Spectrum analysis frequency setting. which can be set through the 

SA Setup dialog box or by pressing the [Freq] key on the front panel to enter the frequency setting 

menu, as the figure shown below. If the frequency is changed, the frequency sweep will restart. 
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Figure 9-3 [Freq] key to set SA frequency parameters 

 

The frequency range of a channel can be expressed by three parameters: Start Frequency, Center 

Frequency and Stop Frequency. If any of the parameters change, the others will be adjusted 

automatically in order to ensure the coupling relationship among them: 

𝑓𝑐𝑒𝑛𝑡𝑒𝑟 = (𝑓𝑠𝑡𝑎𝑟𝑡 + 𝑓𝑠𝑡𝑜𝑝)/2, 𝑓𝑠𝑝𝑎𝑛 =  𝑓𝑠𝑡𝑜𝑝 −  𝑓𝑠𝑡𝑎𝑟𝑡 

 

9.4.1.1  Start Frequencys 

Set the start frequency of the Spectrum Analyzer. The start frequency and the stop frequency will 

display at the bottom of the grid respectively. 

● The span and center frequency vary with the start frequency when the Span does not reach 

the minimum.  

 

9.4.1.2 Stop Frequency 

Set the stop frequency of the Spectrum Analyzer. The start frequency and the stop frequency will 

display at the bottom of the grid respectively. 
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● The span and center frequency vary with the stop frequency.  

 

9.4.1.3 Center Frequency 

Set the center frequency point of the current frequency channel and display the start frequency, aspect 

ratio, and end frequency at the bottom of the grid. Pay attention to the following points. 

● Modifying the center frequency will modify both the start frequency and stop frequency when 

the span is constant (except when the start frequency or stop frequency reaches the 

boundary). 

 

9.4.1.4 Span 

Set the span of the Spectrum Analyzer. Any changes of the span will restart the sweep. 

Pay attention to the following points when set the span: 

● The start and stop frequency vary with the span when the center frequency is constant. 

● The span can be set down to 100 Hz and up to the maximum bandwidth. 

● Variation in the Span, RBW or VBW would cause a change in the sweep time. 

 

9.4.1.5  CF Step Size 

Setting the value of CF step will change the direction key step of center frequency, start frequency, 

stop frequency and frequency offset. 

When Auto mode is selected, the Center frequency step Size is 5% of the current span. That is, 

𝑓𝐶𝐹 𝑆𝑡𝑒𝑝 =   𝑓𝑆𝑝𝑎𝑛 ∗ 5%. Each press of the ▲|▼ arrows on the front panel or click the up and down 

sign of the SA Setup’s center box. The center frequency 𝑓𝐶𝐹 𝑆𝑡𝑒𝑝 increases or decreases by the CF 

step size. 

When Manual mode is selected, Users can customize the size of CF Step. Each press of the ▲|▼ 

arrows on the front panel or click the up and down sign of the SA Setup’s center box. The center 

frequency 𝑓𝐶𝐹 𝑆𝑡𝑒𝑝 increases or decreases by the CF step size. 

 

9.4.1.6 Num of Points 

The number of sweep points represents the number of sweep and trace displayed points (2~20001) 

More sweep points will improve the resolution of waveform, but also affect the minimum sweep time, 
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and increase the time of data processing and remote access to data, and reduce the response rate. 

 

9.4.2 SA Tab Processing setup 

The SA processing setup is to config the signal’s parameters. User can set the parameters via the SA 

Setup dialog, or by pressing [Avg BW] > BW to enter the spectrum analysis signal processing 

parameters setting menu, as the shown figure below. 

 

 

Figure 9-4 Spectrum analysis signal processing setup menu 

 

9.4.2.1 RBW 

Set the RBW (resolution bandwidth) in order to distinguish between signals which have frequency 

components that are near one another. 

● Reducing the RBW will increase the frequency resolution. But lead to a longer sweep time 

(influenced by both RBW and VBW when the sweep time is in automatic mode). 

● RBW varies with the Span/RBW setting in Auto RBW mode. 

 



SHN900A User Manual 

198                                                                               www.siglent.com 

9.4.2.2 VBW 

Set the video bandwidth in order to filter out the noise outside the video band.  

● Reducing the VBW will smooth the trace and helps to highlight small signals from noise, but it 

will also increase the sweep time (Sweep Time is affected by a combination of RBW and VBW 

when it is in Auto mode). 

● VBW varies with RBW when it is in Auto mode. While in Manual mode, VBW is not affected by 

RBW. 

 

9.4.2.3 Averaging Type 

Average type refers to the processing mode of intermediate frequency data in data detection and 

display detection, which affects the effect of trace average and detection average. 

Power

（V^2）

RBW Voltage

LogPower

Detect

Avg Type

VBW Trace
 

Figure 9-5 Flow chart of Average type 

 

1. Log Power 

Select the logarithmic (decibel) scale for all filtering and averaging processes. This scale is “Video” 

because it is the most common display and analysis scale for the video signal within analyzer. 

This scale is excellent for finding Sine/CW signals near noise. 

2. Power Average 

In this average type, all filtering and averaging processes work on the power (the square of the 

magnitude) of the signal, instead of its log or envelope voltage. This scale is best for real-time 

power measurement of complex signals. 

3. Voltage Average 

In this Average type, all filtering and averaging processes work on the voltage of the envelope of 

the signal. This scale is suitable for observing rise and fall behavior of AM or pulse-modulated 

signals such as radar and TDMA transmitters. 
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9.4.2.4 RF Input Receiver 

Select the receiver port for RF signal input. 

 

9.4.3 Source Tab 

The Source Tab of SA Setup is the configuration for internal sources as signal sources. 

 

Figure 9-6 Source Tab 

 

Port Powers Coupled (checked) the power levels are the same at each test port. Set power at any 

test port and all test ports change to the same power level. 

 

SA Source Setup 
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Figure 9-7 SA Source Setup 

 

● State: If the “On” parameter is selected, the port source power is enable 

● Type(Sweep): 

1) CW: The source is set to a CW frequency. 

2) Linear Freq: The source is set to a power sweep. 

3) Power: The source is set to a power sweep. 

4) LinFreq+Power: The source is set to sweep from the Start to Stop frequency and power 

sweep. 

● Frequency: Set the sweep Frequency of the source. 

● Power: Set the power level of the source. 

 

When the internal source is used for the Spectrum analysis signal sources, the sweep type, source 

frequency and the port power level of the source can also be set by pressing the [Power] key on the 

front panel to enter the port power setting menu. As the figure shown below: 
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Figure 9-8 Press the [Power] key to enter the source’s setting menu 

 

9.4.4 Advanced Tab 

The Advanced Tab is the configuration of parameters related to signal processing for Spectrum 

analysis. Which can be set through the SA Setup dialog box or by pressing the [AvgBW]>BW on the 

front panel to enter the setting menu, as the figure shown below. 
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Figure 9-9 Advanced Tab setting menu 

 

9.4.4.1 RBW/VBW 

Sets the ratio of Resolution Bandwidth to Video Bandwidth when the Video Bandwidth is in Auto mode. 

 

9.4.4.2 Span/RBW 

Sets the ratio of Span to Resolution Bandwidth when the Resolution Bandwidth is in Auto mode. 

 

9.4.4.3 Image Reject 

The signal is mixed with the local oscillator to get an intermediate frequency signal, and the mixer 

may produce a mirrored frequency signal. Therefore, it is necessary to change the local oscillator or 

intermediate frequency to collect multiple groups of spectral data, and filter out the image through the 

image suppression algorithm. 

None: Selects 1 acquisitions, and mirror suppression is not performed. 

Min: Selects 3 acquisitions. 

Normal: Selects 4 acquisitions. 

Better: Selects 5 acquisitions. 

Max: Selects 6 acquisitions. 
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Note: Only 3 sets of data can be acquisitions at most when the frequency point is below 40MHz. 

 

9.4.4.4 Attenuation mode  

Set the maximum power or voltage that can be currently displayed in the trace window. The value is 

displayed at the upper left corner of the screen grid. 

The reference level is an important parameter of the spectrum analyzer, which indicates the upper 

limit of the current dynamic range of the spectrum analyzer. When the energy of the signal to be 

measured exceeds the reference level, nonlinear distortion or even overload alarm may be generated. 

The user should understand the nature of the signal to be measured and choose the reference level 

carefully. The reference level is too large to ensure full utilization of the linear range of the ADC, nor 

too small to be higher than the noise of the ADC. By setting a suitable reference level, the best 

measurement results can be obtained while protecting the spectrometer. 

According to the amplitude of the input signal, the user can set the RF front-end attenuation mode of 

the response, which is to avoid the display distortion when the input signal is large and reduce the 

noise when the input signal is small. 

Input attenuation can be set up to Auto, Low Noise and Standard mode 

● Auto: the attenuation value is automatically adjusted according to the state of preamplifier 

and the current reference level. 

● Low noise: The minimum attenuation mode, the average noise level is lower. 

● Standard: The maximum attenuation mode, the average noise level is higher. 

 

9.4.5 Trace setup  

Click the trace status area on the upper left corner of the interface, and the trace setting drop-down 

menu will pop up for trace setting operations. 
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Figure 9-10 The trace Settings drop-down menu 

 

9.4.5.1 Select Trace 

Before operating on the Trace, the user needs to specify and only specify one trace at a time. The 

number of the selected trace will appear as selected in the status bar (with a highlighted border). 

 

9.4.5.2 Trace Type 

There are four trace types: Clear/write, Max Hold, Min Hold, Average. Different trace types represent 

different processing methods of the trace data of a new frame on the historical frame data: 

● Clear/write Erases any data previously stored in the selected trace, and display the data 

sampled in real-time of each point on the trace. The type identifier is “W”. 

● Max Hold Retain the maximum level for each point of the selected trace. Update the data if 

a new maximum level is detected in successive sweeps. Max Hold is very effective when 

measuring events that may take successive scans to measure accurately. Some common 

applications include FM Deviation, AM NRSC, and frequency hopping or drift. The type 

identifier is “M”. 

● Min Hold Display the minimum value from multiple sweeps for each point of the trace and 
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update the data if a new minimum is generated in successive sweeps. The type identifier is 

“m”. 

● Average Set the averages times of the selected trace. The type identifier is “A”. The data 

format it participates in the calculation is consistent with the parameter configuration average 

type (see section 9.4.2.3 Averaging Type), and the specific average calculation is as follows: 

𝑑𝑎𝑡𝑎 =
𝑑𝑛𝑒𝑤

𝑛
+

𝑑𝑜𝑙𝑑 ∗ (𝑛 − 1)

𝑛
 

 

1 ≤ 𝑛 ≤ 𝑁 

 

Among them, N is the average | Hold Times set by the user (Avg | Hold Times), and n is the scan 

counter, which is the nth frame after restarting the scan. This counter will dynamically refresh the 

display in the status bar. When the counter exceeds N, take n=N to participate in the calculation. 

 

The operations of trace types are all based on "frames", and new data and historical frame data are 

processed point by point. Therefore, modifying parameters such as trace operation type, RF channel 

correlation, detection, etc. will result in re measurement (scanning), and naturally, the trace needs to 

be re calculated. 

 

9.4.5.3 Trace State 

There are four trace states: active, view, blank, and background. Different trace states indicate the 

refresh and display states of traces: 

● Active: Refreshed and displayed trace data. 

● View: The trace data will not be refreshed, and the current latest trace will be displayed in a 

fixed frame. 

● Background: Refreshed trace data but no display. 

● Blank: Trace data is no longer refreshed or displayed 

Modifying the trace state so that the trace does not refresh will immediately stop the refresh state of 

the current frame of data. Modify the trace status to refresh the trace and restart measurement and 

scanning. 
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9.4.5.4 Detector 

The detector is the data source of the trace, and this series of analyzers all use digital detectors. For 

each trace point on the trace, the analyzer captures all data within a specific time interval, which is 

processed by the set detector, and then reported to the trace operation module for operation. 

 

Detection represents the process of obtaining trace points from multiple sampling points within a 

certain time interval, and different detection types represent different methods of obtaining trace points: 

● Positive Peak: Use to capture the maximum value at the sampling point during the time 

period. 

● Negative Peak: Use to capture the minimum value at the sampling point during the time 

period. 

● Sample: For each point on the trace, the sampling detector displays the transient energy 

corresponding to a fixed time point (usually the first sampling point within this time period) 

within the corresponding time interval. Sampling detection cannot ensure accurate detection 

of the signal, and there may be some amplitude deviation. 

● Average: The method of averaging all sampling points using capture time depends on the 

average type (see section 9.4.2.3 Averaging Type). 

● Normal: Also known as normal detection or rosenfell detection. Using conventional 

detection traces, the trace data is paired in pairs, with odd points displaying the maximum 

value at the sampling points and even points displaying the minimum value at the sampling 

points. This can intuitively reflect the amplitude range of the signal (background noise), but 

due to implementation reasons, there may also be a certain signal frequency deviation. 

 

In practical implementation, conventional detection belongs to secondary detection, which uses two 

adjacent pairs (a group) of positive and negative peaks for comparison. If the actual signal appears 

at an even point position, in order to achieve the display effect of "odd point displays the maximum 

value in the sampling point, and even point displays the minimum value in the sampling point", the 

order of the data in that group will be reversed, resulting in frequency deviation. 

User can manually select an appropriate detection type based on actual requirements and application 

scenarios to ensure measurement accuracy, or set the detection type to automatic. 
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9.5 Spectrum Analysis measurement 

9.5.1 Marker → SA 

During S parameter measurement, If the user wants to have a quick view of the specific frequency 

point’s spectrum, spectrum analysis can be opened by means of Marker → SA. That is to create a 

new SA channel in full frequency span based on the S parameters, and a marker is created on the 

trace at the same frequency as the S parameter channel marker. 

The same receiver that is used for the S parameter channel is used for the SA channel. For example, 

if a marker is opened in the S11 channel, a SA measurement is created using the receiver “A” of port 

1 after “Marker → SA”. 

 

How to open Marker → SA: 

1. Make an S parameter measurement, such as S22,set the center frequency as 1GHz and Span 

as 50MHz. and mark the S22 trace by pressing the [Marker] key on the front panel; 

2. Press [Marker] > Marker Function > Marker → SA to enable the SA function. You can view the 

frequency spectrum of 1GHz point of the S22, as figure shown below: 

 

Figure 9-11 Marker → SA 
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Press [Sweep] > Sweep > SA Setup… can recall the SA Setup dialog box If the user needs to modify 

the SA parameter settings. 

 

9.5.2 Channel Power 

Measure the power and power density within the specified channel bandwidth. When this function is 

enable, the span and resolution bandwidth are automatically adjusted to smaller values. Select 

“Channel Power” and click “Meas Setup” to set the corresponding parameters. The two vertical lines 

on the trace perpendicular to the X-axis represent the integration bandwidth. The Y-axis value is set 

to the measured power value, and displays on the upper right corner. 

 

Figure 9-12 Channel Power measure 

 

9.5.2.1 Integration BW 

Set the frequency width of the channel to be tested and the power of the channel is the power integral 

within this bandwidth. You can use the numeric keys, knob or direction keys to modify this parameter. 
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9.5.2.2 Info Table 

When the information table is “On”, click other menu options and the measurement result table will 

not be closed. When the status of the information table is “Off”, the measurement result information 

table will be closed 

Channel power measurement results include: Channel power and power spectral density. 

The measurement of the specified channel power is centered on the central frequency point of the 

channel, and the frequency Span of the test channel is adjusted. The channel power is the integral of 

this frequency span, and the bandwidth of the specified channel is called the integral bandwidth. The 

value of the integral bandwidth is related to Span but ≤ Span. 

● Channel Power: Power within the integration bandwidth. 

𝑐ℎ𝑃𝑜𝑤 =  ∑ (
𝑤𝑎𝑡𝑡

𝑟𝑏𝑤
) ∗ (𝑖𝑡𝑔𝐵𝑊/(𝑠𝑡𝑜𝑝 − 𝑠𝑡𝑎𝑟𝑡))

𝑠𝑡𝑜𝑝

𝑠𝑡𝑎𝑟𝑡

 

chPow: Channel power, in watts 

start, stop: The start and stop frequency of channel. 

watt: Absolute power converted from sweep point data, in watts 

rbw: resolution bandwidth 

itgBW: integration bandwidth. 

● Power Spectral Density: Power (in dBm/Hz) normalized to 1Hz within the integration bandwidth 

nspd = chPow/itgBW 

nspd: Power Spectral Density 

itgBW: Integration bandwidth. 

 

9.5.3 ACPR 

Measure the power value of the main channel, the power values of the adjacent two channels before 

and after, and the power difference between them and the main channel. At this time, the scanning 

width and resolution bandwidth of the Spectrum analyzer will be automatically adjusted to a smaller 

value. Given the main channel and one adjacent channel on each side, the main channel is centered 

around the central frequency point, and the left and right adjacent channels are symmetrical relative 

to the main channel. Change channel parameters by setting the main channel bandwidth, adjacent 

channel bandwidth, and adjacent channel spacing (distance between adjacent channels and the 

center point of the main channel). Calculate the power of each channel using the same method as 

the channel power algorithm. The ratio of adjacent channel power to main channel power is the 
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adjacent channel power ratio. 

 

Figure 9-13 ACPR measurement 

 

9.5.3.1 Main Channel 

Set the bandwidth of the main channel, and its power is integrated within this bandwidth. 

 

9.5.3.2 Adjacent Chn 

Set the bandwidth of adjacent channels. 

 

9.5.3.3 Adj Chn Space 

The center frequency spacing between the main channel and adjacent channels. 

Adjusting the distance between adjacent channels will simultaneously adjust the distance between 

the previous and subsequent channels and the main channel. 
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9.5.3.4 Info Table 

When the information table is “On”, click other menu options and the measurement result table will 

not be closed. When the status of the information table is “Off”, the measurement result information 

table will be closed. 

ACPR measurement results include: Main CH Power, Left channel power and Right channel power. 

● Main CH Power: Displays the power within the bandwidth of the main power 

● Left channel power : Displays the power of left channel and the power difference between 

the left channel and the main channel (in dBc) 

● Right channel power: Display the power of the right channel and the power difference 

between the right channel and the main channel(in dBc) 

 

9.5.4 Occupied BW 

Integrate and calculate the power within the entire sweep width, and then calculate the bandwidth 

occupied by this proportional power based on the set power scaling factor. The measurement result 

also gives the difference between the center frequency of the channel and the center frequency of 

the Spectrum analyzer. After selecting the measurement type as "Occupied BW", click "Meas Setup" 

to set the relevant parameters. Two vertical lines perpendicular to the X-axis represent the occupied 

span of the power percentage. The value of the Y-axis is the power value that occupies the bandwidth. 

The bandwidth and power of the span will be displayed in the upper right corner. 
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Figure 9-14 Occupied BW measurement 

 

9.5.4.1 Occ BW Percent 

Specifies the percentage of total power measured within occupied bandwidth for the current 

measurement. 

 

9.5.4.2 Info Table 

When the information table is “On”, click other menu options and the measurement result table will 

not be closed. When the status of the information table is “Off”, the measurement result information 

table will be closed. 

● Occupied Bandwidth: Integrates the power within the whole span and then calculates the 

bandwidth occupied by the power according to the specified power ratio. 

● Power: the power according to the specified power ratio. 

● Total Power: the whole span power. 

● Transmit Freq Error: The difference between the center frequency of the channel and the 

center frequency of the analyzer. 
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● Percent: Power ratio. 
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10 The Frequency Offset Measurement 

10.1 Overview 

Usually, when using a network analyzer, the frequency of the signal source must be the same as the 

frequency of the receiver, so it is not possible to measure nonlinear devices. To enable the network 

analyzer to measure variable frequency devices, it is necessary to operate the RF signal source and 

receiver inside VNA at the input and output frequencies of the variable frequency devices. SHN900A 

not only supports frequency offset scanning, but also provides mixer calibration function: scalar mixer 

calibration. Calibration of scalar mixers can improve the amplitude of mixer frequency conversion loss 

and the measurement accuracy of reflection parameters. 

In addition, SHN900A also supports absolute measurement function. Usually, a network analyzer will 

measure the ratio of the amplitude and phase of the test signal to the reference signal. On the contrary, 

the absolute measurement function measures the absolute value of the test signal amplitude. 

Combined with the frequency offset function, the absolute measurement function provides 

measurements including harmonic distortion measurement. When combined with power calibration 

and receiver calibration functions, the measurement accuracy is further improved. 

 

10.2 Frequency Offset Mode 

Frequency Offset Mode (FOM) enables the SNA internal RF signal source and SNA port receiver to 

operate at different frequencies. To realize the measurement of nonlinear characteristics of the device. 

 

10.2.1 Frequency Offset settings 

Press [Freq] > Freq Offset…to enter the frequency offset function setting dialog box. 



SHN900A User Manual 

www.siglent.com                                                                                215 

 

 

A. Frequency Offset (ON/OFF) Enables Frequency Offset Mode on ALL measurements that are 

present in the active channel. When frequency offset function is not enabled, all frequencies are 

the same as the Primary frequency. 

B. Sources and Receivers 

● Primary The current Active Channel settings. When a Source or Receiver is coupled to the 

Primary settings, its Sweep Type is the same as that of the Primary. The frequency settings 

of the coupled range are mathematically derived from the Primary settings using the 

Multiplier, Divisor and offset values. With this approach, only the Primary settings need to be 

changed in order to affect change in the coupled Sources and Receivers. Changes to the 

Primary channel settings occur when Frequency Offset is checked ON. 

Primary settings are only used when Sources and Receivers are Coupled. It is often easier 

to Uncouple, then set Sources and Receivers independently. 

● Source The internal source signal of the VNA. 

● Receivers All receivers that are used in the channel, including Reference receivers, are 

tuned to the specified frequency settings. 

C. Mode 

● Coupled Source and Receiver settings are mathematically derived from the Primary settings 

using Multiplier, Divisor, and Offset values. 

● Uncoupled Source and Receiver settings are entered independently, without reference to 

Primary settings. When Uncoupled, Source and Receiver Ranges can use separate sweep 
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types. 

D. Sweep Type Click to change the type of sweep for each range. Only available for Primary and 

Uncoupled Sources and Receivers. 

E. Settings To change settings, click IN the appropriate Settings cell, then will pop up the 

corresponding settings dialog box that can be edited. If coupled, invokes the Coupled dialog. If 

uncoupled or Primary invokes the Uncoupled settings dialog. 

F. X-Axis Annotation Select the settings to be displayed on the X-Axis. 

G. X-Axis Point Spacing Only available when a Segment Sweep Type is selected as the X-Axis 

display. 

 

Coupled settings dialog box 

 

 

A. Multiplier Specifies (along with the divisor) the value to multiply by the stimulus. The value is an 

integer from -100 to 100. 

B. Divisor Specifies (along with the multiplier) the value to multiply the stimulus. The value is an 

integer from -100 to100. 

C. Offset Specify the absolute offset frequency (Hz). For the mixer, this will be the LO frequency. 
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The range is [-5000GHz, 5000GHz]. 

D. Start Freq = [Primary Start x (Multiplier / Divisor)] + Offset 

E. Stop Freq = [Primary Stop x (Multiplier / Divisor)] + Offset 

 

Primary and Uncoupled settings dialog box 

 

 

A. Sweep Type The settings dialog box is vary depending on the sweep type. 

B. Frequency Type Select Start/Stop or Center/span. 

C. Start Freq Enter values. 

D. Stop Freq Enter values. 

E. Sweep Point (Primary only) Enter number of data points for the sweep. 

 

When sweep type is Segment Sweep, the segment table edits are made exactly like the standard 

segment table. In segment sweep mode: 

● The OK button is NOT available until the total number of data points for all segments matches 

the number of Primary data points. 
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● Independent IF Bandwidth and Independent Sweep Time are available ONLY on the Primary 

(channel) and the Uncoupled Receivers - NOT Sources. 

● Independent Power is available ONLY on the Primary (channel) and the Uncoupled Sources - 

NOT Receivers. 

 

11 Cable and Antenna Mode 

11.1 Overview 

Cable and Antenna measurement is usually used to verify and diagnose the electrical performance 

of RF and microwave transmission systems and antennas. In radio frequency and microwave 

communication industry, coaxial cable is generally used to establish the connection between 

transmitter and antenna and/or antenna and receiver, and to measure it. This process is sometimes 

called line scanning, and signal attenuation and return loss are related to frequency. Line scanning 

combines the distance measurement of fault points in most RF and microwave signal analyzers, and 

can estimate the location of fault or damage in transmission lines. Transmission line performance 

testing is not limited to coaxial cables. As long as an appropriate adapter is installed between the 

transmission line and the coaxial interface of the analyzer, the performance of the system using 

waveguide and twisted pair cable can also be characterized. In addition, antenna measurement (in 

the form of signal reflection or return loss and VSWR) can be used to verify the antenna performance 

in the installation site. 

 

11.2 Create a CAT Channel 

Press Meas > Mode > CAT/TDR. The CAT/TDR channel selection dialog box will displayed after the 

CAT/TDR measurement mode was selected. Select “Active Channel” (delete the existing 

measurement) or “New Channel” then click OK. A CAT measurement is displayed on the current 

channel or on a new channel and New Window. 

 

11.3 Freq/Dist 

Click Freq/Dist to open the Freq/Dist setting interface, and set the frequency or distance range of the 

current measurement. Distance range can only be set in DTF/TDR. 
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Set the appropriate RF frequency to observe the correct corresponding trace of the DUT(cable, 

antenna, etc.). 

 

Figure 11-1 Freq/Dist setting interface 

 

Start：Specify the starting frequency of the swept measurement range 

Stop：Specify the end frequency of the swept measurement range 

The starting frequency automatically satisfies the formula:  

Stop Freq= Start Freq * Number of points 

 

Start Distance: Specify the start distance of the measurement result to be displayed. The default is 

0 m, which means it will display the trouble points from the calibration plane , and the distance cannot 

be set to a negative value. 

Stop Distance: Specify the stop distance of the measurement result to be displayed. It can not be 

set above max meas distance. The frequency range settings will affect the max meas distance, Refer 

to 11.4.1.2 Max Measurement Distance for details. 
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Unit: The default distance unit is Meter(m), it can be changed to Feet(ft) or Inches(in). 

Number of Points: Sweep Points are the number of data samples representing the measured values 

in a single sweep. 

 

11.4 Meas Settings 

CAT mode provides multiple measurements for different measurement scenarios. 

 

11.4.1 Distance to Fault Measurement 

DTF measurement can be used to locate discontinuous and periodic cable faults. DTF adopts 

reflection measurement method and calculates the amplitude response of any breakpoint (which is 

directly related to the distance). Using DTF to measure is similar to using vector network analyzer to 

measure in time domain, but DTF measures breakpoint distance instead of time delay. 

 

In order to carry out the correct DTF measurement, the wire/ connector/ jumper is required to connect 

the cable to the instrument. Besides, the cable length, working frequency range, and the attenuation 

and velocity factor should be acknowledged in advance. 

 

DTF measurement settings: 

In CAT measurement mode, click Meas > Distance to Fault to open the DTF setting interface and 

select DTF measurement. 
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Figure 11-2 DTF measurement interface 

 

Measurement steps: 

1. Connect any necessary jumper cable or adapter to the SHN900A Port. 

2. Press Freq / Dist in the menu to set the frequency range approrately and set the stop 

distance of the cable. 

3. Press Cal and and follow the Cal prompts to perform calibration. 

4. Connect a LOAD at the end of the DUT if possible and then connect the start end of the 

DUT to the SHN900A. 

5. Press Meas to set the Velocity Factor and Cable Att of the DUT. 

Note: A LOAD at the end of the DUT can reduce the repeated reflection inside the DUT. 

 

11.4.1.1 DTF Format 

In CAT measurement mode, click Format to open the data format setting interface and select the data 

format. 

 

DTF measurement supports three data formats: 

● Log Mag: Faults are displayed on the Y-axis in return loss format. expressed in unit dB. 

● Lin Mag: Faults are displayed on the Y-axis in linear(unitless)format. 
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● VSWR: Faults are displayed on the Y-axis in SWR. 

 

11.4.1.2 Max Measurement Distance 

The calculation of the Max distance is as follows: 

Max Meas distance = (Sweep Points*Velocity Factor*Speed of Light) / 2* Freq Span 

Note: According to the formula, It can be acknowledged that the resolution is only frequency 

related. That means higher frequency span leads to higher resolution. 

 

When fault location measurement is carried out, the physical length, operating frequency range and 

speed factor of cable transmission of the cable or equipment to be measured should be known in 

advance. For a long cable test, it is necessary to reduce the frequency range of measurement. 

 

11.4.1.3 Velocity Factor 

Velocity Factor is a the ratio of the velocity of the electric signal in the cabl to that in the vacuum. For 

example, A polyethylene dielectric cable has VF =0.66 and a cable with PTFE dielectric has VF =0.7. 

In the DTF measurement it is used to calculate the distances by the reflection time. In order to get 

accurate positons of the impedance discontinuities, Velocity Factor should be considered and clarified.  

 

Velocity Factor settings: 

Click Meas > Meas Setup> Velocity Factor to open the velocity factor setting interface and set the 

velocity factor. 

 

11.4.1.4 Cable Loss 

Cable Loss is specified in dB/meter. In addition to the length of the cable, loss is also directly 

proportional to the frequency of the signal that passes through the cable. 

For example, The DUT is a 100 meter transmission cable. The Cable Loss value is 0.1dB/meter. That 

means that a signal traveling one way through the cable will lose 10 dB of power. Considering DTF 

measurement is perfomed with 1 port, the signal traveled down the cable and then back, for a total 

loss of 20 dB. 

 

Cable Loss settings: 
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Click Meas > Distance to Fault > DTF [Port1]/ DTF [Port2] > Meas Setup > Cable Att to open the 

cable loss setting interface and set the cable loss. 

 

11.4.1.5 Stimulus Type 

Click Meas > Distance to Faul > DTF[Port1]/DTF[Port2] > Meas Setup > Stimulus Type to open 

the interface for setting the stimulus type. 

 

Stimulus Type supported by DTF measurement: 

● Low pass impulse:  

High resolution, suitable for viewing the small response of the device propagating low-frequency 

signal. In this low pass impulse mode, the frequency expands to DC and negative frequency.  

● Low pass step:  

The simplest way to determine the discontinuities caused by inductors and capacitors in 

equipment that propagate low frequency signals.  

● Bandpass:  

The simplest method, which can be used with any frequency sweep, it is most useful when 

measuring devices with limited bandwidth. Capacitance and inductance reactance will not be 

shown. For the same frequency range and number of points, the bandwidth of bandpass mode 

is twice that of impulse mode, which will hide the closely spaced response and reduce the 

response resolution.  

 

11.4.1.6 Window 

Due to the limitations of instrument, the measured data is restricted to the frequency range rather 

than an infinite range. That means the frequency domain data is truncated at the start/end of the data 

sample, which will cause overshooting and ringing in the time domain. 

Therefore, the window should be applied to gradually reduce the marginal frequency response and 

control the side lobe formed by the truncation. 

 

Click Meas > Distance to Faul > DTF[Port1]/DTF[Port2] > Meas Setup > Kaiser Beta/DTF Window 

to open the window setting interface and set the window. 
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Window selection: 

When the stimulus type is low pass mode, the window type is Kaiser window.  

When the stimulus type is bandpass mode, the window type is DTF window, and the DTF window can 

be selected from closed, Hamming window and Kaiser window. 

● DTF window closed: No windowing function. 

● Kaiser window: 

The window size is set by setting Kaiser Beta parameters. The value of the window size needs 

to be balanced between the corresponding resolution and the dynamic range. The smallest 

window can get the best corresponding resolution, and the largest window can get the largest 

dynamic range. 

 

Figure 11-3 Kaiser Beta 

 

● Hamming window: The main lobe is widened, It is equivalent to widening the analysis 

bandwidth and decreasing the time domain resolution. 

 

11.4.2 Time Domain Reflection Measurement 

In time domain reflection measurement, the frequency domain data is converted to time domain data 

by inverse Fourier transform. The response values apprear separated in time, allowing a different 

perspective of the test device’s performance and limitations. The Time Domain response not only 

shows the location of the mismatch point, but also displays the characteristic of the impedance 

discontinuity. It helps quickly locate the fault point on the cable, and preliminarily identify the fault 

type.If there is multiple mismatchs in the cable. The measurement steps are the same with DTF. 
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TDR measurement settings: 

In CAT measurement mode, click Meas > TDR to open the TDR setting interface and select TDR 

measurement. 

 

Figure 11-4 

 

11.4.2.1 TDR Format 

In CAT measurement mode, click Format to open the data format setting interface and select the data 

format. 

 

Lin Mag: The Y-axis of the diplay is linear, real, unitless values. A trace without reflections shows as 

0 while maximum reflections from an open or short show as 1. 

Impedance: The Y-axis of the display is impedance (ohms). Accord to that reflectance under the step 

stimulus and base on the port impedance value Z0, the impedance value of each point in the signal 

transmission path is calculated. 

 

11.4.2.2 Velocity Factor 

Velocity Factor is a the ratio of the velocity of the electric signal in the cabl to that in the vacuum. For 

example, A polyethylene dielectric cable has VF =0.66 and a cable with PTFE dielectric has VF =0.7. 
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In the TDR measurement it is used to calculate the distances by the reflection time. In order to get 

accurate positons of the impedance discontinuities, Velocity Factor should be considered and clarified.  

 

Velocity Factor settings: 

Click Meas > Meas Setup> Velocity Factor to open the velocity factor setting interface and set the 

velocity factor. 

 

11.4.2.3 Cable Loss 

Cable Loss is specified in dB/meter. In addition to the length of the cable, loss is also directly 

proportional to the frequency of the signal that passes through the cable. 

For example, The DUT is a 100 meter transmission cable. The Cable Loss value is 0.1dB/meter. That 

means that a signal traveling one way through the cable will lose 10 dB of power. Considering DTF 

measurement is perfomed with 1 port, the signal traveled down the cable and then back, for a total 

loss of 20 dB. 

 

Cable Loss settings: 

Click Meas > TDR > TDR [Port1]/ TDR [Port2] > Meas Setup > Cable Att to open the cable loss 

setting interface and set the cable loss. 

 

11.4.2.4 Stimulus Type 

Click Meas > TDR > TDR [Port1]/ TDR [Port2]> Meas Setup > Stimulus Type to open the interface 

for setting the stimulus type. 

 

TDR time domain measurement only uses low-pass mode. In the measurement menu of TDR, you 

can change the stimulus type of time domain conversion of the current trace and switch the 

reflectance of the current trace between unit step response and unit impulse response. 

By setting the Kaiser Beta in window, it changes the rise time and impulse width of the stimulus signal. 

Essentially it realizes the suppression of truncation effect and the sidelobe level. Because TDR is 

based on the data in a limited frequency range, truncating the data at the end of the frequency domain 

will lead to sidelobes in the time domain transform results. Sidelobe level will be suppressed by 

applying window function, the larger the Kaiser beta is, the more obvious the suppression effect will 

be, but at the same time, it will increase the rise time of stimulus signal, thus reducing the resolution 
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of the time domain transformation result.  

 

11.4.2.5 Kaiser Beta 

Click Meas > TDR > TDR [Port1]/ TDR [Port2] > Meas Setup > Kaiser Beta to open the window 

setting interface and set the window. 

 

Like the Windowing in DTF measurement, Kaiser window is used in Time Domain Refelction to reduce 

overshooting and ringing during the inverse Fourier Transform. 

The window size is set by setting Kaiser Beta parameters. The value of the window size needs to be 

balanced between the corresponding resolution and the dynamic range. The smallest window can get 

the best corresponding resolution, and the largest window can get the largest dynamic range. 

 

11.4.2.6 Time Gating 

When viewing the Time Domain reponse of a device, the gating function allows manualy choose the 

required time-domain response and elimilate undesired time domain response, and then view the 

frequency  domain characteristic curve of the required reponse through Fourier transform, The 

gating function enables the DUT to be characterized without connectors or adapters. 

The response of the mask is determined by selecting the gating type of the time domain gating. The 

Notch option represents the response within the masked time-domain gating interval, and the 

BandPass option represents the response outside the masked time-domain gating interval. 

 

Operating Steps: 

Click Meas > TDR > TDR [Port1]/ TDR [Port2] > Meas Setup >Time Gating to enter the gating 

setting interface, and set the related menus. 

Gating on: Open or close the gating function. 

Gate Start: Set the start distance of the gate. 

Gate Stop: Set the stop distance of the gate. 

Gate Type: Set the type of filtering perfomed by the gating function. 

• Band Pass: Keep the response in the gating span. 

• Notch: Remove reponse using the gating span. 

Gate Shape: Set the filter characteristics of the gating function. There are four options: minimum, 
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normal, wide, and maximum. 

 

The parameters of gating function are defined as shown in the following figure: 

 

Figure 11-5 Gate Shape 

 

11.4.3 Insertion Loss Measurement 

Use 2-Port Insertion Loss measurement to measure the loss of DUT in a specific frequency range. 

On SHN900A, Ouput signal was transmitted from Port1/Source through cable to RF in/Port2. Both 

ends of the DUT must be connected to the SHN900A. 

Insertion loss refers to the loss of load power caused by the cable or components inserted between 

the transimitter and receiver, usually referred to as attenuation. The insertion loss is expressed in dB 

corresponding to the received signal level. This measurement is consistent with S21/S12 

measurement in VNA mode. 

A 2-port Insertion Loss measurement is usually more accurate than a 1-port Cable Loss measurement. 

 

Insertion Loss Operating Steps: 

In the CAT measurement mode, click Meas > Insertion Loss to open the Insertion Loss setting 

interface, and select the Insertion Loss measurement. 
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Figure 11-6 Insertion loss measurement interface 

 

11.4.4 Return Loss Measurements 

Return loss can be thought of as the absolute value of the reflected power compared to the incident 

power. 

For instance, when measuring an OPEN or SHORT, all incident power is reflected and approximately 

0 dB return loss is displayed.When measuring a LOAD, very little power is reflected and values of 40 

dB to 60 dB are displayed. 

 

Return Loss Operating Steps: 

In the CAT measurement mode, click Meas > Return Loss to open the Return Loss setting 

interface, and select the Return Loss measurement. 
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Figure 11-7 Return loss measurement interface 

 

11.4.5 Cable Loss Measurements 

All cables have inherent loss, plus weather and time will deteriorate cables and cause even more 

energy to be abosorbed by the cable.The cable loss will affect the power loss of the transmitter and 

will have a negative impact on the return loss of the system.  

In Distance to Fault measurement, it is not apparent to observe the degree of deteriorating.In such 

case, Cable Loss measurement is necessary to measure the accumulated losses throughout the 

length of the cable. 

 

Average cable loss can be measured, and Avg Cable Loss satisfies the formula: 

Avg Cable Loss = ∑ (measured cable loss)/number of points 

 

Cable Loss Operating Steps: 

In the CAT measurement mode, click Meas > Cable Loss to open the Cable Loss setting 

interface, and select the Cable Loss measurement. 
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Figure 11-8 Cable loss measurement interface 

 

11.4.6 VSWR Measurements 

VSWR is the most important parameter to measure and verify the cable and antenna system, and 

the measurement results can reflect the power transmission efficiency of the system.  

The VSWR shows the ratio of antinode voltage to trough voltage amplitude of transmission line. 

When the VSWR is equal to 1, it means that the impedance of the device to be tested and the 

instrument are completely matched. At this time, there is no reflection and all energy is emitted. If 

the VSWR is infinite, it means total reflection.  

The formula of VSWR is: (1+r)/(1-r) (where R is the reflection coefficient).  

Only valid for reflection measurement. 

 

VSWR Operating Steps: 

In the CAT measurement mode, click Meas > VSWR to open the VSWR setting interface, and 

select the VSWR measurement. 
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Figure 11-9 VSWR measurement interface 
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12 Save and Recall 

The vector network analyzer supports save and recall functions for files of various formats. Press the 

Save/Recall button on the front panel and select file, data, calibration data, and images to save or 

recall. In the menu bar on the right side of the screen.  

 

   

Figure 12-1 Operating interface 

 

Description of supported file formats: 

● CSA file: The calibration data and state file.  

● STA file: The state file contains the configuration parameters (setup) of the instrument.  

● CSV file: Trace data. 

● CAL file: Save the calibration data 

● SnP file: Also known as a Touchstone file. Touchstone file is a standard format file used for 

various simulation software. The simulation software calls this file to represent a device or circuit. 

TouchStone file names are all suffixed with .SnP. N represents the number of ports S2p 

represents a 2-port network. Take the TouchStone file of a Two-port network as an example. This 

file is a plain text file that can be opened directly with Notepad. The S parameters of the Two-port 
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network have 9 columns in total, which are arranged in the order of frequency, amplitude S11, 

phase S11, amplitude S21, phase S21, amplitude S12, phase S12, amplitude S22, and phase 

S22. The frequency is arranged from top to bottom in ascending order, and there is no strict 

regulation for the interval in the middle, but it must be in descending order. It is worth noting that 

in the TouchStone file measured with VNA, there is no DC point, no 0 frequency, which cannot 

be directly called by simulation software. It needs to be edited to supplement the 0 frequency and 

corresponding S parameter values. In this example, dB in the first line represents the expression 

of complex numbers, where dB represents the amplitude unit in dB and the phase unit in angle. 

If MA is displayed at this position in the file, it means that both amplitude and phase are 

represented by actual numerical values. R50 indicates that the matching reference resistance is 

50 ohms. 

● PNG /JPG /BMP file: Screenshot/exact copy of the display. 

 

Save file: 

● Save the status of equipment: Use the Save State As command in the Save State submenu to 

save the equipment state. 

● Save register data: Use the Save Register command in the Save State submenu to save the 

data in the register. 

● Save the status and calibration data of equipment: Select State+Cal Data command in the 

Save Type submenu to save the equipment state and calibration data at the same time. 

● Save trace data: Use the Save Trc Data command in the Save Other submenu to save the trace 

data in CSV format; or use the Save SnP command to save the trace data in SnP format. When 

saving the trace data in SnP format, you can select the following formats: LinMag/ Angle, 

LogMag/ Angle and Real/ Imaginary in the SnP Format drop-down item.  

● Save calibration data: Use the Save Cal command in the Save Other submenu to save channel 

calibration data in. Cal format. 

● Save screenshot: Use the Screenshot command in the Save Other submenu to save the 

screenshot. We can set the default path in the pop-up dialog box. The screenshot file type can 

be saved as PNG/ JPG/ BMP file formats. 

 

Recall file: 

● Recall status of equipment: Use the Recall State command in the Recall submenu to select 

the required equipment state in the .sta file format. 

● Recall the status and calibration data of equipment: Use the Recall State + Cal command in 
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the Recall submenu to select the required equipment state and calibration data in .csa file format. 

● Recall register data: Use the Recall Register command in Recall submenu to select the register 

data to be recalled. 

● Recall calibration data: Using the Recall Cal command from the Recall submenu, select to call 

the required calibration data in a. Cal file format. 

 

File management: 

Click File Browser command to open the file browser, File management can be carried out in the file 

browser. 

 

Figure 12-2 File management interface 
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13 System setting 

Press the System button on the front panel. We can set the IP address, set the date, restore the 

factory settings, consult the help document, set the buzzer, self-detection, language setting, obtain 

the software and hardware information of the device, and license management in the menu on the 

right side of the screen. 

 

Figure 13-1 System setting interface 

 

13.1 System Configuration 

13.1.1 File Browser 

Click File Browser command to open the file browser, File management can be carried out in the file 
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browser. 

 

13.1.2 Firmware Upgrade 

Follow this procedure to update the instrument firmware: 

1. Download the firmware package from an official SIGLENT website. 

2. Extract and copy the .ADS file into the root directory of an USB stick. 

3. Plug the USB stick into the USB Host connector. Press  System  > “System” -> “Upgrade…” ; 

find the .ADS file in USB stick. 

4. Press the “OK”, the analyzer will perform the update process automatically. 

 

 

The upgrade process will take several minutes. When the upgrade is 
completed, the machine will reboot. 

Any interruption during the update process will result in update failure and 
system data loss. This is not covered under the warranty and the user will 
bear repair costs and shipping. 

Do not remove the USB storage device until the update is finished. 

 

13.1.3 Date/Time setting 

Use the Date & Time command in the System submenu to set the date/time. You can set whether to 

display the date/ time and display the format at the bottom right of the screen and modify the date/ 

time value.  
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Figure 13-2 Date/Time setting interface 

 

13.1.4 Screenshot setting 

Use the Screenshot Settings command in the System submenu to set the screen capture 

parameters.  

 

13.1.5 Screensaver 

Use the Screensaver command in the System submenu to set the screen saver parameters.  

 

13.1.6 System language 

The Language command in the Language submenu can be used to change the language of the 

equipment. Simplified Chinese and English are supported. 
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13.1.7 Power 

This menu provides shutdown and restart operation buttons.  

 

13.2  Input and Output Setting 

13.2.1 Network Setting 

13.2.1.1 LAN Status 

We can select static or dynamic allocation of LAN-related parameters. Use LAN Status command in 

System submenu to set LAN parameters.  

 

13.2.1.2 mDNS Setting 

The mDNS host name and description can be set in the mDNS Setting submenu.  

The Reset menu button can restore the host name and description of mDNS to the default state. 

 

13.2.1.3 LXI 

You can view LXI related information in the LXI submenu. 

 

13.2.1.4 VNC Setting 

The analyzer supports VNC remote access to web pages. That is to say, the content displayed by the 

analyzer is projected to the web page remotely, and at the same time, the mouse and keyboard are 

supported to input parameters remotely. 

The VNC port can be set in the VNC Setting submenu. When logging in to VNC, the port of VNC 

should be consistent with the set port. 

The Reset menu button can restore the VNC port to the default state. 

 

13.2.1.5 Web Setting 

You can set the Web password in the Web Setting submenu, and you need to enter the web password 

when remotely controlling the analyzer through the web. 
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The Reset menu button can restore the Web password to the default state. 

 

13.2.2 BIAS 

Click System > I/O Setting > Bias to open the Bias setting interface. 

 

Figure 13-3 Bias setting interface 

 

13.2.2.1 Bias switch 

After the Bias switch is turned on, the Bias out port of the Analyzer outputs a voltage. The built-in DC 

power supply can supply power to external bias connectors, probes and active devices. 

 

Bias Port can be set to:  

• Bias Out: Bias standard output port.  

• Port 1: RF port 1, which can also be used as a Bias output port.  

• Port 2: RF port 2, which can also be used as a Bias output port. 

13.2.2.2 Bias voltage 

The range of Bias voltage is 12V~32V, and the step value is 0.1. 
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13.2.3 GPIB 

Use the GPIB command in the System submenu to set the GPIB port number. 

 

13.2.4 External Device 

Displays information about external devices connected to the analyzer. 

 

Figure 13-4 External device information display interface 

 

13.2.5 GPS Receiver 

Click System > I/O Setting > GPS Receiver to open the GPS Receiver setting interface. 

 

13.2.5.1 GPS Switch 

When GPS is on, enable GPS to start star search, and display "GPS Display information" below the 

quick action bar. 
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Figure 13-5 GPS Receiver information display interface 

 

GPS display information: 

Fix information: Invalid void, GNSS Global navigation satellite system, DGPS Differential global 

positioning system, Estimated unknown system. 

Satellites information : Number of satellites. 

Latitude information : longitude. 

Longitude information : latitude. 

Altitude information : altitude, the unit is Meters. 

UTC Time: Universal standard time. 

13.3 Preset 

13.3.1 Preset Setting 

Preset operation and related settings can be performed in Preset submenu. 

Preset: Use the Preset command to reset immediately according to the setting reset options.  

Preset Option: Use the Preset Option command to set the reset options, and to determine the preset 

source: 
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● Default: Load default parameters. 

● Last: When the equipment is shut down, the current state will be saved automatically. Use 

this option to restore to the last shutdown state. 

● User: Restore the equipment to the user-specified state. 

User Preset: Use the User Preset command to specify the user preset status information file. 

Confirm Preset: Use the Confirm Preset command to set whether to confirm before reset. 

Power On Option: Use the Power On Option command to set the default source of equipment reset 

when the equipment starts. 

 

13.3.2 Factory Reset 

● Configuration files (Selected by default) Indicates that the equipment is restored to the factory 

default state, but the files saved by the user to local will not be deleted. 

● User data (Optional), user can selectively delete the files saved to local. 

● Secure delete (optional), If the check box is checked, the original data will be overwritten with 

random data, achieving the effect of permanent deletion, which may take a little longer. If the 

check box is not checked, the normal deletion mode will be used. 

 

Figure 13-6 Select the saved file 

 

● Configuration files and User data: If user select both, the equipment is restored to the factory 
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default state and deletes the files saved to local by users. 

 

13.4 Help information 

13.4.1 Help Documents 

Help documents can be opened in the Help submenu. Help documents are built-in manual documents, 

including functional descriptions.  

 

13.4.2 About 

Users can get the system information by press  System  > “Help” -> “About” , including 

⚫ Product Model and Serial  

⚫ Software Version and hardware Version 

⚫ Option Information 

 

 

13.4.3 Message Setting 

In the Message Setting submenu, we can open the message setting dialog. 

● Enable Message Display (Selected by default). Check to display all messages as they occur. 

Clear to suppress the display of messages. You can still view them in the View Message. 

● Enable Power Unlevel Detection (Selected by default). Check to enable the power unlevel 

detection. Clear to close. 

 

13.4.4 View Message 

In the View Message submenu, we can open the message log dialog. 
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13.5 Buzzer 

We can set the sound in the Buzzer submenu. 

Buzzer: Use the Buzzer command to turn the device sound on or off. 

Touch Buzzer: Use the Touch Buzzer command to turn on or off the touchscreen keystone. 

Buzzer Volume：Set the buzzer volume (%). 

Complete Test: Use the Complete Test command to test the completion tone. 

Complete Buzzer: Use the Complete Buzzer command to turn the completion tone on or off. 

Warning Test: Use the Warning Test command to test the alarm tone. 

Warning Buzzer: Use the Warning Buzzer command to turn on or off the alarm tone. 

 

13.6 Self-Test 

13.6.1 Key and touch screen test 

In the Self Test submenu, we can perform keyboard self-test (Key Test command), touch screen 

self-test (Touch Test command), screen self-test (Screen Test command) and LED self test (LED 

Test command).  

 

13.7 Options 

Refer to the procedures below to activate the options you have purchased. 

1 Press  System  > “Options”-> “License…” 

2 Enter the license key in the onscreen window.  

Press  Enter  to confirm your input and terminate the license key input. Or load the .lic file and press 

“Scan U-disk” to select the corresponding .lic file in the memory. 

 

13.8 External Ports 

Used to define external logical port, source port, reference receiver port and test receiver port. 
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14 Service and Support 

14.1 Ordering and activating the options 

There are two ways for you: 

1. Pre-activate the options by Siglent factory. 

If you order a instrument and options, Siglent factory will activate the options for you before 

delivery. 

 

 

2. Post-activate the options by yourself. 

If you want to activate options on a instrument that you are using. 
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14.2 Warranty overview 

SIGLENT guarantees that the products produced and sold will not have defects in materials and 

technology within three years from the date of delivery by authorized distributors. If the product is 

defective within the warranty period, SIGLENT will provide repair or replacement service according 

to the detailed provisions of the warranty.  

For service or a complete copy of the warranty, please contact your nearest SIGLENT sales and 

service office. SIGLENT makes no other warranty, express or implied, except as provided in this 

summary or the applicable warranty, including but not limited to the implied warranty of 

merchantability and special applicability. SIGLENT shall not be liable for any indirect, special or 

consequential damages.  

 

14.3 Contact Us 

Headquarters: 

SIGLENT Technologies Co., Ltd 

Add: Bldg No.4 & No.5, Antongda Industrial Zone, 3rd Liuxian Road,  

Bao'an District, Shenzhen, 518101, China  

Tel: + 86 755 3688 7876 

Fax: + 86 755 3359 1582 

Email: sales@siglent.com 

Website: int.siglent.com 

 

North America: 

SIGLENT Technologies America, Inc 

6557 Cochran Rd Solon, Ohio 44139 

Tel: 440-398-5800 

Toll Free: 877-515-5551 

Fax: 440-399-1211 

Email: info@siglentna.com 

Website: www.siglentna.com 
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Europe: 

SIGLENT Technologies Germany GmbH 

Add: Staetzlinger Str.  70 

86165 Augsburg, Germany 

Tel: +49(0)-821-666 0 111 0 

Fax: +49(0)-821-666 0 111 22 

Email: info-eu@siglent.com 

Website: www.siglenteu.com 

 



 

 

 

About SIGLENT 

 

SIGLENT is an international high-tech company, concentrating on R&D, sales, 

production and services of electronic test & measurement instruments. 

 

SIGLENT first began developing digital oscilloscopes independently in 2002. 

After more than a decade of continuous development, SIGLENT has extended 

its product line to include digital oscilloscopes, isolated handheld 

oscilloscopes, function/arbitrary waveform generators, RF/MW signal 

generators, spectrum analyzers, vector network analyzers, digital multimeters, 

DC power supplies, electronic loads and other general purpose test 

instrumentation. Since its first oscilloscope was launched in 2005, SIGLENT 

has become the fastest growing manufacturer of digital oscilloscopes. We 

firmly believe that today SIGLENT is the best value in electronic test & 

measurement. 

Headquarters: 

SIGLENT Technologies Co., Ltd 

Add: Bldg No.4 & No.5, Antongda Industrial 
Zone, 3rd Liuxian Road, Bao'an District, 
Shenzhen, 518101, China  

Tel: + 86 755 3688 7876 

Fax: + 86 755 3359 1582 

Email: sales@siglent.com 

Website: int.siglent.com 

 

North America: 

SIGLENT Technologies America, Inc 

6557 Cochran Rd Solon, Ohio 44139 

Tel: 440-398-5800 

Toll Free: 877-515-5551 

Fax: 440-399-1211 

Email: info@siglentna.com 

Website: www.siglentna.com 

 

Europe: 

SIGLENT Technologies Germany GmbH 

Add: Staetzlinger Str.  70 

86165 Augsburg, Germany 

Tel: +49(0)-821-666 0 111 0 

Fax: +49(0)-821-666 0 111 22 

Email: info-eu@siglent.com 

Website: www.siglenteu.com 

Follow us on
Facebook: SiglentTech
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